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Introduction 

This is a book for two fairly distinct groups of people. First, it is for 
those who currently own an Apple Macintosh computer and want 
some help in getting maximum use out of it. Secondly, it's for those 
who are thinking about buy ing a Macintosh but would like to first 
understand what it does before buying one. 

The book can be viewed as a supplement to or replacement for the 
manuals that come with the Macintosh system, including its word 
processing and drawing programs, MacWrite and MacPaint. Those are 
not bad manuals as computer manuals go, but they have not proved 
satisfactory to many users. They are also incomplete, ignoring some 
basic aspects of Macintosh operation. Moreover, even if Macintosh 
owners have been able to make good progress with the Macintosh 
manuals, they may want the assistance of the different instructional 
approach and format, plus greater thoroughness, provided in this 
book. 

Macintosh-The Definitive User's Guide is just that-a user's guide. 
It is not a technical manual, nor is it an "advanced" user's handbook. 
It is geared to beginners, and to teaching them how to fully use the 
computer and its programs. Its approach is tutoria l, which is one of its 
main differences from the Apple manuals. You will be taken through 
exercises using the Macintosh, where you will see precisely how 
things work, and will be able to check your results against those in the 
book. Since the results of all tutorial actions are presented in the book, 
you will be able to develop a very good sense of how the Macintosh 
works even if you do not currently own one. 

An additional advantage of the tutorial format is that we will not 
need to go into lengthy explanations about how to operate the com
puter. Such explanations are built into the exercises you will be doing. 
Your learning of terms, concepts, and specific skills will come about 
automatically as you proceed from one exercise to another. By con
centrating on actual tasks, we can avoid much of the confusion often 
associated with learning computing, because you will not have to use 
any Macintosh facility until there is a logical reason for using it. As 
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such, the skill is learned in a m eaningful context and is readily 
remembered. 

When you have gone through all the exercises in the book, you will 
have u sed all the faci lities of the Macintosh and the MacWrite and 
MacPaint applications programs as well. You will a lso, if you wish, 
understand how the two versions of the BASIC programming lan
guage available for the Macintosh operate, and be able to make an 
intelligent decision about which is best for you if you want to do some 
programming. 

Structure 

Macintosh-The Definitive User's Guide is divided into three parts . 
Part I is a brief introductory chapter presenting the computer itself 
and some of its basic concepts and modes of operation . The tutorial 
begins in Chapter 2 . This, p lus Chapters 3 and 4 , focuses on the Mac
intosh system- learning how the computer operates no matter what 
you may be us ing it for. Here, you will master the ski lls needed to 
operate the Macintosh whether you are doing word processing, draw
ing, spreadsh eeting, or a nything else. You will learn how to handle 
disks, files of information , and programs; how to store things and 
retr ieve them again, and all the other tools this computer system 
provides. All of this proceeds logically as we move from one task to 
another. 

Each chapter ends with a CHECKLIST covering the main skills 
learned. You can use it to double-check your own mastery of the 
chapter's materia ls and for later reference. Along with the Macintosh 
Quick Reference section and the index, this makes this Macintosh 
guide useful for long-term reference as well. 

Part II continues the tutorial approach, adding mastery of the Mac
intosh$ two most basic applications progra ms, MacWrite and Mac
Paint. We will go through each of them, learning their many facilities 
and preparing you to do serious work on the Macintosh. 

Part III features three appendices. Appendix A is an introduction to 
Apple's Macin tosh BASIC and Microsoft's MS-BASIC, for those who 
are in terested in programming. Appendix B provides some technical 
information about the insides of the Macintosh. Appendix C, the Mac
intosh Quick Reference, is a handy summary of frequently-used opera
tions and comm ands. 

xi 



Scope 

As of the d ate of this writing, there are two hardware versions of the 
Macintosh , varying only in the a mount of main memory provided (the 
original "128K" Macintosh a nd the "512K" Macintosh, or "Fat Mac"). 
There are now two versions of the Macin tosh system software, and 
three versions of MacWr ite a nd MacPa in t. The firs t came wi th the 
original release of the compu ter, in Ja nuary 1984, a nd the second was 
provided a s a free upgrade to a ll Macin tosh owners in the la te spring 
of 1984. The third versions of MacWrite a nd MacPaint (the la tter 
applies only to the "5 12K" Macintosh) were scheduled for release in 
December 1984 . Th is book covers a ll versions of the hardware and 
software, noti ng changes and differences. Whichever you have will be 
included in the following chapters. 

To the bes t of my knowledge, every bas ic facili ty of the Macintosh , 
its operating system , MacWrite, and MacPa in t is covered in this book, 
including some that escaped the Macin tosh manua ls. This is based on 
about 1,000 hours of using the computer. Nothing is based on hearsay, 
company handou ts , or any other externa l sources. Everything is de
scribed and presented as it works in ac tua lity, not in theory. No effort 
has been made to gloss over the compu ter 's weaknesses, and it has 
some; nor to minim ize its strengths, which are m any. The en tire focus 
of the book is to m ake your use of the Macintosh system easier and 
more powerful. 

All of the illustra tions in this book, excep t for the photographs, were 
done on the Macintosh . Moreover, I did them a ll myself, despite my 
lack of any particu lar a r tis tic aptitude . This is a good testimonial to 
the computer 's powers, and suggests wha t you can expect to be able to 
do a fter a very short time. 

A cknowledgments 

Macintosh- The Definitive User's Guide is not an "officia l" or "au
thorized" manua l. I do not have any relationship with Apple Com
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developing the understanding of these computers that can only come 
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Computer in resolving some needs and questions that emerged in the 
course of my work. John Rizzo, John Duhring, Joe Shelton, Kevin 
Jones, and Louise Egan all helped at one time or another, and I would 
like to thank them for it. 
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with unremitting patience and graciousness, and I thank them as well . 
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Introduction 

The basic things we must learn in order to use any computer system 
are unusually easy with the Macintosh. We can provide a ll the essen
tial background in one introductory chapter, and then move on to the 
exercises that wi ll make you a master of this computer. Our task is 
greatly eased by the Macintosh's integration of the three key elements 
that make up any computer system: hardware-the metal, plastic, 
and, not least , silicon components which are the physical machine; 
system software- the programs which ac tua lly run th e computer, 
whose presence is generally invisible to the user; a nd applications 
software-the programs which you wi ll load into the computer for 
specific purposes, such as word processing or progra mming. 

The Macintosh hardware includes the very powerfu l Motorola 
68000 microprocessor-its "brain" as it were-plus numerous addi
tional integrated ci rcuits and other electronic components for mem
ory, video display, and so on. An understanding of these electronic 
elements is not at a ll essentia l for successful use of any computer; they 

Figure 1-1. A basic Macintosh system. 
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are described in some detail in Appendix B, however, for those inter
ested in learning more about them . 

More practically useful is an understanding of those parts of the 
Macintosh hardware that the user does deal with on a regular basis. 
This includes the keyboard and mouse for putting information into 
the Macintosh, the screen and printer for getting it out, and the disk 
drive(s) for s toring it for later use. We shall look at each of these in 
some detail. 

The sys tem software, which gives the Macin tosh its particular per
sonality a nd mode of operation, works for us regardless of the specific 
task in which we are engaged. It consists of a group of computer 
programs that ca ll upon one another as necessary. Some of these 
programs are permanently ins ta lled inside the machine, in what is 
called ROM (read-only memory), and are constantly available. Others 
are on the diskettes you will use to run programs, and are automati
cally loaded into the computer when n eeded. 

What really dis tinguishes the Macintosh is that the hardware and 
system software were created to match one another much more inti
mately than is the case with mos t other computers. The system soft
ware provides , for example, the graphic images that you will manipu
late on the screen with the mouse, easily accomplishing tasks that on 
other computers would require a good deal of typing. 

Applications software, tha t is, programs, provides our main tools 
for using the computer (under the Macintosh system they are usually 
referred to as "applications"). With this software we can write letters, 
create drawings, develop spreadsheets, and so forth . Each user will 
have his or her own main interests here, and choose from the increas
ing variety of programs availa ble. But a ll users will benefi t from the 
fact that their programs have been specifically designed for the Macin 
tosh and make extensive use of its h ardware and system software. This 
means that, more than with other computers, you will apply the same 
physical motions, terminology, and concepts, no matter which ap
plications software you are using. Learning new programs becomes 
much easier than with other computer systems, and moving informa
tion from one to a nother is readily accomplished. 

This chapter will focus on acquainting you with the m ain charac
teristics of the ha rdware and system software of the Macintosh. The 
hardware description will be strictly practical-how you connect 
things together, what each part does and how it works, and so on. The 
system software introduction will be similar. We will learn what 
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"windows" and "icons" are, for example, and how the Macintosh uses 
them. The amount of material we require for this introduction is not 
great, and the Macintosh system lets us learn it quite easily. Once that 
is done, we can go on to the ensuing chapters which , using an interac
tive tutorial approach, wi ll take us to m astery of the machine . 

The Physical Macintosh ________ _ 

Figure 1-2 is a photo of a rather extensive Macintosh system. The 
main unit houses the compu ter itself, the video screen, and the in ter
nal disk drive, plus a variety of connectors for other parts of the 
system. For all users, those additional parts will include the keyboard, 
mouse, and, most likely, an Imagewriter printer. Some users wi ll a lso 
have the numeric keypad, a second, external disk drive, a modem for 
telecommunications, a carrying case, and, as time goes by, va rious 
other peripherals as well. The external appearance of the " 128K" and 
"512K" Macintoshes is identical. 

Figure 1·2. A Macintosh system with second disk drive, modem, 
printer, numeric keypad, and carrying case. 
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Video Display 

The video screen is the Macintosh's most important output device, 
displaying the results of its labors. It is 9 inches across, measured 
diagonally, and has a medium high resolution of 175,104 pi.xels-512 
horizontally by 342 vertically. (Pixels are picture elements, or dots, 
that can be illuminated or not.) It displays images in black and white, 
plus numerous shades in between. Whereas most current computers 
display a green or amber on black video image, the Macintosh relies 
primarily on black and white, to maintain its philosophy of keeping 
computing as similar to the "real world" as possible. 

The Macintosh is also unlike most other computers in that it does 
not have totally distinct "graphics" and "text" modes for the separate 
handling of words and pictures. Rather, the two facilities are highly 
integrated, which explains the versatility of the Macintosh display. 
Pictures and words, for example, are simultaneously displayed on 
the screen with ease, and the screen can show things exactly as they 
will appear on paper-italics, for example, or other unusual type 
faces. This requires the moving about of a great deal of data (an image 
of each dot used in each picture must be remembered) and slows the 
computer down a bit. But the expanded ease of use and simplicity of 
operation, as well as the materials that can thus be displayed, more 
than justify the time taken. Figure 1-3 is a printed example. 

The only video control available to the user is the brightness control 
knob. It is below and behind the Apple symbol on the front of the 
computer. Turn it clockwise or counter-clockwise to establish a bright
ness level you find agreeable. Do not, however, leave it turned very 
high if your computer wi ll be sitting unused for some hours-that 
could ultimately damage the tube. 

Auxiliary Storage 

Just below the screen on the front of the Macintosh is the internal 
disk drive. It is a Sony micro-floppy drive, using 31/2-inch floppy 
diskettes housed in a rigid plastic case, as illustrated in Figure 1-4. 
Each side of a diskette can hold 400,000 characters, or bytes of data, 
the equivalen t of about 250 typewritten, double-spaced pages {gener
ally, the term K is used to denote 1,000 bytes, so these are 400K 
diskettes). While that sounds like a lot, diskettes can become filled 
quite quickly; system software and programs take a lot of space, as do 
graphic images. When double-sided disk drives become available (cur-
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You can mix text and 
graphicS allmoSt ever~where 

on the macintosh' 

Which means that the computer 
must manipulate vast amounts 

or data. 
This picture is made up of 
12.000 characters (bytes)l 

Figure 1-3. The Macintosh mixes words and pictures easily, but uses up a 
lot of memory in the process. 
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rently, only one side of the disk is used), diskette capacity will be 
BOOK. This wi ll make using the Macintosh a good deal easier, es
pecially for those with a single disk drive. Most users will quickly 
discover that a second, external drive is a very usefu l addition to their 
systems. 

Macintosh 

Rigid plastic case-
easy to handle and ship. 

3.5 Inches. 

400,00 bytes on 
one side 

= 250 pages: 

Sliding metal shield to 
protect recording surface. 

Figure 1-4. A micro-floppy diskette. 

The micro-floppy diskettes (in this book, we will use the terms qisk 
and diskette interchangeably) are much better protected than their 
larger 51/ 4- or 8-inch cousins. The rigid case and sliding shutter door 
make them relatively impervious to bending or scratching; so long as 
the spring on the shutter is working, you can carry them in pocket or 
purse, or mail them, without much danger. Still, the medium itself is 
quite fragi le, and diskettes should be handled with some care, and 
kept away from heat, liquids, and magnetic fields. 

Keyboard 

The keyboard, shown in Figure 1-1 , attaches by a modular tele
phone-type connector to the lower front of the main unit. (If you also 
bought the optiona l numeric keypad, as seen in Figure 1-5, the key
board plugs into it, and it plugs into this connector.) It is quite like a 
typewriter keyboard, with a few additions and minor differences to 
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take full advantage of the power of the computer. With almost all 
computers, for example, the Caps Lock key affects only the letter 
keys-the number keys remain unshifted unless you use the Shift key. 
As we shall discover in Chapter 2, the action of the keyboard, and the 
characters it generates, can be easily controlled by the user. 

Figure 1-5. The Macintosh numeric keypad. 

The Macintosh has three specia l keys, enlarged in the drawing in 
Figure 1-6, which you would not find on a typewriter. The Option keys 
and the Command key, with a symbol looking more like a square four 
leaf clover than anyth ing e lse, are {unction keys. They work rather like 
Shift or Caps Lock in that, when he ld down while depressing another 
key, they change the latter 's meaning. They permit the keys to do extra 
duty, and facilitate much of what you will be doing on the Macintosh. 
The Enter key is used primari ly by some applications programs for 
data entry; most of the time it works the same as the Return key or is 
inactive. We wi ll explore each of these in greater detail below. 
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Mouse 

The mouse is central to the entire Macin tosh way of doing things. 
Technically, it is a n analog input device, using a sma ll ba ll in its 

Figure 1-6. The Macintosh's Option, Command, and Enter keys. 

Figure 1-7. The Macintosh mouse. 
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bottom, whose motion as you move the mouse across your table is 
transmitted to the computer and interpreted by the software . The 
mouse button provides an additional form of input-by clicking it 
once or twice, you can tell the computer to do a variety of things. What 
on other computers requires carefully typing in words or phrases, can 
be done on the Macintosh simply by moving the mouse and then 
clicking its button. The Macintosh mouse makes computing both 
simpler and, often, faster. The mouse cord connects via a special 
connector to the back of the Macintosh. 

lmagewriter 

The Imagewriter printer was specifically designed to take advan
tage of the capacities of the Macintosh, and Apple's Lisa as well. Most 
particularly, its graphics capabilities enable it to duplicate anything 
you see on the computer's screen. (Actually, its resolution is somewhat 
higher than that of the screen, and so what you print wi ll be a bit 
sharper than what the screen shows.) Unlike with most computers, 
where often-complicated control codes have to be sent to the printer in 
order to specify various special effects, with the Macintosh and Im
agewriter it is all done automatically. 

The Imagewriter uses dot-matrix printing technology, with a group 
of wires in a matrix of seven horizontal by nine vertical positions. A 
print hammer hits wires in any of those positions, which in turn hit 
the ribbon and transfer the image to paper. Consequently, a single, 
very sma[\ dot can be printed anywhere on a page, which explains 
how the Macintosh/lmagewriter combination can produce such strik
ing print effects. 

The Imagewriter feeds paper with either friction or sprocket mecha
nisms, chosen by flipping the switch on its top left. This means that it 
can use single sheets, fanfold sprocketed paper, or even paper rolls. 
The sprocket feed is adjustable, to handle paper widths from 41/2 to 10 
inches (17 inches with the wider model); thus, mailing labels and 
other specialized forms can easily be printed. The Imagewriter can 
move paper both forward and backward as well, permitting super
scripts and subscripts, overstriking, and other special effects in your 
documents. It attaches to the rear of the computer with a special 
cable. Most important, the Imagewriter is so integrated into the com
puter system that you can pretty much forget about it. You are free to 
concentrate on using the Macintosh's programs-whatever you create 
will be correctly transmitted to the Imagewriter when you tell the 
Macintosh to print. 
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Rear Panel 

The back of the Macintosh has a number of connectors for necessary 
and optional parts of the system, as seen in Figure 1-8. In keeping with 
Macintosh's graphic and international orientalion, every item is pic
torially represented, by icons, which illustrate its use. On the top right 
is a small compartment for replacing the battery, which keeps the 
Macintosh's internal clock running even when the computer is off. 
Beneath that is the on-off switch, and beneath tha t the connector for 
the power cord. And at the left side is a s lot for the optional security 
system-a special cord attaches to this slot and one on the keyboa rd, 
and around some secure i tern like a table leg; it can then be locked to 
deter thievery. 

I 
----

- 1.. • 

Figure 1·8. The Macintosh back panel, showing security connector, power 
receptacle, and five connectors for peripherals. 

There are five connectors in a row at the bottom, each dis ti ngu ished 
pictorially. (Figure 1-8 illus trates an early production Macintosh-on 
yours, the placem ent of the printer a nd modem connec tors will proba
bly be reversed .) From left to r ight in Figure 1-8, they arc for: (I) con
necting the mouse; (2) connecting a n ex terna l second disk drive; 
(3) connecting a modem for te lecommunications; (4) connec ting the 
Imagewriter p r inter; a nd (5) connect ing additiona l a udio output 
devices. 
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The mouse and printer connectors will be of immediate use to 
virtually all Macintosh owners; the others will probably be employed 
later, if at all. Note, however, that the modem and printer ports (what 
are called RS-422 serial ports) are actually very versatile, and can be 
used for numerous other purposes as well. Apple and other vendors 
are producing many additional peripherals that can be plugged into 
these ports, and into one another. 

System Setup 

Most readers will probably have their computers up and running by 
the time they read this. If you don't, or haven't bought a Macintosh 
yet, we can quickly go over the process; it is extraordinarily simple. 

Unpack the components carefully, spreading out all the cords and 
other parts on an uncluttered workspace. Attach the mouse and 
printer cables to their designated connectors on the computer, being 
sure to tighten the knurled knobs for a solid connection and to mini
mize radio/TV interference. Then you can plug the keyboard cable 
into the keyboard and into its connector on the front of the Macintosh 
(unless you have the numeric keypad, in which case the keyboard 
plugs into it, and it, in turn, plugs into the front of the computer). 

Follow the Imagewriter instructions on unpacking the printer, in
serting paper and ribbon, and doing a power-on test. Then connect the 
second end of the printer cable to it. If you have purchased an external 
disk drive, attach it to the connector between those for the mouse and 
the Imagewriter. Then plug the Macintosh power cord into the com
puter and into a grounded outlet. That is really all there is to it. 

These are the hardware features that every Macintosh user will be 
employing from the start. We shall use each extensively, and learn 
more about them, in the following chapters. You probably also re
ceived the Programmer's Switch with your system; this is a small 
plastic device that can be inserted in the back left side of the com
puter, toward the bottom. It permits restarting the Macintosh without 
turning it off (called a reset in the computer world), but is primarily 
designed for the use of programmers. Most users would do well to 
forget about it, and follow standard Macintosh procedures in their 
computing. You can therefore simply put it away. 
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The Macintosh System 

The most notable fea ture of the Macintosh 's sys tem software is its 
"user interface," a fancy term for the way in which it presen ts itself to 
people using it. Through the use of a desktop ana logy, readily recog
nizable objects to manipulate, and so on, the Macintosh makes com
puting easy with no sacri fice of power. In this chapter, we will cover 
the basic system software concepts so that you have an elementary 
sense of what is going on . Then, as with ha rdware , we will learn more 
a bout each of them through ex tensive practice and examples. 

A key to the Macin tosh 's user interface is the idea of intuitive com
puting-making the use of the computer correspond as closely a s 
possible to the way in which we work in the real world outside. The 
Macintosh and Lisa have gone well beyond o ther computers in achiev
ing th is, a nd you will be surprised at how often things will functi on 
just a bout as you guessed or hoped they would , based on the way you 
work with pencil a nd pa per. This is not often the case w ith computers, 
where everything from conceptua lization to vocabulary seems en
tire ly new and often threatening. 

The Desktop 

The desktop ana logy is a good example of this . When you start up 
your Macintosh , you a re greeted with a desktop, usua lly almost empty, 
as in the example in Figure 1-9. As you begin to do work, your desktop 
will ge t busier; "pieces of paper" and o ther images will overlap one 
another. You can m ove things a round on the desktop, put them away 
and bring them back, write on a nything availa ble, and reorganize the 
stuff tha t is there . You can put your clock on the desktop, and your 
was tebasket, plus folders for s toring things. Compare Figure 1-9 to 
1-10, which illus trates a very busy desktop, with numerous objects 
partia lly visible, just as might be the case on your physical desk. 
Although the Macintosh 's desktop has capaci ties well beyond the most 
expensive mahogany one, the a nalogy rema ins, making the use of your 
computer easier. So long as you continue to think of it as just that, a 
desktop, your computing will indeed be in tui t ive. 
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Figure 1-9. A nearly-empty desktop. 
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Figure 1-10. A busy Macintosh desktop. 
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seems premature, since there are 
2. Technical Presentation: I'm 
technical presentation. He's been 
Frank has a 
developmen 

., 



----------------1 I The Fundamental Macintosh 0 17 

Icons 

The Lisa and Macintosh are perhaps mos t fa mous for their use of 
icons, that is, pictoria l images. Critics some times dismiss this as 
"computing for illiterates," but they a re in fac t missing the point. 
Icons actua lly have several justi ficat ions . Firs t, they are easy to under
s ta nd-nothing represents the abi lity to file materia l better than a n 
image of a file folder, after a ll. Moreover, they save time-you simply 
point to an icon rather tha n typing in bo th a na me a nd a n action . And 
they save space on the screen, as well. 

Icons fit in nicely with the desktop ana logy, since it is intuitive to 
move an object on a desktop, and that is precisely what you do with 
icons . Everything, to the Macintosh- be it a progra m, a di skette, a 
letter you wri te-is an object , represen ted by an icon , as we see in 
Figure 1-11. Here , there are icons for a diskette, a pointer, a folder, a 
program, an individua l document, and a trash can.lcons h ave a great 
variety of images, depending upon wha t they represent. The meanings 
of most of them are immediately obvious; a few may take a bit of 
experience before they become intuitive . 

Moe Point 'w'rittl /Point 

A Program A Diskette 

Ch. 1-- Greoot Ameoricon Nonl 

A Po inter A Document 

m LJ 
Trash F oldt>r for Building Plans 

A Thing A Folder 

Figure 1-11. Macintosh Icons. 
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On the whole, however, the meanings of the icons are sufficiently 
clear that, even for those things you may use only occasionally, the 
need to stop and think or to consult reference manuals is greatly 
minimized. And, the same kinds of icons are used across the spectrum 
of Macintosh applications-word processing, spreadsheeting, or 
whatever-so that moving from one task to another is simple because 
you continue to use the same images and actions. 

The Cursor or Pointer 

The term cursor is quite standard in the world of computing, denot
ing the small, usually blinking, box or dash on a video display that 
shows where the next typed character will appear. This is not really an 
adequate concept for the Macintosh, however, and we will more often 
refer to the pointer. Technically, we should use the term "cursor" with 
the Macintosh only for the vertical bar that appears when we are 

.t 

~ 
The ~RROW. The I-BEAM. I For ma"i ng selections. For manipulating text. 

+ 
T'w'O PLUS SIGNS, used by 
various applications for 

selecting ar~ to be 
acted upon. 

The CURSOR or INSERTION 
POINT, usual11J flashing. 
Shows pos1t1on at 'w'h1ch 
text 'Will be i n~ rted. 

Figure 1-12. Macintosh Pointer shapes. 

THE WRISTWATCH. 
Wait, Macint~h is 
'w'O r lei ng . 
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entering text. The Macintosh pointer is much more versatile than the 
cursor on other computers. Consequently, it assumes a variety of 
shapes, reflecting the choices that confront us at a given time, as 
illustrated in Figure 1-12. Indeed, the shape of the pointer often intu
itively suggests what kind of action is appropriate in a given si tuation. 

Mos t often, the pointer is an arrow-shape, which we move around 
the screen with the mouse, finally depressing the mouse button to 
initia te a n action . Sometimes, especially when we are typing in text, 
we have both the I-Beam pointer and the vertica l bar, which is indeed 
a cursor-showing where the nex t typed character will appear. But 
the pointer will use several additional images, not least the wris t 
watch tha t is the symbol for "wait a minute, Macintosh is working." 

The appearance of the pointer, and its usage, are also consis tent 
across Macintosh applications. Wi th icons a nd the mouse, we can 
easily use the pointer to manipulate our work, a nd rapidly become 
mas ters of what is in fact a highly sophis ti cated system . 

Windows 

Equally central to the operation of the Macintosh is the concept of 
windows. A window, as its name sugges ts, is a view into something, 
usua lly just part of a greater whole. If you are doing some word 
processing with MacWrite, for example, at a ny one time you have a 
window showing part of the le tter or report you are creating. You will 
soon learn how to open and close windows, to make them larger or 
sma ller, to move them around the desktop, and to scroll through any 
window so tha t the part you want to see is actually on the screen . In 
Figure 1- l 0 we got a gl impse of this feature, with several windows on 
the screen, some of which showed only a part of their contents . 

Windows are used for many purposes by the Macintosh. Most icons, 
such as those for di sks a nd applications, can be "Opened ," creating a 
window. We open a diskette icon for a window that shows us the 
contents of that diskette, or open the Trash icon to see what we have 
thrown away, so ~hat we can reconsider whether we want that s tuff 
perma nently junked or not. Figure 1-13 shows the desktop with both 
the Trash icon and the window that emerges when we open that icon; 
in this case, four items were sitting in the trash . 

There are a lso a number of special windows, sometimes called 
"boxes," which the Macintos h uses to provide us with cau tions and 
information . Figure 1-14 illustra tes two of them. The uppe r one is a n 
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=o Trosh 
4 it~ms 16K in Trash 

Figure 1-13. The window created by opening up the Trash icon. 

Alert box, which warns us of the potentially da ngerous consequences 
of certain choices we may make. This is one of the ways the Macintosh 
makes computing relatively painless. Beneath it is a Dialog box, which 
is used by the Macintosh when it needs more information in order to 
complete a given action . We wi ll see some additional special Macin
tosh windows as we go along. 

As with other aspects of the Macintosh, using the window soon 
becomes entirely intuitive. In many respects it is similar to paging 
through a document that is longer than a single page. But it is much 
easier to scroll through a window than to turn pages; moreover, parts 
are less likely to be lost, and can easily be moved from one window to 
another. 
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saue changes before quitting? 

[ Yes J 
[ No ) ( Cancel ) 

An ALERT BOX to worn 
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II 
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( Eject 
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Figure 1-14. Helpful Macintosh windows. 
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Applications and Documents 

The Macintosh makes a useful distinction between applications and 
documents, the first being used to create the second . Applications can 
a lso be thought of, more generally, as tools, since the Macintosh man
ual uses the former term somewhat restrictively. Programs , such as 
MacWrite and MacPaint, are what are formally referred to as applica
tions by the Macintosh; but facilities such as the Note Pad and Clip
board, which we will learn about in Chapter 2, are essentially similar. 
The pointer is a tool, whose use will vary from p lace to place; the 
keyboard and mouse are physical tools , as is the video screen on 
which you see the development of your labors. And individual pro
grams, such as MacPaint, have their own special collections of soft
ware tools to achieve their specific capabilities . 

Documents, on the other hand, are the end result of the process of 
computing, the reason you bought a computer in the first place. You 
wri te a report, or make a drawing, or perhaps write a BASIC program, 
creating a Macintosh document. Any such document can then be 
further manipulated, if desired, by other Macintosh applications. Con
ceptua lly, this is a ll quite logical, and makes intuitive sense. The end 
result of computing, obviously, is the document-the work you want 
done. Icons, windows, the desktop, and so on, are all there to facili tate 
this process. 

With this introduction behind us, we have enough general under
standing of the nature of the Macintosh 's hardware and system soft
ware to permit us to move ahead. Through ex tensive practice and 
examples, the ensuing chapters will clarify what we have seen here . 
We will begin in Chapter 2. 

Checklist for Chapter 1 

1. System software consis ts of the progra ms tha t run the computer, some of 
which are perma nently ins talled within it, o thers of which are on the 
diskettes we use to get it going. 

2. Applications software consis ts of the programs tha t do the prac tical tasks 
we want done. 

3. Macintosh micro-floppy disks!diskelles hold 400,000 individual characters, 
or bytes, the equiva lent of a bout 250 pages of double-spaced typewritten 
text. 

4. The Macintosh desktop, like a physical one , is where we organize and do 
our work. We can move things around on the desktop, put one thing atop 
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another, and immediately access a ny of the items sitting there. 
5. Icons are graphic representations of objects, physical or otherwise. We 

manipula te the icon in order to either use or act upon the objec t it 
represents. 

6. The pointer is used for making choices of many kinds, as well as for 
positioning the cursor. It takes on a variety of shapes, depending upon 
where we a re and what we are doing at a given time. 

7 . Windows are the way the Macintosh lets us see the contents of things, 
from physical objects to the end results of our computing. Windows can 
be opened , closed , moved , and changed in size. When any item is larger 
than what its window can display, we can scroll through it so tha t the part 
we want to see appears in the window. 

8. Applications or tools are the things we use, such as progra ms, in order to 
get work done on the Macintosh. 

9. Documents, such as written reports or d rawings, are what we create with 
Macintosh applications. 
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Introduction 

The Macintosh's desktop a na logy, along with icons, windows, and 
the mouse, makes using this computer a pleasure. And now is the time 
to apply what we discussed in Chapter I to make your Macintosh 
work. In this chapter, we will focus on genera l tasks and techniques 
that are applicable no matter what the Macintosh is doing. This will 
be a "learning while doing" exercise-in the process of learning some 
of the Macintosh's features, you will a lso be learning how to use its 
most basic and importa nt facilities. If your Macintosh is not currently 
on, put the Write/Paint disk (its label says MACWRITE-MACPAINT) 
into the drive and turn it on. We will go through the elements that 
appear on the screen, and start to see how the thing actu a lly works. 

Don't be concerned if your screens are no t absolu tely identical to 
those in the figures; they may well have additiona l icons. The Macin
tosh system software is being regularly upgraded with additional 
features, not a ll of which we want to discuss at this point. All of them 
will be covered as we go a long. 

The Menu Bar ____________ _ 

Your screen should show your desktop with two icons-one of the 
Write/Pa int disk itse lf and a nother of the Trash basket. And across the 
top left of the screen is the menu bar with an apple and four headings, 
as seen in Figure 2-1. The screen itself represents the desktop-rather 
neat right now, but we will fi ll it up presently. 

Move the mouse so that the pointer is on the desktop (not on the disk 
icon), and depress then release the mouse button . Then move the 
pointer back a nd forth from the desktop to the d isk icon several times , 
pressing and releasing the mouse button when the pointer is over each 
of them. Note how the icon inverts with each cl ick, from black 
(highlighted) to white. (If, by mistake, you click twice in rapid succes
s ion , the disk icon will open to reveal a window. For now, if that 
happens, just click in the little box at the upper left corner of the 
window and it will close.) Everything we use in the Macintosh will 
become visibly highlighted in some way when it is selected-ready for 
some sort of action. In fact, the word active is used as a synonym for 
selec ted . We select icons (and some o ther things, as we shall see) by 
using the mouse to move the pointer to them and then clicking
depressing and immediately releasing the mouse's button . 
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Figure 2-1. An almost-empty desktop showing a disk icon selected. 

Now make sure the Write/Paint icon is selected (black). Move the 
pointer a long the m enu bar at the top until it is over the File title , and 
now depress the mouse button and hold it down: this is called 
pressing, as opposed to clicking where we release it immediately. The 
File m enu unfolds. Those choices which are in black are applicable to 
where you are now; those in gray are not and cannot be chosen. With 
the mouse button still depressed , move the pointer down to Get Info, 
so your screen looks like Figure 2-2, and release the button. This is 
called dragging the pointer, that is, moving the mouse while its button 
is pressed (down). It is used extensively with the Macintosh. You will 
hear the disk whir a bit , and then the result of your action appears
some information about the Write/Paint disk, as seen in Figure 2-3 . 
Move the pointer to the small square at the top le ft of the Information 
about Write/Paint window-it is called the Close box-and click once. 
The window returns to whence it came . You are beginning to learn 
how to use the system. 
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Figure 2-2. Desktop with File menu opened by clicking on File title. 

Kind: 
Size: 
Where: 
Created: 
Modified: 

D f.O( kt~d 

Information about Write/Paint 

Write/Point [d 
disk 
35840 bytes auailable, 364544 bytes used 
internal driue 
Wednesday, May 30, 1984 at 11 :09 RM 
Friday, July 6, 1984 at 9:16 RM 

Congratulations--
You are learning to use the Macintosh! 

Figure 2-3. The Get Info window for the Write/Paint diskette. 
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Now move the pointer back to the Menu bar, point at the File 
heading and press once again. You have two more choices-Open and 
Eject. (Note that to the right of some of the choices is the Command 
symbol and a letter. Macintosh will let you use the keyboard as well as 
the mouse for many frequently selected choices: you could have 
chosen Get Info by holding down the Command key while you typed 
the letter 'T' as well.) The Eject option is an important one-this is 
how you get Macintosh to spit out the disk currently in the disk drive . 
You ask and Macintosh delivers, but only after il makes sure that 
everything on the disk is in order. 

With the File menu still open, drag the pointer to Open and release 
the button. Because the Write/Paint icon was active , this opens a 
window that shows what is on the disk, as seen in Figure 2-4. There are 
icons for three applications (MacWrite , MacPaint, and Font Mover-if 
the last is not there, that is quite okay); a System Folder icon (contain
ing programs the Macintosh needs but which you should ignore); an 

~D Write/Paint 
6 iteoms 364K in disk 35K availab leo 

1f', ~ 
,~~ 

~ 
~~l 

',~ 
MacWr1tt? Font Mover 

MacPaint 

CJ CJ I . 
System Folder Empty Folder Sample Memo 

0 
~I 10 121 

Figure 2-4. The Window that appears when we Open the Write/Paint icon. 
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icon for an empty folder to hold your work; and one or more icons of 
sample documents created by MacWrite or MacPaint. There is also a 
line of type that says that this disk contains six items and is currently 
using 364K (that is, 364,000 bytes or characters) of disk space, with 
35K more space available. (The actual number of icons on your Write/ 
Paint disk, and the number of bytes used and available, will vary 
depending upon when you purchased your Macintosh and whether or 
not you have used the disk previously.) 

Note the various shapes and forms along the right side and bottom 
of the window. These permit scrolling-moving around in the window 
to see more information. Figure 2-5 shows the names and functions of 
the bars and boxes for manipulating windows. Not all of them are 
available in every type of window. At this stage they won't do anything 
because all the information can already be seen. But you will soon be 
using windows that can reveal, at any one time, only a fraction of their 
contents, and the scrolling tools will be constantly used to bring 
whatever information you want into the window. 

Now use the mouse to move the pointer to any part of the top bar of 
the window-except for the little Close box at the left. Depress the 
button and hold it, dragging the mouse down and to the right, then 
release the button. You can move any window anywhere you want it 
on the desktop. Now move the pointer to the extreme lower right of 
the window, where you see the Size box (one square overlapping 
another). Press the button and move the mouse down and to either 
side-windows can be made larger and smaller at will. 

Practice moving the window and changing its size a few times, until 
you are comfortable with the process. Then put it back to about the 
place and size it originally was-this need not be exact, it really 
doesn't matter. 

When you were moving the window around and changing its size, 
you may well have covered the Write/Paint or Trash icons-they were 
still there even if you could not see them. Just as on a real desktop, one 
thing can be put over another, and to get to the one below you need 
only move the first so that the second can again be seen. It can then be 
made the active window by clicking on it. We will do this many times 
as we go along. 

The menus at the top of the screen will vary according to what you 
are doing and the program you are currently using. Some of the 
menus you see now will not appear at some places, but other ones will. 
And the choices available within each menu will also change-what is 
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Figure 2-5. Anatomy of a window. 
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in gray now will be in black (that is, selectable) at other times, and 
vice versa. This is how the Macintosh makes life easier ; it will not let 
you do things that make no sense to the kind of work you are currently 
doing. Nor will it let you des troy things easily. 

The File menu is used to manipula te the applications and docu
ments you are currently working wi th. The Edit menu is used pri
marily for ma king ch anges in documents. And the View and Special 
menus provide utili ties for housekeeping chores . Each of these will be 
dealt with in de tail a s we go along. For now, you h ave learned how to 
open a menu and make choices from it. 
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The Apple Menu _ _ ________ _ 

The Apple menu is somewha t d ifferen t. Firs t of all , it is a lways 
available, no mat ter wha t e lse you may be doing . Second, it provides a 
number of usefu l features tha t you wi ll often employ while using other 
applications on the Macintosh . So we w ill go through them in some 
de ta il . 

A bout the Finder . 

This is simply an informational window, providing a brief descrip
tion of the Macin tosh Finder, which we will consider in detai l in 
Chapter 3. (Under o ther a pplications, the information w ill be abou t 
that application ra ther tha n the Finder.) Move the pointer to the Apple 
and press, then drag the poin ter to About the Finder . . . (as demon
stra ted in Figure 2-6) a nd release the button- the box of information 
appears. To close thi s box, jus t move the poin ter anywhere over it and 
cl ick once. The other menu choices a re more significant , providing a 

Note Pad 
Calculator 
Key Cops 
Control Panel 

~ 
Mac'Wri tt> 

LJ 
System Folder 

Font Mover 
MacPaint 

LJ ~ 
Empty Folder Sample Memo 

Figure 2-6. Making a choice from the Apple menu. 

., 
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number of tools and storage devices that h elp make Macintosh so 
versatile. 

Alarm Clock 

Move the pointer to the Apple symbol, press the button to open the 
menu, drag the mouse until Alarm Clock is inverted, and release the 
button. The disk will whir a bit and then the clock appears, showing 
the time in minutes and seconds. Try moving it around the desktop 
just as you did the Write/Pa int window-but don't click on the Close 
box at the left-that wi ll put the Alarm Clock away. 

You can put the clock anywhere, for example, keeping it at the 
bottom of the screen while you are working; if you leave it there when 
you quit your work, it will be put away for you when you turn the 
Macintosh off. If you click on the little switch icon at the right, the 
clock will open up, as seen in Figure 2-7, permitting you to set time, 

r "" • file Edit Uiew 
., 

MocPoint Font Mover 

System Folder Empty Folder Somplt> Mt>mo 

Figure 2-7. The Alarm Clock opened, with the alarm selected and set to go 
off at five p.m. 
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date, and the ala rm. The three icons in the bottom boxes control what 
will appear in the middle bar-and what is in the middle is there to be 
changed, if desired. Click on the calendar icon. Now the middle bar 
will show the current date; if you move the pointer over any part of 
the middle bar, it cha nges into a plus (+)sign, which means you can 
change text. Try clicking over the number of the month-it inver ts . 
You can change it if necessary, either by typing a new number or by 
using the tiny up and down armws. The same applies to day and year. 

If you selec t the clockface icon at the bottom left, a copy of the 
current time appears in the middle bar a nd can be similarly changed. 
If you se lect the a larm clock icon on the right, the same choice applies 
for setting the a larm-plus a tiny button icon a t the left that lets you 
turn the alarm itse lf either on (up) or off (down). Whenever the Maci n
tosh is on, the alarm wil l sound once at the preset time if you have set 
it to go off, and the Apple menu symbol will cont inue to blink until 
you open and then close the clock. (So, if you ever turn your Macintosh 
on and see the Apple blinking, this is because the alarm had been set 
and has gone off.) 

Click the switch icon in the top bar, and the clock returns to its 
smaller state, showing the time only. If you wanted to put it away, you 
could either click on the Close box to the left of the time or select Close 
from the Fi le menu. For now, however, just move the clock down to the 
lower left-hand corner of the desktop a nd leave it there. 

Calculator 

Now go back to the Apple menu and select Calculator. After a 
moment, the calcu lator wil l appear on the screen, as seen in Figure 
2-8. This , too, is a lways ava ilable, so tha t when you are using any 
other program, you can ca ll up the Calcula tor, do some work with it, 
and, if you wish, paste the resu lts into the document you are current ly 
working on. Let's try it: Enter "45 ,., 72 =" into the calculator. You can 
either use the mouse button to click the numbers a nd the symbols on 
the screen (all computers use the asterisk for multiplicat ion) or use the 
keyboard-the Mac intosh doesn't ca re . Now go to the Edit menu and 
select Copy. The n go the the Edit menu aga in a nd choose Show 
Clipboard. 

Voila! We have a new window, as seen in Figure 2-9, which can also 
be opened, closed, moved , a nd cha nged in size. Anything we Cut (that 
is, dele te) or Copy via the Edit menu goes to the Clipboard and stays 
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Figure 2-8. The Calculator, chosen from the Apple menu. 

there until we Cut or Copy something else. And what is on the Clip
board can be moved into any other document we are working on. (We 
could have copied the time from the Clock in the same way.) This is 
how the Macintosh permits us to move information from one docu
ment to another-it is a very powerful characteristic of the computer. 

Right now, you should have both the Clipboard and the Calculator 
on your desktop, plus the Write/Paint window and the clock, although 
the last may be covered by the Clipboard. Your desktop is getting 
busier, and it also shows the Trash icon and the shadow of the Mac
Write/MacPaint disk icon (where the window came from). Move the 
pointer back and forth among the windows and click on any of them. 
Notice that the appearance of the title bar of whichever window you 
have selected highlights to show that it is active- you can have many 
icons and windows on your desktop, but only one is active at any one 
time. Icons turn to black when selected, whereas windows indicate 
selection with a darkening of their title bars. You can only work on the 
active one, but can readily select another for action whenever you 
wish. 
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Figure 2-9. Calculator and Clipboard Windows after a Copy command. 

Lets close the Write/Paint window: make sure it is selec ted, then 
move the pointer to the File menu and, pressing the button, drag it 
until the Close option is highlighted (white on black) and release the 
button. The Write/Paint window returns to its icon. Note that you can 
close a window by either clicking on its Close box or by selecting Close 
from the File menu. 

Now select the Clipboard and move it (remember, you grab it by 
placing the pointer on the title bar and then pressing the mouse 
button) so that it covers part but not a ll of the Calculator, just as if you 
put a sheet of paper on your desk on top of a physical calculator. Then 
move the pointer to any part of the Calculator and click-whatever is 
selected will come to the front, and overlap other documents or icons on 
the desktop, as we see in Figure 2-10. Even if some icon is completely 
covered, it is still there-and can be seen if you move or sh ri nk or 
Close whatever is covering it. (If you want to move something without 
Selecting it, hold down the Command key when you press and drag on 
its tit le bar.) 
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Figure 2-10. The selected item always comes to the front. 

Try using the Calculator for a wh ile-it is quite s tandard in opera
tion (the E is for exponentia l notation, something computers use for 
very large numbers). When fini shed, go to the Fi le menu and select 
Close All. This puts the Clock, Calcula tor, and Clipboard back where 
they came from, on the MacWrite/MacPaint disk. You can a lways 
Close just the thing you a re currently working on by using its Close 
box or selecting Close from the File menu. And you can close every
thing that is open on the desktop by selecting Close All. 

Key Caps 

Now go to the Apple menu and se lect Key Caps , which wi ll give you 
a window showing the Macin tosh keyboard wi th a s ma ll rectangular 
screen at its top, as we see in Figure 2- 11. This window can also be 
moved around, but its size is not adjustable. It is used as a reminder of 
just what the keyboard can do for us. When it firs t appears, we see 
what each key wi ll type-hit a few keys a nd what you have typed 
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appears in the small screen, moving the vertica l cursor bar to the 
right with each character typed. Now hold down the Shift key and 
watch how the display on each key changes. Then try it with the Caps 
Lock key-this key does not shi ft the numeric keys, which makes 
sense for mos t computer applications . And try it again with the Op
tion key held down and then Option and Shift toge ther- these show 
the a lternate characters that the Macintosh keyboard can genera te 
and send to its printer, for foreign la nguage a nd other specialized 
applications. Square boxes appear to indicate a keys troke without a ny 
function- unless you want to type square boxes. 

Key Caps 

Figure 2-11. Key Caps with some writing on its screen. 

Any key currently being represented can be typed . For example , 
hold down the Option key and type a "w"-the sigma for "sum" 
appears on the little screen. By the way, as you might expect by now, 
the le tters ca n be typed either by hitting the appropriate keys or by 
clicking on the screen image of the key you want. 

Now type in a number of le tters or numbers so that there is some 
text in the sma ll Key Ca ps screen. Then use the mouse to move the 
poin ter until it is a lso in tha t screen, in the middle of what you have 
typed. Note how its shape cha nges from an arrow to a n !-beam, 
denoting tex t insertion. Move it between any two characters a nd c lick 
the mouse bu tton-the flashing line that is your actual cursor or 
insertion point is now where you have clicked . Type a letter or two-it 
will go in at the point you h ave selec ted , pushing the rest of the tex t to 
the right. Try the Backspace key as we ll , to erase from the point of the 
cursor backwards . Now move the "I" to the left of the very firs t le tter. 
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Press the mouse button down and drag the mouse a few characters to 
the right-your text highlights, meaning that it has been selected. 
Type in three or four charac ters: they rep lace the selected ones, as in 
Figure 2-12 . 

Figure 2-12. Key Caps showing new text inserted. 

Now move the "I" pointer to the left of the first character on the 
screen; press the button and drag all the way across. Everything you 
have typed is now selec ted. Move the pointer up to the Edit menu, 
open it, and selec t Cut (Command-X does the same thing from the 
keyboard). Your selected tex t has been deleted. But it is not yet gone 
entirely-go back to the Edit menu a nd select Show Clipboard. Your 
most recent Cut rep laces what had previously been Cut to there from 
the Calculator, as in Figure 2-13. 

Reactivate Key Caps by clicking on it; note that the flashing cursor 
is at the left edge of the Key Caps screen. Now go to the Edit menu and 
select Paste (Command-V from the keyboard), a nd whatever is on the 
Clipboard is inserted back into your "document"-in this case, the 
Key Caps screen. (With actual applications programs you can also 
select Undo from the Edit m enu to reverse your most recent action; 
this does not work with Key Caps, however.) Close the Clipboa rd and 
try it again-just selec t a ll the text in the screen by moving the cursor 
across it, then select Cut from the Edit menu and it disappears. Select 
Paste and it is back aga in. There is no need to actua lly open the 
Clipboard. This will work everywhere in the Macintosh. 

Finally, select all the tex t in the screen again, then hit the Backspace 
key. This also deletes whatever you have se lected, but in this case it is 
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Figure 2-13. Text that has been Cut goes to the Clipboard, from where it 
can be Pasted anywhere. 

gone forever. Unlike Cut, material removed with Backspace does not 
go to the Clipboard . Often , however, this is fas ter and more efficient 
for permanently getting rid of errors- or deleting stuff without affec t
ing what is on the Clipboard. You can also selec t Clear from th e Edit 
menu; it has the same effect as the Backspace key. With mos t a pplica
tions, un like Key Caps, you can use Undo to reverse dele tion ma de by 
the Backspace key. 

Key Caps is ha ndy for reminding ourselves of a ll the cha racters 
which can be typed , particularly since it can be checked while we a re 
using any application. It illustra tes the ma ny foreign a nd other specia l 
cha racters that are cons tantly available with the use of th e Op tion key. 
Several of these are "dead keys" that do not move the cursor a head, so 
tha t we can easily type ch aracters like "a" and "e". Compare the 
difference between hi tt ing the " ' " key and then the "Option ' " com
b ination- in the latter case, the typed character is not put on the 
screen until we type a nother ch aracter to go with it. 

While investigating Key Ca ps, we have a lso learned more about the 
Edit menu choices, text ma nipulation , and how the form of the cursor 
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changes, depending on what we are doing. Moreover, what applies in 
working with the Clock, or wi th Key Caps, is essentia lly the same 
when you are doing word processing, calculations, or whatever. This is 
why the Macin tosh is so easy to use-mouse actions, menu selections, 
text manipulation, and so on are identical no matter what you are 
doing. 

C ontrol Panel 

Now put everything away (Close All) so that all you have on the 
desktop are the MacWrite/MacPaint and Trash icons. You now know 
enough Macintosh basics to learn how to fine-tune the Macintosh to 
your liking with the Control Panel. Go to the Apple menu and select 
Control Panel. There are lots of things we can adjust to m ake comput
ing more personal and agreeable. Figure 2-14 illustrates the Control 
Panel as you should see it on your desktop, and Figure 2-15 is an 
exploded version for easier labeling (created, by the way, with 
MacPa int). 

Control Panel 

5/31/84 

Figure 2-14. The Control Panel from the Apple menu. 

First, we see the clock once again; the time and date, but not the 
alarm, can be changed h ere as well as from the Alarm Clock itself. As 
before, when we move the cursor over part of the t ime or date, it 
becomes a"+." We can select any number, then either type in what we 
want or use the arrows th at suddenly appear. Selecting date or time 
freezes the clock; select something else or hit the Return key to ge t it 
going again. 
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Figure 2-15. An exploded Control Panel, with labels for each function. 

To the left of the clock is a n analog gauge permitting the selection of 
speaker volume, from s ilen t operation through very loud indeed. Sim
ply move the pointer to the white bar and drag it; wherever you s top, 
Macintosh will beep, showing you wha t the volume level will be. 

To the right of the clock, a bit less obvious, is your means of choos
ing the blinking rate for ite ms selected from menus. When you make a 
menu selection, that ac tion can be impiemented immediately o r there 
can be a brief pause while the name of your selec tion blinks at you . 
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Click 0, I , 2, or 3 to control the number of blinks, which means the 
speed at which the selection is implemented. To see its effect, just go to 
the Edit menu and select Undo (i t won't actually undo anything here) 
and watch what happens to the word Undo with each rate. 

Beneath the blinking rate box is one that controls the blinking rate 
of the cursor under any application. As you choose 1, 2, or 3, the 
blinking rate of the cursor above shows you how rapidly it will flash in 
practice. 

In the middle are two controls related to the auto-repeat action of 
the keyboard; all typing keys are capable of automatically repeating 
when held down. The lower one-with the finger symbols-controls 
how long you must keep a key depressed before it begins to auto
repeat. It varies from a very brief delay (4) to no repeat action at all (0). 
If you find keys unintentionally auto-repeating, select a lower number. 
The upper control, with tortoise and hare, sets the actual speed of 
keyboard repeating. The higher the number, the more rapid the repeat 
action will be. The nature of your typing skills will de termine what 
works best for you. Since the Control Panel can be called up at any 
time, you may find it easies t to adjust keyboard characteristics when 
you start using MacWrite for word processing. 

There are also two con trols for mouse movement. The one on the left 
affects how far the pointer moves on the screen relative to mouse 
movement on your tabletop. At setting 1, the pointer will move further 
when you speed up mouse movement on your table; at sett ing 0, the 
pointer moves the same distance regardless of mouse speed. The 
second mouse control relates to double-clicking; we will be learning 
that one Macintosh shortcut is to click the mouse button twice, rather 
than clicking once to se lect and then going up to a menu to choose an 
action for that selection. This control determines how long the Macin
tosh will wait between clicks and still assume you are double-clicking. 
Newcomers may prefer the longes t delay (where the arrows are fur
ther apart); after you get used to the Macintosh, you may want things 
to go faster. 

Finally, in the lower middle of the Control Panel, you h ave the 
means to create a different pattern for your desktop. In the two boxes 
are, on the left, a magnified dot or bit image of a pattern (comparable 
to what is ca lled FatBits, which we wi ll encounter when discussing 
MacPaint), and, on the right, the way that pattern will look as our 
desktop. There are numerous preset patterns, which can be viewed by 
clicking on the white bar above the right-hand box. As you click at 
either the left or right side of that little bar, the available patterns fill 
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the box below and their magnified image appears in the box to the 
left . If you want any of these patterns for your desktop, move the 
cursor into the right-hand box itself and click the mouse button- your 
whole desktop will take on th at pattern. 

You can even customize your desktop with a pattern of your own 
design, by manipulating the dots in the box on the left. Click on a 
white area and drag the mouse-the white dots you cover turn to 
black; click on a black dot , and the black ones you drag over turn 
white. Its effects are immediately seen in the changing pattern of the 
box on the righ t. Again, click in the middle of that box a nd your actual 
desktop pattern will correspond. Play around with it and you will see 
the possibilities. It is not a terribly meaningful facility, perhaps, but 
does suggest how the Macin tosh tries to make computing correspond 
to your own preferences. In Figure 2-16, we have created an "A for 
Apple" pattern for our desktop. 

Whatever choices you make with the Control Panel will be stored on 
the current diskette, and will come up automatically the next time 

,. 
File Edit Uiew Spec in I 

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 

., 

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA A 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAA AAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAARRRRRRR RRRRRRRRRRRR 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAA AAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAA AAAAAAAA AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAA AAA AAAAAAAAAAAAAAAAAAAAAAAAAAAAAA AAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAIAAA 
AAAAAAAAAAAAAAAAAA AA AAAAA AAAAA AAAA AAAAAAAAAAA AAAAAAA AAAAA II II A AA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA AAAAAA AAAAAAA AA AAAA AAA 
AAAAAAAAAAAA AAA AAAA AAAAAAAAAAAAAAAAA AAAAA AAAA AAAAAAAAAA AA AAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA AAA 
A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AA A A A A A A A A A A AA A A A A A A A A A A A A Trash A A A 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA AAA AAAAAAAAAAAAAAAAAAAAAAAA AAAAAA 
SAAAAAA A AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA~ 

Figure 2-16. Control Panel showing a customized desktop pattern. 
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you turn your Macintosh on, if you are using that diskette . By se tting 
the Control Panel differently with different disks, you can, if you wish, 
have one cus tomized setup for one application and a different one for 
another. Once you have all the choices as you want them for the 
moment, click the Control Panels Close box to put it away. 

S crapbook 
Now select Scrapbook from the Apple menu. The Scrapbook can be 

thought of as a more permanent version of the Clipboard. Remember 
that anything we Cut or Copy automatical ly goes to the Clipboard, 
from where it can be pas ted into another document, if des ired . The 
Clipboard can hold a lot , even severa l pages of text, but it holds only 
one thing at a time-as soon as we do another Cut or Copy, that 
material rep laces what is currently on the Clipboard. 

The Scrapbook, on the other hand, is for longer-term s torage, partic
ularly of things we use often-a letterhead, perhaps, or a company 
logo. Anything we create with MacPaint or MacWrite or some other 
Macintosh application can be Cut or Copied to the Clipboard and then 
Pasted into a screen of the Scrapbook. From there it can b e copied 
back onto the Clipboard and then into whichever document we a re 
currently working on. Note that the Scrapbook window, like that for 
the Calculator, can be moved around the desktop but its size cannot be 
changed. 

When you start out, the Scrapbook has fi ve screens, the first of 
which has some information on it; the other four have sample pic
tures, which you can get rid of whenever you want. The left and right 
scroll arrows a t the bottom of the Scrapbook le t you scroll from one 
picture to another (there are no up and down arrows b ecause the full 
height of the Scrapbook's window is a lready there). And between the 
scroll arrows we make our firs t use of the scroll bar and scroll box, as 
illustrated above in Figure 2-5. Put the pointer anywhere in the gray 
scroll bar and click- the scroll box jumps in that direction and you 
have scrolled to the next window, as seen in Figure 2-17. Alternatively, 
you can drag the scroll box itself to a ny position on the ba r you desire . 
When you begin to work with larger documents, the scroll bar and 
scroll box will permit rapid movement through the m, both horizon
tally and vertically, as applicab le . 

The Scrapbook numbers its screens, and always te lls you just where 
you are (" 1 of 6," "2 of 5," and so on). It a lso te lls you whether the 
screen's contents are text or a picture . The Scrapbook does not always 
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Figure 2-17. Screen 2 of the Scrapbook, showing the Scroll box moved 
along the Scroll bar. 

., 

seem to be s toring documents exactly as they were created-text, for 
example, will be s ma ll a nd not show actua l type fon ts used in its 
creation. But Scrapbook remembers, and when you transfer its con
tents back to an actual document, it will look exactly as it did when 
you created it. Any one Scrapbook screen can be deleted by simply 
selecting Cut [rom the Edit menu when that screen is showing. To add 
something to the Scrapbook, jus t Paste it wherever you want-what
ever is there wi ll be automatically pushed to the next page. There is no 
limit to the number of pages you can have. Now you can put the 
Scrapbook away-click on its Close box or choose Close from the File 
menu. 

Note Pad 

Open the Apple menu and select Note Pad; your pad of notepaper 
appears on the screen . In some ways, the Note Pad is comparable to 
the Scrapbook and Clipboard, in that text from other docu
ments/progra ms can be Cut o r Copied and stored there, and will 
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remain as long as you wish . It works only for text, however; pictures 
will not transfer to it. Moreover, unlike the Scrapbook, it has a finite 
number of pages, only eight. But text can be directly typed into the 
Note Pad, whereas in the Scrapbook and Clipboard information has to 
be transferred from the application that created it. 

The Note Pad is useful for keeping notes to yourself-a "things to 
do" fil e, as in Figure 2-18, tha t will not get lost on the desk or 
inadvertently thrown out. If you become a Macintosh adventure game 
fanatic, the Note Pad is a good place for entering things you want to 
keep track of. You can move easily from page to page . At the lower left
hand corner of any page, click on the turned-up corner to page for
ward or on the flat corner beneath it to page back. 

Scrapbook 
Alarm Clock 

Calculator 
Key Caps 
Control Panel 

1. Buy another Mac so the kids 
will leave mine alone. 

2. Use MacPaint for a card for 
Mom's birthday-instead of a 
present. 

3. Answer letter from IRS. 

Figure 2-18. The Note Pad with some text entered on page 3. 

., 

Right now, turn to page two of your Note Pad, which should be 
empty. Type in a few lines of text. Watch how the Note Pad , like a word 
processor, does word-wrap-if a word is too long for its line, it is 
automatically moved to the next. You do not have to use the Re turn 
key. Now move the pointer to some point in the middle of what you 
have typed-it should turn into the 1-beam sha pe when you are prop-
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erly situated . Press the mouse button a nd drag down and to the right 
until some of your text is highlighted; then release the button. Now 
choose Cut from the Edit menu (or Command-X from the keyboard) to 
delete the selected text . The n go back to the Edit menu and choose 
Undo (or Command-Z from the keyboard), as in Figure 2-19, for your 
first try at changing your mind. Undo is extremely valuable, and even 
works for text deleted with the Backspace key. You can even Undo an 
Undo, and the Undo of an Undo, and so on, in case you have difficu lty 
making up your mind. Now move the pointer to a clear part of the 
page and cl ick the button once-the text is dese lec ted . 

This is an example of entering 
text into the Note Pad; it uses 
word-wrap like a word 
processor --you don't have to hit 

:)[:!~ the RETURN key at the end of a 
::_::::·::J .......... -.............................................. 1 line. Let's delete 1l6ii@b and 

·::m~m~~m7.1 replace it with Mac. 

Macintosh 2 

Figure 2-19. Cutting and then Undoing a Cut in the Note Pad. 

., 

This is a good place to practice a bit of tex t manipulation. Try 
insert ing a le tte r or two in the middle of a word-just move the 
pointer to where you want the new text to star t, cl ick, and then type. 
Next, try to selec t just one word or a single charac ter by moving the 
cursor nex t to it , pressing, and dragging left or right over wha t you 
want selected . Note that selected tex t can not only be Cut or Copied, it 
can also be replaced by just typing-anything you type in , regard less 
of length, wi ll replace what is highligh ted. This abi lity, too, is a lways 
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available in all Macintosh applications, and makes editing tex t of any 
kind very simple. After you have experimented a bit, close the Note 
Pad. 

Puzzle 

Finally, the Apple menu provides an elec tronic equivalen t of an old 
tiles-in-a-box game, to resort to when serious computing becomes 
tedious . Select Puzzle and click to move the tiles around the box until 
you have them lined up in correct numeric sequence, across in rows 
from top to bottom, with the empty space in the bottom-right corner. 
When you get it right, the Macintosh will let you know. 

In this chapter, we have dealt with two very important things. Firs t , 
we have gone over the Apple menu, and learned what its options 
provide for us. Second, and more important, we have lea rned a lot 
abou t the desktop, windows, and the pointer, and have used most of 
the basic Macintosh techniques for creating, editing, and manipulat
ing information. We are now ready for the Finder. 

Checklist for Chapter 2 

1. The mouse moves the pointer, and clicking the mouse button initiates an 
action. 

2. When we click on an icon, it is selected or active-pre pared for some 
furt her action. Clicking e lsewhere deselects. 

3. When we depress the mouse button and hold it down, this is called 
pressing, as opposed to cl icking, where we re lease it immedi ately. 

4. We drag the mouse by moving it to a chosen place, depressing its button 
and continuing to hold it down whi le moving the mouse . Th is is used to 
make a choice from a menu or to select a range of text. 

5. The pointer has a variety of sha pes (arrow, I, +, etc.) depending upon 
where it is a nd what actions a rc available . 

6. We open a menu by pressing on its title in the menu bar, then dragging 
the pointer down to our selection and releasing the button . 

7. Windows can be moved, and made la rger or sma ll c1·, and we can scroll 
through the ir contents by clicking on their arrows or by clicking in the 
scroll bar or dragging the scroll box. 

8. Many windows a nd icons can be on the desktop, but only one is selected 
at a ny time. We select one by cl icking on it; its appearance w ill change 
slightly (highlight), and it will move to the foreground. 
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9. We close a window by selecting Close from the File menu or clicking in 
its Close box. If more than one window is open, selecting Close All will 
close all of them automatically. 

10. An insertion point within a body of text is set by moving the pointer to a 
chosen location and clicking. We can then type in new text, or drag the 
mouse to highlight any text for further action. 

11. Selected text can be replaced by typing or pas ting in new text. It can be 
deleted by choosing Cut from the Edit menu (Command-X from the 
keyboard) or with the Backspace key. 

12. Selected text can be copied by choosing Copy from the Edit menu or 
Command-C from the keyboard . 

13. Text tha t has been Cut or Copied goes to the Clipboard, from which it 
can be Pasted elsewhere (by selecting Pas te from the Edit menu or 
Command-V). Text cut with the Backspace key or with Clear from the 
Edit menu does not go to the Clipboard. 

14. The Undo selection from the Edit menu (01- Command-Z) lets us reverse 
our most recent action . 

IS. All of the tools on the Apple menu arc constantly available, and can be 
used whenever the Macintosh is on. 
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I ntroduction 

If you open the System Folder on either your System or Wri te/Pain t 
di skette, you will find several miniature Maci ntosh icons. Two of 
them- System and Finder-make up most of wha t on other comput
ers would be ca lled the operating system. They are important parts of 
the sys tem software we d iscussed in Cha pter 1, a nd, for your own use, 
the Finder is the most s ignificant. The Finder does a ll kinds of crucia l 
housekeeping chores that keep the Macintosh operating effic iently
copying d isks a nd parts of them , saving a nd s toring documents, get
ti ng back s tuff you have previous ly s tored , and so forth . 

In this cha pter, we will go over most of the th ings the F inder does 
(reserving a few a dva nced ones for Chapter 4), learning how to use 
them, and at the same time learn ing a few more s tandard Macintosh 
procedures. The Finder is actua lly a n application or program, a l
though you canno t open it directly. You shou ld consider it as such , 
however, in order to unders tand its operation, as we shall sec. It is 
automatically opened a nd run when the Macintosh is turned on, 
un less you have specified tha t a nother application should replace it; 
th is will be covered in Cha pter 4. 

D isk Displays _ _ __________ _ 

If your Macintosh is no t on , put in the Write/Pain t disk and turn it 
on . You should see the Wr ite/Pa int d isk icon and the Trash icon on your 
desktop. Ma ke sure the Write/Paint icon is 1101 selected; that is, if it is 
black, click on a bla nk part of the desktop, so tha t it becomes white. 
Now move the pointer to the Write/Pa int icon and cl ick twice in rapid 
succession- if you have done i t correc tly, the icon will open a nd the 
Write/Pa int w indow a ppears. (If you didn ' t click quickly enough, you 
may have just selected and then deselected the icon-try aga in .) 

This is double-clicki11g, a much-used shortcut with the Macin tosh . 
Ra ther tha n c licking once on a n icon to selec t it , and then moving up 
to the File menu to se lect Open, you can simp ly double-click on any 
icon to select a nd open it s imultaneously. We w ill encou nter add i
t iona l uses fo r doub le-clicking as we go a long. (Some of the emerging 
applications for the Macintosh a lso e mploy triple-clicking, but it is no t 
used by a nything we are dealing with in this book.) 

You should now have the Write/Pa int window in front of you, w ith 
icons for the MacWrite, MacPa int , and Font Mover programs, the 
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System Folder and Empty Folder, and one or more sample docu ments . 
There may be others, as well , or the Font Mover may not be there, 
depending on when you purchased your Macin tosh. Now move the 
poin ter to the View heading and press to open the menu . Your screen 
should look like Figure 3-1. The Finder offers us a variety of ways in 
which to d isplay the conten ts of any disk or folder window. Note the 
check in front of by Icon- the default form at in which the Macin tosh 
norma lly d isplays the conten ts of any disk or folder. But it a lso offers 
the option to display those con ten ts a lphabe tically by Name, chrono
logically by Date, by Size of each i tern (la rges t fi rst), or by Kind (such as 
docu ment or fo lder). 
r • File Edit Special 
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Figure 3-1 . The Write/Paint disk window with the View menu open. 

Try each of these op t ions to see what the d isplay looks like. Note 
that , while the by leon option ha's a bar a t the top telling us the to tal 
space used and available on the disk , the o ther op tions do not offer 
this . Each of them , however, does give us more precise information
the size of each ind ividua l item a nd the date of its most recent 
modification. Examples of each of these w indows are given in Figure 
3-2. S ize is often importa n t when we want to tra ns fer a document 
from one di sk to another- the by Icon display will te ll us how much 
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space is avai lab le on the destination disk, and any of the other displays 
tells how big the document we want to transfer is . 

VIEWING THE CONTENTS OF A DISK 
10 
Ill! ·- I By SIZE, largest first. I 221< CAP 
121< VAlL fol<Hr Tot, MIV 211, I !94 

IlK cb2-drowtn, M•cP oint documtnt Tvt I Mey 22 I 15191 

6K m•cfonts docum•nt Tut,Miy 22,1191 

3K ,rondmo docY~Mnt t'bl, t'b/20, 1904 

OK Emptv foldor fol<Hr Fri,t'b/18, 1984 

i'\ 

IQI 1;11 ORTR RJ 

!0 DR Siz• ....... 
Stzo l!mM I By NAME, 221< CAP 

Alphabetically . 121< YAEL 
22K CAP 

OK (mptlj fo ldor 
Il K cb2-drowing MocPoint documtnt 
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~ I By KIND, within 
kinds by size. 

Ql 10 112: 
~ 

10 I 
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Figure 3-2. The Finder offers us five different ways to View the contents of 
a diskette. 
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Any one display may be preferable at one time or another, so the 
Finder permits us to use whichever we want. If a disk has many 
documents, display by means other than Icon takes up less space on 
the screen, so that we can see more information in a single window 
without having to scroll. And the way we leave the display when we 
close the window is the way it wi ll be when we next open it. 

Make sure that you have the display by Icon, and we will look 
further into the Finder. 

Copying and Moving _________ _ 

One of the Finder's main tasks is to copy things for us, whether it be 
an entire disk, a tool of some sort, or just a single document. Every 
important diskette should be backed up-that is one of the first 
principles of computing. Moreover, the storage capacity of diskettes is 
easily exceeded, so you will often need to move your documents from 
the diskette with an application on it to another diskette for storage. 
Copying with a single-drive system is somewhat laborious (less so 
with a 512K Macintosh than a 128K one), and can be a li ttle confusing. 
But the Finder keeps track of things for us to help avoid errors. We will 
look at copying for both single- and two-drive systems, and for earlier 
and later versions of the Finder as well. We will a lso cover the dif
ferences between copying an entire d isk and copying only parts of a 
disk, and between copying onto the same disk or to a different one. 
The procedures remain quite consistent. 

Copying a Whole Disk 

To try disk copying, we will need a second disk. If you have a single 
disk drive, click on the Write/Paint window's Close box, and then 
choose Eject from the File menu (Command-E from the keyboard). 
The Finder ejects the disk but keeps a shadow of its icon on the 
desktop; it remembers what is on the disk and is ready to refer back to 
it, or to te ll us to reinsert it, when necessary. 

Now insert a blank disk in the drive, or, with a two-drive system, 
put the blank di sk in the externa l drive. The Finder presents a Dialog 
box saying the disk is unreadable and asking whether you want it 
initialized. Diskettes require initializing (also often called formatting) 
before they can be used . This is a process of electronically marking 
them into the divisions the computer uses for storing data. Click on 
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Initialize, and give the Finder a few moments to prepare the disk. An 
information box tell s us that the process is underway, and when done 
it takes on the appearance of Figure 3-3 . The Finder wants us to give 
each di skette a name so that it can be manipula ted without confusion. 
Since this will be our main backup di sk (perm itting us to store the 
Write/Paint disk in a safe place), let's name it W/P Copy. Type that in. 
Use the Backspace key if you make an er ror, or use the mouse to edit 
tex t just like you did in Chapter 2. Then click OK, a nd the Finder puts 
a second diske tte icon on our desktop (this looks the same whether 
your system has one drive or two), which should look like Figure 3-4. 
Note that the Write/Paint icon is s till in shadow form on single disk 
systems, since that diskette is not currently in the drive. (The Get Info 
window for any disk icon will tell you whether it is "in internal drive," 
"in external drive," or "not in any drive.") 

Please name this disk: 

OK ) 

Figure 3-3. A Dialog box after diskette initialization, asking us to name the 
newly formatted diskette. 

Now, what we want to do is copy the whole Write/Paint disk. (If you 
have the newer version of Macintosh software, with the Disk Copy 
application , read on to page 58 first, since you have a faster way to do 
this . It never hur ts, however, to learn all possible ways to do things.) 
Press on the Write/Paint icon to select it , a nd drag it over the W/P icon, 
until the latter highlights ; th en release the mouse button. The Macin
tosh provides us with a Dialog box, as in Figure 3-5 (if you have a dual
drive system , with W/P Copy in the externa l drive, references to "not 
in any drive" are replaced by "external drive") to give us a chance to 
back out if we wish . But we do want to replace the contents of W/P 
Copy with the contents of Write/Paint, and so we cl ick OK. 

The Finder now provides s tep-by-step instruc tions for disk switch
ing for single-drive systems, while it copies as much as memory allows 
in each pair of disk swaps. It a lso gives us some ind ication of its 
progress, as seen in Figure 3-6. With the ear lier version of the Finder 
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Figure 3-4. The desktop with two disk icons. 

Completely replace contents of II W/P 
Copy~~ (internal driue) with contents of 
II Write/Point II (not in ony driue)? 

( OK ) ( Cancel ) 

Figure 3-5. The Finder provides a Dialog box when we do a total disk 
copy. 

and a 128K sys tem, you will have ten to twelve swaps-this is some
thing that sells a lo t of second disk dri ves and 512K upgrades to 
Macintosh use rs! On dual-drive sys tems, of course, there will be no 
swapping instructions; the Finder just copies from one drive to the the 
other (the Finder doesn't care which has the origina l diskette and 
which the copy). Eventua lly, it finishes and you have copied an entire 
disk. 
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~~ 
~ 

~ 
~ 
~ 
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~ 
~ 
~ 
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Files remaining to copy 

~ 

,. ...... 
I 9 I 

bl~ Please insert the disk: 
't ...... : 

Write/Paint ~~~ 
~~~ 
~~I'S 
~~~ 

~~~~=~~~ 
~~~~~~~ 
~~~~~~~~ 
~~~~ ~ ~~ ~~ 
~~~~ ~ 

Figure 3-6. The Finder leads us through disk-swapping for file transfers. 

Now is a good time to put your original Write/Pa int disk away in a 
safe place. Select whichever di skette is in the drive, then choose Eject 
and turn the Macintosh off. Wait a moment, put the W/P Copy disk in 
the drive, and turn the Macintosh back on. If you wish, you can 
rename it anything you like , including Write/Pa in t- just avoid having 
two diskettes with the same name in the Macintosh at any one time, 
because the Finder can be confused by this. If you ever do this acciden 
ta lly, just rename the last disk you inserted before you do anything 
else. 

Most Macintosh owners should have the upgraded version of the 
system software, released in the late spring of 1984. (If you do not , you 
should go to your Apple dealer and request it; the upgrade is free.) The 
upgraded software has several ch anges and additions, one of which is 
of interest here-the Disk Copy application, whose icon can b e seen in 
Figure 3-7 (this is from a disk other than the one we have been using 
for examples so far). If you do have this prograin, which is for single
drive systems and {or whole disk transfers only, you should use it, 
because it is much faster than the procedure outlined above, particu
la rly for 128K systems . 

With Disk Copy, you can copy a ny one disk to any other disk; neither 
need have been inserted previously. Also, Disk Copy will automatically 
initialize a new diskette, so you will not h ave to go through initia liza
tion beforehand. You simply open the Disk Copy icon, which produces 
a window similar to that il lustrated in Figure 3-8. If you click OK, 



---------------------3 I The Finder 0 59 

Disk Copy prompts you on inserting the original and copy diskettes, 
with only four swaps needed to get the job done. You have the option 
of canceling and quitting at any time . As the text in Figure 3-8 notes, 
Disk Copy works by taking over some of the display memory, so you 
will get some odd stuff on the screen during copying; this is quite 
normal. 

~ ~ ~ 
Disk Copll Fonts Seattle 

LJ LJ ~ 
System Folder Empty Folder Font Mover 

Figure 3-7. A disk window showing the Disk Copy icon. 

About Disk Copy 

With Disk Copy you tan copy entire disks quickly using a 
one-driue system. 

Messages at the bottom of the screen will ask you to insert 
alternately the disk you want to copy and the destination disk. 
Any uninitialized destination disk will be initialized 
automatically. 

To minimize the number of disk swaps needed, Disk Copy uses 
the space in memory that's allocated to the screen display; 
therefore, unusual patterns will appear on the screen during 
the copying process. 

OK Cancel 

Figure 3-8. The Disk Copy information screen. 
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Copying Files 

While we will occasionally want to copy an enti re di sk, far more 
often we need to copy jus t one or a few documents, or perhaps an 
application. The term file is universal in computing, referring to any
thing s tored on a disk-a program, a document, or whatever. First, 
let's initialize another disk to use for fil e transfers: eject W/P Copy and 
put in a new disk (with two-drive system s, put the new di sk in the 
external drive) . Follow the Finder's instructions for initia li zation, and 
then name it DATA# l - it will be a disk for s toring documents created 
by applications on other disks. Since we won't have any of the system 
files on it , there will be lots of room for storage. 

Make sure DATA # 1 is in the drive-if not , eject W/P Copy a nd then 
put it in. Now open W/P Copy; no te, on s ingle-drive systems, tha t you 
can do so, and see its contents w indow even though it is not in the di sk 
drive. Select the Sample Memo icon by clicking on it, then drag it to 
the DATA # 1 icon; the Finder will tell you to insert the W/P Copy 
diskette, so it can read in the file, and present a window like Figure 

r j File Edit Uiew Special 
., 

Files remaining to copy 

Moc'v/ritt> MocPoir 

II 
Empt~ Folder S~stem Folder Somplt> Memo 

Figure 3-9. Copying a single file from one diskette to another. 
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3-9. Again, depending upon the size of the fil e being transferred , this 
can take one or several disk swaps. 

If you have a number of fil es to move from one d isk to ano ther, you 
can provide a ll the instructions a t one time by selecting them all 
together. This is a technique tha t you w i II use for other purposes in the 
Macintosh as well. Make sure the icons on the W/P Copy window are 
so set up that MacWrite is jus t above System Folder, as in Figure 3-10, 
with the pointer slightly above and to the ldt uf the MacWrite icon. 
Press , then drag the pointer down a nd to the right , so tha t the box of 
dotted lines you are creating includes both icons; re lease the mouse 
button and both are selec ted, as in Figure 3-11 . If you don't get them 
both, just release the button a nd click on any blank area of the 
window, which will deselect everything; then start over. Now, if you 
wanted to copy them, you would press and drag either one; both 
images would be dragged to the icon of the di ske tte you wanted to 
copy to. This would be a practical way to create a separate MacWrite 
diskette, with more room for documents. 

W/P Cop 
6 it•ms 

~ ~ 
MocW'rite MocPoint Font Mover 

LJ LJ I . 
System Folder Empty Folder Sample Memo 

Figure 3-10. Setup of W/P Copy window for double selection exercise. 

There is another way to select multiple icons, which is even easier, 
especially when the items to be selec ted arc no t adjacent. This is by 
shift-clicking. Make sure a ll icons in the W/P Copy window are de
selected Uust click on an empty area of the window). Now, whi le you 
hold down the Shift key, move the mouse a nd click on MacWrite, 
MacPaint, and System Folder-all three are selec ted. As with drawing 
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W/ P Copy 
363K in disk 

MocPoiot 

LJ 

36K avoilobl• 

Font Monr 

~ 
~ 

Empty F old~r Sample Memo 

Figure 3-11. This is how the window should look after you have made the 
selection by drawing a box around the two icons. 

a selection box, this technique is a lso used within a ll Macin tosh 
app lications. Here, we see th eir use for copying files from one disk to 
another ; obviously, the tech niques are equ ally time-saving when we 
wan t, for example, to trash a nu mber of objects. Now click away from 
the icons to deselect them. 

The Select All choice from the Edit menu (Command-A from the 
keyboard) is a lso used for m ultiple selections . If only one window is 
open, whether act ive or not, this choice selects a ll its icons . If more 
than one window is open , it selects a ll the icons in the acti ve one. And 
if no window is open , it selects a ll icons on the desktop; this is useful, 
for exa mple, to select both disk icons in a dual-drive sys tem , so they 
can be ejected with one Eject. 

Note that there is no way with the Macintosh to simply move a file 
from one disk to another; the process a lways involves copying, wi th 
the original application or docu ment or folder remaining where it 
was. This is for our own safe ty, but does requ ire an addi tiona l s tep if 
you don' t want the original-you h ave to drag it to the Trash after you 
have completed the Copy. 

Duplicating 

So fa r, we have dealt only with copying from one diskette to another. 
Sometimes, we want to make a copy of something and keep it on the 
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same diskette the origina l is on. For this, we use Duplicate from the 
File menu (Command-O from the keyboard). Selec t Sample Memo, 
then choose Duplicate; the result is as we see in Figure 3-12-a copy is 
made and automatically named "Copy of" . . . whatever we have 
copied . It is also automatically selected, so that we can immediately 
type in a new name for it. 

Put Back 

Close 
Close Rll 
Print 

............................................. 

33K availabl• 

Font Monr 

Sample 

Figure 3-12. Making a copy of an item to the same diskette. 

There are various reasons why we might want copies of some docu
ments on the same disk. This is one of the ways (we will see another 
later) in which we can maintain the original copy of something, while 
modifying it under a different name. It is also useful for things like 
creating a letterhead-you can use MacWrite to create any number of 
d ifferent letterheads, with the heading, margins, and other features 
you want, and then keep the master copies on the disk. Every time you 
want to write a le tter, you need only duplicate the appropriate docu
ment, rename the copy, and open it as a MacWrite document. You have 
a piece of preprinted stationery ready to go. Sometimes, also, we 
make a copy of some document because we want to leave it out on the 
desktop, perhaps for la ter copying elsewhere or as a reminder of its 
need for more work. You can ejec t the diskette a nd even turn off the 
computer; when you turn it back on, the copy will be in the same 
place on the desktop where you left it , as we see in Figure 3-13. 

This would be a good time to practice your disk copying skills by 
creating a couple more work disks, one with MacWrite and the System 
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,. a File Edit Uiew Speciol 
., 

Figure 3-13. An item left out on the desktop will still be there the next time 
we turn on the Macintosh. 

Folder, and the other with MacPaint and the System Folder. You might 
call the first WRITING and the second DRAWING. Each will leave you 
with more elbow room for creating documents on a single drive 
system. (In the next chapter, we will look at thi s topic, and the Font 
Mover, in detail, to see how even more room can be made.) As you do 
some work, try moving completed documents to the DATA # 1 dis
kette; it is genera lly a good idea to s tore documents on such a diskette, 
freeing up room on your work disks. Even more, you should have 
backup copies of anything of value. It can be d isastrous if you let the 
minor aggravation of disk swapping with a single-drive system dis
cou rage you from proper backing-up proced ures. 

Storing 

Folders 

The Finder a lso helps us to store information simply and logically. 
As in most physical office systems, the Finder uses folders-we can 
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put documents, and other things as well , inside [olders. And we can 
even store folders inside of other folders, permitting a very powerful 
and sophis ticated system of what, on other computers, would be 
called "hierarchical fil e handling." You can readily organize all your 
information, within folders, in a scheme that emulates the rea l-li fe 
method of storage of file cabinet to file drawer to individual folder. 

Let 's try it. Tur n off your Macintosh, insert your W/P Copy disk, a nd 
turn it back on. Double-click on its icon to open its window and then 
select Empty Folder. Type Command-D for Duplicate. Type Command
O again, then once again. You now have Copy of Empty Folder, Copy of 
Copy of Empty Folder, a nd Copy of Copy of Copy of Empty Folder, as 
illustrated in Figure 3-14. This could go on forever! Maybe that's one 
too many-make sure that Copy of Copy of Copy of Empty Folder is 
selected, and drag it to the Trash icon . Now we're rid of tha t. 

W/P Copy 
382K in disk 

Moe 'w'ri~t> MocPoint Font Movt-r 

0 
Sy s~em Folder 

Copy of 

Copy of Copy of 

~ 
EJ 

1 7K OYOilabl~ 

Somplt> Mt>mo 

lder 

Figure 3-14. W/P Copy window after three duplications of Empty Folder. 

Now select Copy of Empty Folder and type in a new na me: Trial 
Folderl . Then select the Copy of Copy of Empty Folder a nd name it 
Trial Folder2. Now we can do some practice organization. We want to 
select MacWrite, MacPaint, a nd Font Mover, which you can do either 
by shift-clicking or by dragging a selection box around a ll three. Use 
whichever means you wish, so that your window looks like Figure 
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3-15. If you missed a nd a ll three are not selected, just deselec t and 
s tart over. Reme mber that you can en large the window and move 
icons around if you need more space. 

W/P Copy 
8 items 375K in disk 24K OYailabl~ 

• IINW 

[] 
S!J stem Folder 

[] 
Empty Folder 

Sample Memo 

[] [] 
Trial Folder1 Trial Folder2 

Figure 3-15. W/P Copy Window with new folders and three icons selected. 

Now cl ick on any of the three se lected icons a nd drag to Trial 
Folderl; the outlines of a ll three wi ll move together, as in Figure 3-16. 
And when a ny one is over Tria l Folder! , the folder's icon will high
light-release the button and a ll three are deposited therein. Now 
select the Sys tem Folder icon and drag it to Tria l Folder2. Then select 
Tria l Folderl and drag it also to Tria l Folder2. Your W/P Copy window 
is much less cluttered now, as seen in Figure 3-17, a lthough this would 
not be a very effic ient organization for real-world applications. Still, 
you are ge tting the idea. 

Now double-click on Tria l Foldcr2. It opens and we see its con tents : 
the two folders we put there. Then doub le-click on Trial Folderl; its 
window appears, showing the s tuff we put in there . The sh adow of 
Tria l Folder] remains in Trial Folder2, to show that that is its official 
location. Your desktop should now look more or less like Figure 3-1 8, 
depending on the size of each window. Folders can hold documents 
and other folders, which in turn can themselves hold documents and 
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375K in disk 

• ·-J-:--Jd:·--_1] 
Empty F old~r 

0 0 
System Folder Trial Fold~r1 

0 
Trial Fold~r2 

Figure 3-16. Moving three application icons to a folder for storage. 

W/P Co 
3 items 375K in disk 24K available 

0 Sample 1"1emo 

Empty F old~r 

0 
Trial Folder2 

Figure 3-17. The W/P Copy window after storing icons inside folders and 
one folder inside another. 
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other fo lders-and th is can be carried to many levels. In a practical 
sense, think, for example, of a Letters folder, which in turn holds, 
perhaps, twelve monthly fo lders, or a group of subject fo lders, each of 
which has the actua l documents. That wou ld be much more efficient 
than a single window for the whole disk, displaying dozens of indi
vidual documents. 

As with a physical fi ling sys tem, a little thought in advance, plus the 
Finder's storing facilities, w ill permit effi c ient ha ndling of large num
bers of documents. If you do find a need for reorganization over time, 
it is certainly much easier to do under the Macintosh system than 
with manila fo lders a nd s tee l filin g cab inets. 

,.. • File Edit 
., 

System Folder Trial Folder1 

Figure 3-18. Desktop with W/P Copy window and two folder windows. 

While the three windows a re s ti ll open on your desk top, try se lect
ing firs t one, then a nother. Remember tha t only one window is active 
at a time, but that by clicking on a ny part of any w indow, you activate 
it and it wi ll come to the foreg round. Remember, a lso, tha t you can 
move any window around by pressing in its title bar and dragging it 
wherever you wan t on the desktop, a nd that you can ch ange th e 
window's s ize by p ressing on its s ize box and dragging. Try this, 
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moving the three windows and changing their sizes. Then select Trial 
Folder!, choose by Name from the View menu, and expand its win
dow so that all the information can be seen, as in Figure 3-19. Now 
make sure your printer is on, and a lso make su re that the Caps Lock 
key is up, not down. Then, simultaneous ly depress the Shift, Com
mand, and 4 (the number 4) keys. Your printer should give you a copy 
of Figure 3-19. 

D Trial Folderl 
Size Name Kind last Modified 

13~~ Font Mover opplic:otion TIJP. , .Jon 24 .• 1984 K} 
1=-

ErOK MocPaint opplic:otion Tue .• • .Jor1 24, 1984 

53K Macla'rite opplic:otieon Tue ..• .Jon 24 , 1984 

0 
'-01 1¢ Q] 

Figure 3-19. The Trial Folder1 window, showing the folder's contents by 
name. 

Directories 
A common practice in computing is to get a "directory" or "cata

log," that is, a listing of a ll the files on a disk, or a subgroup of those 
fi les. You a lready know how to do this on the screen-by simply 
opening an icon, you automatically see its contents, in any one of five 
ways . If you want to have hardcopy printout of the contents of any 
window, you follow the procedure just outlined: depress the Com
mand-Shift-4 combination with the Cap s Lock key not engaged. (If the 
Caps Lock key is down when you type Command-Shift-4, the Macin
tosh will print out the entire screen instead of just the active window, 
which is discussed below.) We wi ll look into some additional printing 
features in Chapter 4. 

Now change the Trial Folder! display back to by Icon, then resize 
the windows and move them so that they look abou t like those in 
Figure 3-20. Remember that you can move a window wi thout select
ing it by holding down the Command key whi le you press on its title 
bar and drag. Select the System Folder icon and drag it back to 
anywhere in the W/P Copy window. Then select Trial Folder! and 
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choose Select All from the Edi t menu or Command-A from the key
board. Then drag those icons back to the W/P Copy window. Now Trial 
Folder! is empty and Trial Folder2 shows only the shadow of Tria l 
Folderl. Select the latter and click in its Close box- it re turns to Tria l 
Folder2. Close Trial Folder2, and it returns to W/P Copy; you don't 
need it any more, so drag it to the Trash. 

r j File Edit Uiew Special 
., 

CJ 
Empty Folder Sample Memo Triol Folder2 

Trial Folder2 
3 itrms 350K in foldrr 36K oniloblr 

IEll Trial Folderl 
in foldrr 36K v v uvu .. 

~ ~ ~ Trial Fold~r l 
LJ 

System Folder 

Mac"w'rite MocPoint Font Mover 

11 111 1·~ ·-· : ~ 
. rra-;h !··· !·! 

:·: 
:.: 

Figure 3-20. The three open windows, ready to move icons back to their 
correct places. 

, .. 

Finally, make sure the W/P Copy window is ac tive. The various icons 
may well be sloppily situated in the window. So open the Specia l 
menu and choose Clean Up- the Finder wi ll reorganize all the icons 
for you . Of course, if you disagree with the Finder 's placements, just 
drag any icon to where you want it. Be careful with the Special 
menu-you don't want to se lect Erase Disk by mistake ; this is a Finder 
utility for getting rid of everything on a diskette . Fortunate ly, the 
Finder will a lways provide a n Alert box to let you change your mind 
about Erase Disk. Moreover, it wi ll refuse to erase the startup disk (see 
Chapter 4)-you mus t resta rt the sys tem with a s ta rtup di sk other 
than the one you wan t to erase. · 
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Trash 

The Finder protects us in numerous ways. For example, double
click on the Trash icon to see its window, which should look like 
Figure 3-21. Trial Folder2 is there (with Trial Folder! inside), and so is 
Copy of Copy of Copy of Empty Folder, which we put there earlier. The 
Finder holds onto stuff you throw away for a while, to give you a 
chance to change your mind. It will preserve what you trash, but only 
until you either select Empty Trash or open any application or turn off 
the Macintosh. This time, we don't want to resurrect any of this stuff, 
so go to the Special menu and select Empty Trash. Then move the 
pointer to the Trash window's Close box and double-click: this is 
another use of double-clicking, to both close and deselect any icon. 

-D Trash 
2 items 12K in Trash 

~ 

0 0 I 
Trial Foldtor2 Cop•~ of Copy of Copy of Empty Folder ro 

~I 1¢ '21 
Figure 3-21. The Trash window. 

File and Disk Locking 

Another means of protecting things is by locking them. Let's try this: 
select the MacPaint icon, then enter Command-! from the keyboard or 
select Get Info from the File menu. We get the descriptive window we 
have looked at before, illustrated in Figure 3-22. Note, first, the box at 
the bottom of the window which permits us to enter any notes we 
might wish, as I have done here. This is available for each Get Info 
window and is a useful device for keeping notes on our documents, 
etc. But note also the Locked box, which has just been clicked on in 
this example. When you click on the box, it changes its state from X'ed 
(locked) to blank (not locked) and back again. 

Any Macintosh application or docu ment can be locked via its Get 
Info box, in which case it cannot be trashed or replaced (by saving a 
new version or copying one from another disk) until you unlock it. 
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Kind: 
Size: 
lllhere: 
Created: 
Modified: 

(81 Lor:k:ed 

Information about MacPaint 

MaePaint 

applieation 
60416 bytes, au:ounts for 60K on disk: 
System Copy, internal driue 
Tuesday, January 24, 1984 at 1 0:04AM 
Tuesday, January 24, 1984 at 5:14PM 

This is the original uersion of Mar:Paint~ 

Fig. 3-22. A Get Info box with its Locked box selected so that the item 
cannot be trashed or changed. 

This is a way to avoid inadvertent destruction, a nd can be useful for 
things you do not p la n to cha nge . It is not a bad idea to lock programs 
and tools, a nd even some documents . Note tha t some Macintosh ap
plications won't work correctly when locked; the Macintosh will give 
you an error message if this is the case. Under no circums tances, 
however, shou ld you get into the habit of using locking as a substitute 
for the best method of data a nd p rogra m securi ty-backup copies . It 
can happen that every thing on a diske tte is destroyed, locked or not. 
The habit of backing up important m aterials regularly is one of the 
most importa nt any computer user can develop. 

You can also lock a n entire di sk by moving the sm all s liding write
protect tab a t its upper right-ha nd corner from down to up, so that the 
hole is uncovered. When a diskette is write-protected in this way, 
nothing can be written on it; its icons can be opened, copied from, and 
usua lly printed, but they cannot be removed or changed in any way. 
Many a pplications, including MacPa int, will not work when the disk 
is locked in this fashion , because temporary fi les a re created during 
their use. But it is a useful device for protecting the origina l copies of 
a ll your diske ttes-they should never be used in a ny case. 
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Closing and Putting Away 

Now make sure the W/P Copy window is ac ti ve . Select the Sa mple 
Memo icon, drag it down to the lower part of the deskto p, a nd leave it 
there . Then click the Close box of the W/P Copy window, so that it 
closes a nd returns to its disk icon . Then selec t Sa mple Memo again, 
a nd go to the File menu a nd se lec t Put Back, as illustrated in Figure 
3-23 . The Sa mple Memo icon goes back to its proper location, inside 
the closed W /P Copy icon. 

Edit Uiew Special 

Figure 3-23. Put Back returns icons to the folder and/or disk they came 
from. 

., 

The Put Back option can be very handy. Suppose you do some work 
on a document, then decide to leave it on the desktop in case you wan t 
to do some more work on it later. Then, a fter do ing some other things, 
perhaps with other diske ttes, you decide you want to put it away. 
Rather than opening a fo lder (or, perhaps, more tha n one folder) and 
dragging the document 's icon to it , you can jus t select Put Back- and 
it will go to its place automatically, even if its folder is not visible. I t is 
also useful when you have items out on th e desktop from two or more 
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disks; the Finder knows where each belongs (even if you have forgot
ten!), and Put Back wi ll do the job. 

Another Finder facility from the ,File menu, which we encountered 
in Chapter 2, is Close All. Open the W/P Copy icon, then open the 
System Folder icon and the Empty Folder icon as well. This should 
provide three windows on the screen, as in Figure 3-24. Select Close 
All from the File menu, and each will return to its proper place and be 
closed . Close All is like Put Back, but is for windows. It is identical to 
se lecting each w indow individually and closing it from the File menu 
or its Close box. 

;. 

Figure 3-24. Three open windows on the desktop ready for simultaneous 
closing. 

Ejecting 

., 

At this point, we should also clarify a few points about ejecting 
diske ttes, which you have done many times by now. You a lready know 
that a diskette icon has to be selected before it can be ejected; if it is 
not highlighted, choosing Eject from the File menu or Command-E 
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from the keyboard will not work. The Finder insis ts on controlling the 
Eject process, to make sure all files are closed and the disk has a 
record of where everything is. 

In addition to Command-E. there is another way to ejec t diskettes 
under keyboard control, which does work whether or not the desired 
disk is selected. Command-Shift-! will eject the disk in the internal 
drive, and Command-Shift-2 will eject the disk in the external drive. 
This technique can frustrate the Finder's record-keeping, however, and 
should not be used unless a normal Eject fails to work. 

Occasionally, for one reason or a nother (a power failure, for exam
ple, or some tempora ry hardware or software problem, or a n error on 
your part), the Macintosh will be turned off while a disk is in a drive. 
Just turn the Macintosh back on while holding the mouse bullon down;· 
the diske tte(s) will be ejec ted during the power-on sequence. Only if 
this doesn't work should you use the mechanical alternative-insert
ing a straightened heavy paper clip into the little hole to the right of 
the drive. That will work, but shouldn't be done unless you have to. 

Other Finder Services 

The services that the Finder provides vary with what you are doing 
with your Macintosh a nd the applications you are using. So far, we 
have concentrated on general Finder capabilities for the desktop and 
disk windows. When an application, such as MacWrite or MacPaint, is 
active, that application is in control of what Finder faci li ties are 
avai lable. Thus we wi ll learn some additional things about it in Chap
ters 5 and 6, which explore those programs, as well as in Chapter 4, 
where we look more closely at document and d isk management. 

We will note here, therefore, only a few general things we will find of 
use from within applications. The Finder permits us, for example, to 
save documents we have created, rename them , and so forth. When we 
work on any document, we can save it under whatever name it cur
rently has (if "Untitled," the Macintosh will ask us to name it), or we 
can use Save as ... , which lets us provide a new name at that time. 
Thus, we could make a change in a document and· save it under a new 
name, in which case both the former document and the new one will 
be maintained; this can be done repeatedly. It is an a lternative to the 
use of Duplicate, illus trated above, for working on several versions of 
the same document. 
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Usua lly, you will wan t to instruct the Finder to Save the docu ment 
you are currently working on as you deve lop it. This puts it on disk 
a nd avoids losing a ll your work, in case there is a power failure, for 
example, or something else goes wrong. Next to backing up all files, 
frequent saving while working is the most important security meas
ure we have. The Finder will also le t you s imply Quit, if you decide to 
s top work on a document; or Close, if you wa nt to pu t it away, but to 
continue using the same a pplica tion. In a ll of these cases, the Finder 
provides a Dialog box to give you a cha nce to cha nge your mind. 

The Finder also provides a connec tion to the printer, guiding us in 
selecting just how we wan t a document prin ted; we will look at this in 
de tail in the next chapter. In addi t ion to permitting us to prin t any 
document, the Finder will also let us print a n image of the screen, 
generally referred to as a screen dump. We saw above (Figure 3-1 9) that 
by depressing Shift-Command-4 we would get a n automatic printou t 
of the active window. If we do the same thing with the Caps Lock key 
in the down position, we get a printout of the en tire screen-desktop, 
t itles, and a ll. Numerous examples of this can be found in the illustra
tions for this cha pter. Try it now: ma ke sure the Caps Lock key is in the 
down position and your printer is on ; then hit the Shift-Command-4 
combination and see your current screen print out. This is very useful 
indeed , especially if you decide to write your own book about the 
Macintosh. 

Another, rela ted facility is the Finder 's ability to send a screen dump 
not to the printer but to a separate fi le on the disk, which au tomati
cal ly becomes a MacPaint document. By holding clown the Shift
Comma ncl-3 combination (the position of the Caps Lock key doesn 't 
matter), the Finder takes a "snapsho t" of the current screen, and 
places it on the disk, a s illust rated in Figure 3-25. You can then open 
a nd use it just like any other MacPaint document. These snapsho ts are 
a lways na med Screen x, where x will be number between zero and 
nine, s ince up to ten such snapshots can be taken in any one Macin
tosh session. 

The Finder, then, a long w ith application progra ms, is the link be
tween you a nd the Macin tosh. It is quite invisible; indeed, you will 
know it only by its tools, which you use constantl y. Its name simply 
provides a convenient label for a ll tha t it docs. Its powers, no ma tter 
what we call it, a re considera ble, and are a t the heart of wha t makes 
this computer so easy to use. 
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W/P Cop 
370K in disk 

~ ~ 
Moc\Y'rite MocPoin~ Font Mover 

LJ LJ 
Empty Folder System Folder 

~ 
~ 

Sample Memo 

29K OYoilabl~ 

Figure 3-25. The W/P Copy window showing a MacPaint document created 
by taking a snapshot of the current screen. 

Checklist for Chapter 3 ________ _ 

1. Double-clicking will bo th Selec t a nd Open a n icon , or both De-select and 
Close i l. It has other applications as we ll. 

2. The View menu offers five ways of viewing the contents of any window. 
3. We copy all or part of the contents of one diske tte to another d iskette by 

dragging the icon(s) of what we wan t copied to the icon of the disket te 
we want to copy to . 

4. Disk Copy is a specia l application that speeds up the process of copyi ng 
an entire diske lle with s ingle-drive systems. 

5. We create add itiona l cop ies of any file on the same diske tte by selecting 
Duplicate from the Fi le menu or Command-D from the keyboard. 

6. Selection of more than one icon is done by dragging a Selectio11 box or by 
Shift-Clicking. 

7. All icons in a window or on the desktop can be s imultaneously selected 
with Select All from the File men u or Command-A from the keyboard . 

8. Folders a rc used to organize fi le s torage. Applicat ions, documents, and 
othe r fo lders can be s tored in them. New ones arc created with 
Duplicate. 

9. Shifi-Command-4 with the Caps Lock key up prints a copy of the active 
window. 

10. Shifi-Command-4 with the Caps Lock key doiVn prints a copy of the 
en tire screen, often referred to as a screen dump. 



78 0 1: The Macintosh System------------------

11. Shifi-Command-3 takes a snapshot of the screen, turning it into a Mac
Paint document. 

12. To move a window without selecting it, hold down the Command key 
while you press and drag. 

13. Select Clean Up from the Special menu to have the Finder reorganize 
the icons in the active window or on the desktop. 

14. Select Erase Disk from the Special menu to delete the entire contents of 
a diskette. 

15. The Trash window holds trashed materials until you open an applica
tion, turn the Macintosh off, or select Empty Trash from the Special 
menu. 

16. Locking an application or document in its Get Info window prevents its 
being trashed or replaced. 

17. An entire disk can be mechanically locked by s liding its write-protect tab 
up; its contents cannot then be changed in any way. 

18. Select Put Back from the File menu to return an icon to its proper folder 
and/or window, whether that folder or window is open or not. 

19. Diskettes should be ejected by selecting Eject from the File menu or 
Command-E from the keyboard (Command-Shift- ! for the internal 
drive and Command-Shift-2 for the external drive also work). If dis
kettes are accidentally left in the Macintosh when it is turned off, 
holding the mouse button down while turning it back on will eject 
them. They can also be mechanically ejected, if necessary, by inserting 
the end of a s traightened paper clip in the little hole to the right of the 
disk drive(s). 
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Introduction 
Most of the basic techniq ues for using the Macintosh were int ro

duced in Chapters 2 a nd 3. In th is chap ter, you w ill learn to apply 
those techniques to its overa ll contro l. This will h elp you master the 
system and prepa re you for the spec ific tasks covered in Pa rt II. Just as 
actions like pointer movement, cl icking, a nd window contro l arc basic 
techniques, correc t a nd effic ient ma nagement of docu men ts and d is
kettes a re equally importa nt to using your Macintosh to its fullest. So 
we will look in more detai l a t the use of documents a nd d is ks, and 
investigate the Macintosh$ prin t ing capa bilities as well. 

Document Management __________________ _ 
You have a lready learned some things a bou t documen t manage

ment. You know a lot a bout how the Finder ha ndles documents : 
opening and clos ing them ; copying the m to another d isk or duplicat
ing them in order to have two copies on the same disk; editi ng tex t 
within them , and cutting, copying a nd pasting as well. Now we can 
move on to the more genera l aspects of document managemen t that 
you can di rect the Finder to do for you. For this, we will need some
thing to work with , so put your working copy of the Wri te/Paint 
diskette in the Macintosh and turn it on. 

There a re several ways to get a document to work on. If it is an 
entirely new documen t, simply Open the application you wan t to use 
for crea ting it. If it is an old document, on which you wan t ,o do more 
work, jus t Open tha t document-there is no need to touch the app lica
tion icon a t all. Or, to re ta in an o ld document but ma ke changes in a 
new version, you can Duplicate it, give the copy a new name, a nd Open 
the copy. The last, however, is somewha t less e ffi cient tha n using the 
Save as . .. option, which we will get to momentarily. 

Saving 

For our firs t exercise, we wan t an en tire ly new document a nd wi ll 
use MacWrite to create it. Selec t the MacWrite icon a nd then select 
Open from the File menu-or jus t dou ble-click on the MacWrite icon, 
which accomplishes the same thi ng. We will no t be lea rning MacWrite 
now (tha t comes in Cha pter 5); we are using it only as a tool for 
lea rning about document management. Just type in a few le tters or 
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words on the l"irst line when the window a ppears, as seen in Figure 
4-1. What you type is irrelevant-we simply want to h ave a docu ment 
to manipulate. Note that the window is labeled "Untitled." 

r • file Edit Search Format Font Style 
., 

ili Untitled . . ·---- " -

·~-'·-'-'-•-·'·-··J? ... ,,,_ ... j_._,~, ... .J~ ... .l_ • ...l.-. . ..J_._J.1 ... , ..... ...L. . ... .L...._l.~ •. ..J ..... :k·• ... ! ...... .l.~ .... ! ...•. .l .... ... ~-. •. .;t:. 

~~~xyzobd tlle~ ~E) ~ ~ ~ ~ ~ 

Figure 4-1. A MacWrite window with a few characters typed in. 

Now go to the File menu a nd choose Save. The Macintosh wi ll 
provide us with a Dialog box like that of either Figure 4-2 or 4-3. Since 
we have not yet g iven the document a name , the Finder prompts us for 
one, and it gives us the opportunity to reconsider (Cancel) if we wish. 
It a lso permits us to save tex t on ly; this means tha t differing type fon ts 
and s tyles, as well as pictures transferred from other applications , 
will not be saved. Its main utility is a cons iderable saving of space, 
which makes sense if you don' t think you will need exac tly the same 
document again, but s imply want a copy of its text. (Tex t Only saves 
are a lso used for documents tha t will be sen t to another computer via 
telecommunications, s ince only the Macintosh 's "tex t format can be 
used by other computers.) Enter a na me, as in the example. If you 
make any mis takes, you can edit this text like a ny other; the pointer 
will not turn into an 1-beam shape, but you can use the a rrow pointer 
to select any text and remove, replace, or whatever. Don't click on 
Save yet. 
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saue current document as Write/Paint 

( Eject ) 

[ Saue ] [ Cancel ) 

® Entire Document QTeHt Only 

Figure 4-2. A Dialog box for saving a document in a single-drive system. 

Saue current document as Write/Paint 

( Eject ) 

[ Saue ] ( cancel ] ( Ot'ttH? ) 

® Entire Document 0 TeHt Only 

Figure 4-3. A Dialog box for saving a document in a dual-drive system. 

The difference between the two figures reOects a lternative operat ion 
with single-drive (Figure 4-2) or dual-drive (Figure 4-3) systems. With 
the latter, the Dialog box offers another choice, labeled Drive. As you 
click on it, the diskette name above wi ll switch back and fort h be
tween the diskettes in the two dri ves, permitting you to specify the 
one on which you want the file saved. (In this example, the word 
"Drive" is in sha dow because there was no dis k in the second drive, 
another example of the Macintosh 's efforts to protect us from errors.) 
Moreover, with either a single- or dual-drive system , you can also save 
the document to any other disk by choosi ng Eject from the Dialog box. 
Your diskette will be ejected a nd you can insert any other diskette you 
want; then you click Save a nd the document will be saved to tha t 
diskette. You wi ll then be prompted to reinsert the orig ina l diske tte. 
Any additional Saves will result in an automat ic prompt to re inser t 
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the diske tte you Saved to before . This g rea tl y facilita tes getting 
around the s torage problems of single-drive sys tems. 

Now click Save a nd the document is saved to the Write/Paint di sk; 
then you arc returned to your document. The Finder docs not assume 
you have finished just because you have saved a document. Indeed, as 
already noted, saving should be done at regula r interva ls-every ten 
minutes or so-as a safe ty precaution in case something goes wrong. 
Now enter a few more characters on the screen, and then pull down 
the File menu and choose Save once more. Note that thi s Lime there is 
no Dialog box; the document a lready has a na me and a disk designa
tion , so the curren t version replaces the previous one on the correct 
disk . 

Type ano ther few cha rac ters, and now se lect Save as . . . from the 
File menu. This provides a screen identical to that of Figure 4-2 or 4-3 , 
with the current document in the na me bar, but highlighted so that it 
can be changed immedia tely, which will most often be your intention. 
Now you can save the new vers ion under a different na me, or to a 
different di skette, or only in text form, e tc . In fac t , you can do this even 
if you have made no cha nges at a ll, but simply want a nother copy 
under a different name or on another disk. 

Save as . .. can be used like Save for naming a documen t when you 
have opened it by clicking on the application icon a nd its current 
name is "Un titled." It is also used when you a re working on an old 
document and want to retain both it and a copy of your changes. And 
it can be used to create two or more identical versions of a document 
on one or more di skettes. Be awa re, however, that a ll subsequent 
Saves wi ll be to the new document (the one created with the most 
recent Save as ... ) rather than to the original one . In most cases this 
is exactly what you will want, but if not, you can compensate by using 
a nother Save as ... to save to the earlier version or diskette, or to yet 
a nother one . 

Save as . . . a lso permits an effi cient way to mainta in "s tationery 
pads." You can create a le tterhead, for example, under MacWri te , a nd 
save it to di sk with headings and margins se t jus t the way you gener
ally use them. Then , whenever you want to use a "piece of this s tation
cry," just open the documen t and immediately use Save as .. . to give 
the current version a new name. The origina l will be una ffected a nd 
can be used in this way again and again. This is faster a nd simpler 
than firs t duplicating the document on the desktop and then naming 
and opening the duplicate. 
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Enter a name to replace My Memo; let's ca ll it My Other Memo, and 
then click on the Save bar. You now have two documents on the disk. 

Just remember tha t whichever document na me you have used in 
your mos t recent Save or Save as . . . becomes your current document, 
with its name in the title bar of the active window. The Finder will 
assume tha t you want to continue work with that document, a nd tha t 
any Saves you do will be to it. If this is not the case-if you later want 
to save the current text to a nother name that may or may not have 
a lready existed- then use Save as ... once more. You can a lso usc 
Close, which we wi ll d iscuss below. 

The Finder a lso tries to pro tect you from inadvertently overwriting 
(thus permanently removing) an exis ting file w ith a Save as ... .If 
that name already exists, even with different capita lization, you will 
see an Alert box like that in F igure 4-4, rem inding you that such a 
name is already in use. The h eavy lines a round the No mean tha t it is 
the defau lt choice-it can be selected with either the Return or E nter 
key, as well as by clicking. 

Replace eHisting "my 
memo"? 

[.....__ Ye_s --J) ._( iiiiiiiNiiioiiiiiiiiiJ 

Figure 4-4. An Alert box when saving with a document name that already 
exists. 

Quitting 

Now type a few more characters in your MacWrite wi ndow and then 
select Quit from the File menu. The Finder beeps and presents you 
with a Dialog box like that in Figure 4-5. It a lways keeps track of wha t 
you arc doing. If you h ave no t made any cha nges since your las t save, 
you are immedia tely sent back to the desktop. But if a ny changes have 
been made, the F inder reminds you of tha t fact a nd let's you decide 
whether you , in effect, want to Save aga in before you s top. For th is 
box, Yes is the de fau lt choice. In this case, click on No, and the Finder 
puts everything away a nd re turns you to the desktop. 
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Saue changes before quitting? 

n Yes I 
( No J ( Cancel J 

Figure 4-5. A Dialog box that appears when we Quit an application with 
any changes since the last Save. 

Closing and Open . . . ing 

Your Write/Paint window should now include two new icons, one for 
My Memo and one [or My Other Memo. In fact, that window may be 
getting a bit full, so that you may have to scrol l a bit or en large it in 
order to see a ll its contents. Lets double-click on MacWrite to open 
another document. When the window a ppears, type in a few charac
ters, then go to the File menu a nd select Close. You get the same 
Dialog box we saw in Figure 4-5, except tha t "closing" replaces "quit
ting." The Finder wants to know if you want this document saved in its 
current s tate or as it was at the las t Save, a nd wi ll save it accordingly. 
In this case, since we never did a Save on the document , not saving the 
changes would result in its not being saved a t a ll. 

We really don 't want to keep this document, s ince it was just a 
device to get us to Close and Open .. . , so cl ick on No. This produces 
the bla nk screen illustrated in Figure 4-6; on yours , of course, the Fi le 
menu will not be open until you press on it. Note that we don't have 
too m any choices availab le to us at this point. The Apple menu is 
there, and so is the Edit menu , but the latter will only permit us to 
view the Clipboard. Here, you would usually be using one of the three 
select ions ava ilable [rom the Fi le menu , which is why we have it 
showing in the illustration. 

Whereas Quit returns us to the desktop with no application active, 
Close jus t stores the current document in its proper place, while 
keeping the current application-in thi s case MacWritc-ac tive. So, 
at this point, as we sec in Figure 4-6, the Quit selection will le t you 
change your mind, cancel the applica tion , and re turn to the Desktop. 
New, on the other hand, has exactly the same effect as if we were a t the 
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Figure 4-6. The desktop after a Close command, with the File menu open. 

desktop, looking a t the MacPaint/MacWrite window, a nd opened the 
a pplication icon. It provides us with a new document to work on , 
la beled Untitled , under whatever application we have been using. 

Open . . . is more interes ting, so select it. This produces a Dia log 
box like Figure 4-7. On the left is a n a lphabe tical li s t of a ll the 
documents on the cur rent disk which were created by the active ap
plication . When there a re more than the sm all w indow can display, 
you can scroll up a nd down to see them . If you click on a ny of these 
names, the Open ba r turns from shadow to black, and if you then cl ick 
on Open the docu ment is opened for you (you can a lso doub le-click on 
the document name to open it di rectly). If you have a two-drive system 
the Drive box will a lso be there to let you see relevan t documents on 
the diske tte in the o ther d r ive. And, as before, you can a lso choose 
Eject and insert a different dis kette, in which case a ll of its relevant 
documents will appear. There is no need to Quit a nd then open some 
o ther document from the desktop level. Obviously, s ince a n a pplica
tion-in this case, MacWrite-is s till active, there is no need for 
documents created under o ther app licat ions to be shown , and they 
a ren 't. 
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My Memo ~ 
My Other Memo ( Open ) Write/Paint 
Sample Memo 

( Eject ) 

( Cancel ) ( Orim~ ) 
ro 

Figure 4-7. The Dialog box when Open ... is selected. 

The New and Open ... selections can speed up your work consider
ably, when you want to continue with the same application. With one 
or the other of these two selections, you can quickly start work on a 
new document under that application, or do some additional work on 
an old one. In combination with Save as ... , you can work on or 
create many different versions of several documents without ever 
going back to the desktop. 

At this point, we rea lly don't want to do any more work with this 
stuff, so select Cancel, a nd then, from the File menu, select Quit. 

Note that while we used MacWri te for this demonstration, the oper
ations associated with saving, opening, closing, and quitting will be 
quite constant across Macintosh applications. Some may offer addi
tional choices, but these are the basics, which will apply no matter 
which application you may be using. To a much greater degree with 
the Macintosh than any other computer, once you have learned any 
one application, you know most of what you wi ll need for any other. 

Disk Management __________ _ 

You learned a bit about diskettes in Chapters 2 and 3-how to 
handle them, initialize them, copy them, and so on. But there is quite 
a bit more you should know in order to make the operation of you r 
Macintosh as efficient as possible. For example, you will want to be 
able to maximize the free space on your disks . And you should under
stand differences in operations be tween single- and dual-drive 
systems. 
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Startup Disks 

The term startup disk really has two meanings. Firs t, it relates to 
what is on the diskette. If a diskette has the System documents on it 
(they are usually in the System Folder), it is technically a startup disk 
because it can be used when you boot the system (that is , turn the 
Macintosh on). If you try to boot your Macintosh with a nonstartup 
disket te, it will be ejected. Le t's look a t these system files for a mo
ment, for a better understanding. Make sure your Write/Paint diskette 
is active, Open it, and then open the System Folder. You should see up 
to six icons for the items illus trated in Figure 4-8; the Clipboard and 
Scrapbook fil es are sometimes not there, which is okay. Here we have 
displayed them by Name rather than by icon so we can get more 
information. 

~D System Folder 
Sin .. ~ .... Kind Lut Ho4ifiM 

OK Clipboud Fill' System document Sun, Jun 3, 1984 ~ .=. 

46K FiRdl'r System documfllt W'ed, May 2, 1984 

171< l~vritl'r System doc~nt Suo, Jun 3, 1984 

2K Notl' P .td Fill' System document Fri, Jun 1, 1984 

101< Scnpbook Fill' System document Fri, Apr 20, 1984 

1331< S,stl'm System document Sun, Jun 3, 1984 

~ 
~J IQ IQJ 

Figure 4-8. The System documents in the System Folder on a startup disk. 

Three of these System documents are quite small-files for holding 
whatever is currently in the Note Pad, Scrapbook, or Clipboard. Im
agewr iter is a special file for printer operations, and is automatically 
activated when you choose Pr int. Finder holds the Finder's programs, 
which you use cons tantly. And System consists of a large number of 
programs that make the Macintosh go. You never call on these pro
grams directly; indeed, it is impossible to Open them the way you do 
other icons. But virtually everything you do, from turning the com
puter on, through runn ing applications , and then turning it off again, 
uses them extensively. They can safely stay in a separate folder, quite 
invisible to the user running the Macintosh . Now Close the System 
Folder. 
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Startup has a second, specia l meaning to the Finder: the startup 
disk is the one you actua lly used when you turned on the computer (in 
a two-drive system , either drive can be used for this purpose). Even if 
you eject that firs t diske tte while working and replace it with a nother 
startup disk, the Finder s till considers the firs t one as the s tartup disk 
up to a certain point. It wil l continue to ins ist on the reinsertion of 
that diskette when any System funct ions are called for, and it will not 
permit Note Pad or Scrapbook access to or from o ther disks. So long 
as the Finder is active, bo th startup disk icons will remain on the 
desktop, but the first one continues to be the startup. This is worth 
remembering, to faci lita te your being able to keep track of where 
things a re. 

However, wh enever a ny app lica t ion is opened, it overrides the 
Finder in memory. When you finish with that application, the Finder 
is reconnected, but it does not remember everything that 1vas on the 
desktop before that application was opened. It will therefore consider 
any startup disk it finds in the dri ve (the internal dri ve if you have 
two) as the startup disk. 

For example, with a single-drive sys tem, if you remove the startup 
disk and replace it w ith one that does not have the System Folder, all 
reads to and writes from the Scrapbook or Note Pad will be to the 
startup disk; the Finder will not permit you to use these features on 
the second disk. And you will be obliged to re insert the s tartup disk 
when the Finder needs something, since the original disk is used to 
keep track of a ll saves, changes, and so forth . But if you replace your 
startup disk with one tha t does have the System Folder on it, once you 
open an application from that disk it becomes the startup dis k. Calling 
up the Scrapbook or Note Pad will resu lt in reads or writes to the ones 
on the new disk . And when you qu it the application, you will find tha t 
the origina l disks icon is no longer on the desktop. Now the active 
Finder is the one on the second disk, not the first. 

With a two-drive system, it works a bi t differently. The Finder of the 
startup disk is in contro l at a ll times, except when an application on the 
disk in the external drive is being used. Even if the disk in the external 
drive does no t have the System Folder, any applications on it will 
displace the Finder. Thus the active Scrapbook a nd Note Pad before 
using a n application a nd after quitting it w ill be those of the s tartup 
disk in the internal dri ve. But wh ile using an applica tion on the 
ex ternal dri ve, its Scrapbook a nd Note Pad will be active. 

This can be a bit confusing at firs t, but you will readily get used to 
it. An awareness of what is ha ppen ing wi ll help avoid looking for 
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things like Scrapbook entries whe n they are not avai lab le . For
tunately, the contents of the Clipboard are unaffected by disk swaps or 
application openings; the most recent Cut or Copy will be there re
gardless of which disk is in control. 

In addition to startup disks, beginning with the second version of 
the system software you can a lso have a startup application. That is, 
you can so configure a diskette that any desired application on it will 
be automatically selected and opened when the computer is turned 
on. For example, make sure the Write/Paint window is open, and click 
once on MacWrite to highlight it. Then open the Special Menu and 
select Set Startup, as in Figure 4-9. You are immediately presented 
with the Dialog box illus trated in Figure 4-10. If you click OK, Mac
Write becomes the startup application. Any time you turn on the 
computer with this diskette inserted, you will automatically be pre
sented with an "Untitled" MacWrite window. For now, just selec t 
Cancel. 

If you regula rly do a lot of work with any one application , you may 
find it worthwhile to configure one or more disks for this type of 
startup. This is usually referred to as "auto-booting" in the computer 
world in general. To undo an automatic application s tartup, open the 
System folder, select Finder, and then use Set Startup to make Finder 
the startup application. This is the s tandard way the Macintosh 
works. 

Some users may wonder how many disk icons they can safely have 
on a desktop before the Finder becomes confused. So far as the Finder 
actions described in Chapter 3 are concerned, four is the practical 
limit a nd five the maximum; user confusion is a good deal more likely 
to emerge fi rst. (You will get an Alert box if you exceed the Finder's 
capabilities.) The ex tra icons will be reta ined on the desktop only so 
long as no application other than the Finder is open; once you open a n 
application , the Finder loses track of any disks not in a drive, and their 
icons will disappear. As a genera l ru le , you should not have more disk 
icons out tha n are rea lly being used, because it can get confusing
certainly for you, and on rare occasions for the Finder. If your desk 
gets too cluttered, just remove the excess icons by dragging their 
shadows to the Trash . Trashing shadow (that is, not currently in
serted) disk icons has no effect on the disks themselves; it s imply 
removes the icons from the desktop. The Finder wi ll protect you from 
yourself by refusing to trash the startup disk. 

The System documents needed by a startup disk take up just about 
one-half of the diskette 's capacity. In fac t, they can take up more than 
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Figure 4-9. Selecting Set Startup from the Special menu, after having 
selected the application wanted for automatic startup. 

Rre you sure you want to make 
"MacWrite" the startup application? 

( OK ) ( Cancel ) 

Figure 4-10. The Dialog box that selecting Set Startup generates. 
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that because your applications wi ll often a lso be on the s tartup d isk. 
This is especia lly true on a s ingle-drive sys tem; otherwise, the amount 
of d isk swapping called for is excessive . It is therefore q uite importa nt 
to understand when you want disks to h ave startup capacities and 
when you don't. This is one of the reasons we are looking more deep ly 
into the ma nagement of both documents a nd the disks themselves. 

Font Mover 

One of the things tha t makes the System fi le so la rge, taking up 
anything from about 130K to over 200K on a dis kette, is that it 
includes the numerous type fonts a nd styles that the Macintosh makes 
available to its app lications programs. For a fon t to be avai lable, it 
must be in the System file. And as the number of availa ble fonts is 
increased , the s ize of the System fi le becomes correspondingly 
greater, taking up more a nd more space on a s tartup disk. For some 
applications you won't need some of the fon ts s tored in System; for 
others, you wi ll want to add a font that is not yet in Sys tem . This is the 
job of the Fon t Mover application-i t permits us to remove fonts from 
the Sys tem fil e, either to the Trash or to a separate fil e for s torage. And 
it permits us to add fon ts to the System fi le from a separate file 
holding the m . 

Turn off your Macintosh, then insert the Syste m Disk that came 
with your Macintosh (our firs t time using tha t di sk), a nd turn i t on. In 
the firs t version of the Macintosh sys tem software, everything that 
was on the System Dis k was a lso on Write/Pa int. But most readers will 
have the upgraded vers ion, including Disk Copy and more fonts. And 
those additiona l fonts create a qua ntity of information too great for a 
single diskette- they, a long with the Font Mover application, are on 
the System Disk, but not on Write/Pa int. Open the System Disk and 
you should see a w indow pre tty much li ke that of Figure 4-11 . We have 
the Font Move r application itself, the Fonts file with a number of fonts 
in it , and a separate Seatt le fi le with one more font. Additionally, of 
cou rse, we have numerous fonts a lready in the Sys te m file. 

You can use the Font Mover app lication to remove any fonts in the 
Sys tem file tha t you have no use for, or to move fonts from the Fon ts or 
Seattle fi les to the System fil e so they can be used. Double-click on the 
Font Mover icon to open it, j us t like any other applica tion. This creates 
a w indow like that of Figure 4- 12. On the left is a window showing the 
fonts current ly in the System file, and on the right those currently in 
the Fonts file. The Font Mover is ready to move a ny single font from 
one to another, or to trash it. (If you have the firs t version of the 
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software, the right window will be empty, because a ll fonts are a l
ready in the Sys tem file. You would therefore use the Font Mover only 
to remove any fonts you didn't want.) 

stem Disk 
6 itftRs 348K in disk 52K avail a~ lt' 

~ 
'~ ~ ~ ~ 

Font Mover Disk Copy Fonts Seattle 

stem Folder Empty Folder 

Figure 4-11. Window into System Disk of second release of Macintosh 
systems software. 

in system file 

Hthens-18 
*Chicago-12 
*Geneua- 9 
Geneua-10 

*Geneua-12 
Geneua-14 
Geneun-18 

Nome: 

Point size: 
Disk Space: 

Font Mouer 

~ ( Help 

I 
[ O(Hj 

( th~mmn~ 

fO [ Quit 

) 

) 

) 

in Fonts file 

Cairo-18 ~ 
Los Hngeles-12 

~:~R~~~~~t I 
San Froncisco-18 mm 
Toronto- 9 mm 

~ 

Toronto-12 {} 

* required for system use 

Figure 4-12. The Font Mover window, showing the fonts in the System and 
Fonts files. 
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Try scro lling up and down th rough both windows to see the names 
of a ll the fonts in the System and Fonts files. If you wan t to see what 
any one of them looks like, just click on it, as in Figure 4-13. This 
display a lso tells us how much disk space the selected font takes up
in this case, a lmost 14K! Font Mover a lso has a Help option: if you 
click on it , several screens explaining the application wi ll appear. 

Font Mouer 

in System file 

Geneun-18 ( Help ) 
Geneun-20 
Geneun-24 «Copy« ) 
London-18 

*Monnco- 9 ( Remoue ) Toronto- 9 
Monaco-12 Toronto-12 
New Yorlc- 9 Quit ) Toronto-14 

Nnme: New York Sample Point size: 36 
Disk Space: 13780 bytes 

* required for system use 

Figure 4-13. Selecting any font under Font Mover provides an example of 
it, and an indication of the space it takes on disk. 

You m ay notice that the System file does not list every size of every 
font you may have been using. This is because some of the style 
possibilities are created with combinations of others . A couple of 
warnings apply to moving fon ts ou t of the Sys tem file: First, those 
preceded by an asterisk cannot be removed; they are used by the 
Madntosh for som e of its own displays (when you remove a font from 
the System fil e, it is being removed for screen display as well as 
printing purposes). Second, if you plan to use High q uality printing as 
well as Standard (see below, on printing), don't remove the doubled 
size of any font you wi ll be using. For example, to get high resolu tion 
of New York 12 point type, New York 24 point type must also be 
available. 
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To move any font, si mply click on it; the arrows around the word 
Copy will switch to point in the opposite direc tion , and then clicking 
on Copy will move a copy of that font to the o ther window. In Figure 
4-14, we have chosen Sa n Fra ncisco- 18 in the Fon ts fil e a nd copied it 
to the Sys tem file. You can a lso shift-cl ick or d rag to se lect several 
fonts a t one time. Note that copying does not remove the font from its 
sou rce; it simply creates a copy in the other fil e. If, for example, you 
wa nt to remove a font from the System fi le a nd keep it in the Fonts 
fil e , you firs t do a Copy, a nd then, with the or igina l font s till selec ted, 
click on Remove to get rid of it. 

font Mouer 

in System file 
New York-12 Help ) 

~~~ ~~~~~; II [~......._<_~:-:--=:.....::::.....:___,;) 
Son froncisco- 18 
Uenice-14 [~_Q_:_u_it _ __.) 

Nome: 
Point size: 

Son Fronclsco 
18 

Disk Spoce: 2984 bytes 

in fonts file 
Los Rngeles-12 
Los Rngeles- 24 
New York- 36 

Toronto- 14 

* required for system use 

Figure 4-1 4. Selecting Copy moves a copy of the selected font to the other 
file. 

Generally, you would not want to remove fonts from the Font file; 
more likely, you would just copy the whole fi le to another d isk for 
storage or simply trash i t. But often you w ill wan t to remove fonts 
from the System file-since you have additiona l copies of the Fonts 
file on your backup diskettes, there is no good reason to keep extra 
copies of any font. It is a good idea, however, to put a no te in the Get 
Info window of a ny System or Fonts file, noting how you have cha nged 
it , so that you can easily remind yourself of what is where, as in Figure 
4- 15. This kind of on-disk documen tation is not likely to get lost , and 
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makes it easy to keep track of just what you have done and what is 
where. 

sO Information about System ·-=--

System e 
Kind: System document 

Size: 131828 bytes, accounts for 132K on disk 

Where: System Disk, internal driue 

Created: Wednesday, Moy 2, 1984 at 8:04 AM 

Modified: Monday. June 4. 1984 at 8:53 AM 

D Locked 

Customized for word processing; seueral fonts 
remoued and trashed. If others are needed, copy in a 
full fonts file and transfer with font Mouer~ 

Figure 4-15. Documentation in a System file Get Info window, specifying 
how its original fonts collection has been changed. 

For practice, try copying one or two fonts, and then removing them 
from their new locations on ly. You don't actually want to make a ny 
permanent changes at thi s point. When you begin to set up work 
diskettes, you will have a clearer idea of what you wi ll be using them 
for. You can then make sensible decisions about which fonts you want 
to retain and which you can do without. When you are done practic
ing, jus t click on Quit and you will be returned to the desktop. 

The Seattle file contains two additional fonts. If you Open it, Font 
Mover is run with the Seattle fi le loaded into it. (Opening Font Mover 
itself, or the Fonts fil e, results in only the Fonts fi le being loaded.) The 
right-hand window will have the two Seattle s izes and the left-hand 
window th e current System fonts. You would no t want to move any
thing from the System file to this font file, but might wan t to add one 
or both of the Seattle fonts to the Sys tem file on some of you r di s
kettes. (The Seatt le font, pr in ted in High Qua lity mode, creates a near 
"le tter quality" printing effect ,a.excellen t for business correspon
dence.) 
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Setting Up Work Disks 

Because the Sys tem documents on s tartup disks take up so much 
space, it is important to learn how to maximize the free space on those 
dis ks. This is particularly the case with single-drive systems, since 
disk-swapping is time-consuming a nd clumsy. And it provides greater 
e[[iciency to two-drive systems as well. On single-drive sys tems, any 
app lication should be on a s tartup disk. You learned ea rli e1· that with 
a Save or Save as _ . . you can Eject the disk you are us ing a nd do the 
save to another diske tte, and that for subsequent Saves the Finder wi ll 
prompt for reinserting that d iske tte. Sti ll, you may want to be able to 
save, at least temporarily, to the s tar tup disk itself. This can be done 
with a little planning a nd organization. 

Let 's lea rn by example, se tting up a word processing s tartup dis
kette. The first s tep will be to ma ke a copy of your Write/Paint dis
kette. Follow the instructions for your system, as given in Chapter 3 . 
(Be s ure to use Disk Copy if yours is a s ing le-drive system a nd you have 
that application.) Name the new di sk WRITING, turn your Macintosh 
off, insert WRITING in the drive and turn the power back on. Then 
open WRITING and you should have a window pretty much like tha t 
of Figure 4- 16. Note that over 80 percent of the di sk is a lready fu ll 
(332K on thi s one). This leaves very little room for documents: 67K is 
no t a ll tha t much, a nd the Macintosh reserves some space for its own 
use. (It periodically writes to the di sk a temporary copy of what you 
arc working on so you wi ll have a reasonab ly current copy there if 
power is disrupted . That temporary file is au tomatically erased if 
there arc no problems, so you may never sec it.) 

So now le t's see how we can improve the s ituation, part icularly for 
s ingle-drive systems. First, s ince this will be a word processing disk
ette, select MacPaint and drag it to the Trash . Click OK when the Alert 
box comes up, and then select Empty Trash from the Special menu. 
Very good; you h ave considerably increased the avai lab le space to 
a bout 128K (the actual figure wi ll vary s lightly from one time to 
another, based , for example, on the number of fonts in the System 
file). 

Now we want to use the Font Mover, so eject WRITING, insert your 
System Disk, select the Font Mover icon, and drag it to the shadow 
WRITING icon . That is , follow what we learned in Chapter 3 to 
transfer a s ingle fil e from one diske tte to another. After that is done, 
reinsert WRITING in the drive and drag the System Disk icon to the 
trash (this is not necessary, but it will minimize confusion at this 
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WRITING 
332K in disk 

Mac'w'rite 

[] [] 

Figure 4-16. The WRITING diskette before any deletions are made. 

ti me). When you arc done, your WRITING window should have Font 
Mover added; we have lost a li tt le space , but that is only temporary. 

Now we wan t to run the Font Mover app lication, so double-click to 
get it going. The Font Mover window shows nothing in the righ t-hand 
window, as illustra ted in Figure 4-17 , s ince we do no t have the Fonts 
file on thi s disk- our current interes t is in ge tting rid of fonts rather 
than adding them. Similarly, we will now dele te fonts rathe r tha n 
copy them to a new Fonts file . Remember, we have copies of tha t file 
on our System and backup diskettes, and can a lways ge t them back if 
we wish. Le t's firs t ge t rid of London- 18; it is a decora tive fon t of little 
use in most word processing. Select it, and then click on Remove, as in 
Figure 4- 17 . Then do the same to Athens- 18 and Vcnice- 14, which we 
a lso don't need. 

Now scroll through the window until the seven New York fonts a re 
evident. This is a commonly used font, and le t's assume you think you 
migh t use the 9-, 10-, and 12-point versions, and tha t you might a lso 
want to print some le tters in High resolution, mean ing tha t you also 
need the 18-, 20-, and 24-point ones (later, if you find you never really 
use High qua lity, you can remove them). So select New York-14 and 
remove it- that will add another 3,352 free bytes to our disk. Then 
select one or two examples o[ Monaco and Geneva, a nd look a t their 
Samples. They a re really quite similar, so le t 's se lec t Monaco- 12 (Mon
aco-9 is reserved) a nd remove it. This leaves the one reserved Chicago 
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in System file 
6eneuo-14 
6eneua-18 
6eneuo-20 

Nome: 
Point size: 

London 
18 

( 

( 

( 

Font Mouer 

Help 

»Copy» 

Quit 

Disk Spoce: 3268 bytes 

in Fonts file 
) 

) 

) 

iamplt 

* required for system use 

Figure 4-17. Removing the London-18 font from the System file. 

Q 

font and quite a number of Geneva fonts . We'll keep Geneva 9, 10, and 
12, p lus their doub les, a nd remove Geneva-14. 

Now select Quit, a nd wa it a while for the Font Mover to update the 
Sys tem fil e. When the WRITING window reappears , move the Font 
Mover icon also to the Trash-you have no further need for it on this 
disk. E mpty the Trash, which leaves you with about 148K avai lable on 
your disk, as seen in Figure 4-18. You might well find, when you do 
rea l word process ing, that you use only one font , in which case you 
could copy Font Mover back to this disk and remove the extras. 
Similarly, if you la ter wanted to add one or more fonts from the Fonts 
or Seattle fil es , you could copy those to this disk, a nd then use Font 
Mover to a dd them to the System fil e. Here, we are jus t looking into an 
example of max imizing di skette room for documents. 

There is more we can do, as well. Firs t, trash the Sample Memo
tha t is a learning example that you wouldn't rea lly want on a work 
diskette once you ha d some experience with MacWrite. That gives you 
3K more. Now pull down the Apple menu a nd choose Scrapbook, 
which currently has fi ve sample screens, each of which takes up 
s torage space. Then, with the first page showing, go to the Edit menu 
and select Cut, as in Figure 4- 19. This will remove that screen, and the 
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4 itftns 

IJ -. 
Mac'w'rit~ Samp~~mo 

0 0 
System Folder Empty Folder 

Figure 4-18. The WRITING window after removing MacPaint and some 
fonts. 

former Screen 2 now becomes Screen 1. So select Cut (or Command
X) four more times, to empty out the Scrapbook. You are now up to 
abou t 158K of free space . 

Then return to the Apple menu and select Note Pad. You have no 
need for this instructional first page, so move the pointer in front of 
the firs t word. It takes on the familiar !-beam shape. Drag it down and 
to the right until a ll the text is highlighted . Then selec t Cut or just hit 
the Backspace key, and it is gone-not much of a saving, bu t all 
useless material should be routinely removed. 

You now have 160K available on this word processing work diskette, 
as seen in Figure 4-20. This leaves a reasonable a mount of room for 
document development on this s tartup disk. If you move documents to 
backup diskettes as you finish with them, this disket te can be used 
wi th reasonable ease on a single-drive sys tem for a ll your word pro
cessing work. Moreover, you can always use Save or Save as . . . to put 
some documents on another diskette as you are writing them. That 
way you are sure of having sufficient d isk space for whatever you are 
doing. 

You can now pu t this diskette away for use in word processing, or, if 
you w ish, simply Erase it. (Remember that the Finder won 't let you 
erase the startup disk for security reasons-you will have to res tart 
the Macintosh with a nother s tartup disk, then reinsert WRITING a nd 
se lect Erase .) This might be a good time to prac tice by creat ing a 
DRAWING diskette with MacPaint, following the same process used 
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Figure 4-19. Cutting material from the Scrapbook to create more free 
space on disk. 
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Figure 4-20. The WRITING diskette ready for work. 
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above. For that disk, you might well want to add a number ·of deco
rative fonts from the Fonts file, to the point , indeed, that the diskette 
will get quite full. (You can, however, t rash Imagewriter from the 
System Folder, because MacPaint doesn't use it.) In that case, you will 
want to save your work to another diskette with the firs t Save, to be 
sure you don 't run out of room, and move fin ished work off the s tartup 
disk as soon as possible . Try, if you can, to h ave at least 60K ava ilable 
on a ny startup disk each time you use it; this will avo id "disk full " 
messages from the Finder, and the interruption of your work. 

Macintosh owners with two-drive systems have it considerably 
easier, since they can have a s tar tup disk in one drive and a data disk 
in the other. For the latter, simply initia li ze a blank diskette and give it 
a name. Figure 4-21 illustrates this with a disk named JANUARY 
DATA, assuming we might wan t to back up a ll app lications programs 
for a given month to a s ingle d iskette. We have an Empty Folder for 
s torage, provided by the initia lization process, and nothing more, 
leaving us with 399K for our documents. In such a situation, dual
drive system owners can have more than ohe app lication on their 
s tartup disks (for example , MacWrite and MacPaint). Or they could 
have a drawing disk with MacPaint and with every possible font in the 
System file , which would ta ke up a lmost the full capacity of a 
diskette. •.. _ -· ____ :_ ------ --- JANUARY DATA 

1 it..n 1K in disk 

LJ 
Empty Foldtr 

Figure 4-21 . A non-startup data diskette with lots of room for documents. 

An even more efficien t format, with two-drive systems, is to use a 
copy of the Sys tem Disk for s ta rtup, w ith a ll fonts loaded into the 
System file, a nd to h ave individual applications on separate diskettes. 
That is, the second diskette (in the external d r ive) would contain only 
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MacWrite or some other application, plus a great deal of room for 
storage. You w ill also have to keep a copy of Imagewriter on that diskette 
(except with MacPaint) because the Finder looks for that file on the same 
disk as the application you are using. Those with single-drive sys tems 
can work a lmost as well , but they will have to do some disk swapping 
as they develop their documents . 

If you remember the above principles, using your Macintosh will be 
a good deal easier and less frustrating, whether with one drive or two. 
A bit of experience with a ny applications program will teach you how 
much free space you require, which fonts you actually need, etc. 

Printing 

The combination of the Macintosh and Imagewriter printer offers 
printing possibilities that are both extraordinari ly versatile and 
uniquely simple to execute. Because of the system's integration, user's 
have no need to learn complex codes or other printer controls. You just 
type or draw in whatever you want, based on an individual applica
tion's capacities and menus, and then tell the Finder to Print. What 
you see on the screen will appear, in slightly higher resolution, on 
paper. 

The actual printing options availab le will vary from one a pplication 
to another. What MacWrite offers is, logica lly enough, somewhat dif
ferent than the possibilities of MacPaint. Other applications also will 
have printing capacities and limita tions which reflect their primary 
uses and, perhaps , the strengths or weaknesses of their designs. All 
Macintosh applications, however, are more simi lar than they are dif
ferent, and we will discuss the similarities here. Whatever might be 
unique to individual applications will be considered in later chapters. 

First, we can note a few constraints. For example, the Macintosh is 
not ab le to print a document without first opening it. Insert your 
Write/Paint disk and select- don't Open, jus t click once to highlight
Sample Memo. Then go to the File menu and selec t Print , as in Figure 
4-22 . Note that the screen blanks and there is some disk activity, as 
the file is opened. Since you selected Print, you do go directly to a 
Print Dialog box rather than to the document itself, but nonetheless 
the document has been opened. This is a minor inconvenience, since it 
takes more time than if the document could be printed without Open
ing. We will get to the Dialog box itself shortly; for the moment just 
select Cancel, which returns us to the desktop. 
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Uiew Special 
., 

3CO 
st:IF!::y··y:!:::!:::t::!:~~~====~~~~==~~~: 

~ M~t~ 
Mac'rt'r ite 

.:.1 . 

'· 

Figure 4-22. Selecting a Document and then Print results in the document 
being opened before it is printed. 

Also worth rea li zing is that the Macin tosh cannot sim ply pr int wh at 
is curren t ly in its memory. As you begin to create documents, and then 
request a Print , you will get a message telling you th a t a copy is being 
w ri tten to the disk . To illus tra te thi s , Open Sam ple Me mo a nd, as soon 
as it appears, se lect Print from the File menu. Take no te of the Dialog 
box, which we will discuss in a momen t, and then click OK . The 
Macin tosh will then tell you it is wri ting a copy to disk before it 
actua lly begins printing. I t does this in order to make room for the 
Imagewriter app lication in m emor y, and to have the fil e in a forma t 
Imagewriter can use. Once printing is done, this specia l version of the 
fil e is au tomatica lly erased . 

We do have the ab ili ty to select mult iple docu ments for printi ng a t 
the same time. Just select the document icons you want to pri n t by 
drawing a selection box around them or by shift-clicking. Then , when 
you select Pr int from the File menu, they will a u tomatically be 
prin ted , one after the other. 

The advantages of the Macin tosh 's ra ther s low pr in t ing charac
teristics clearl y ou tweigh the disadvantages . Not least of these is the 
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incredi ble variety of possibilities availab le in text form at a lone via its 
numerous fonts, fon t s izes, and s tyles. Figure 4-23 shows the richness 
of customization avai la ble in font cha racteri s ti cs , in this case the 
s tandard menus ava ilable in MacPa int. The combinations available, 
using each font in one o r more S tyles a nd any of the numerous 
possible FontSizes, is considerable enough that one would need the 
Macintosh 's calcula tor to determine their number. 

B 

Toronto 
Sen Francisco 
Los Rngeles 
Cairo 
Chicago 

./Geneue 
New York 
Monaco 
Uenice 
London 
Rthens 

Font Choices. Up to 
12. If all possible 

fonts ore l ooded Into 
System File. 

Macintosh Menus 

FOR FOnT CHRRRCTERISTICS 

XP 
X B 

lflllir. X I 
Underline xu 
~ xo 
~ xs 

XL 

style and Alignment 
Choices. Avo11oble 

w1th oll Fonts. 

QJ (JXDIDlU 
OID 

./Ol2 
0~ 
OlD 
00 
:56 
48 
72 

FontSize Choices. 
Those In outline 
ore recommended 

for the selected Font. 

Figure 4-23. The three menus generally available for Font choice and 
characteristics. 

Exploring a ll these possibilities is something Macintosh owners can 
do for themselves. Only w ith some experimenta tion will you rea lly 
unders tand the a ppeara nce of each font in its various Styles and 
FontSizes. You should generally fo!Jow the Macintosh recommenda
tions and use any font only in its sugges ted sizes , as noted by the size 
being in outline rather than black. Usually, the nonrecommended ones 
are less clear. Figure 4-24, quite obviously, is no t a comprehensive 
illus tra tion of a ll the possibilities, but rather a n example of the variety 
avai la ble. And Figure 4-25 illustra tes the pictorial Cairo fon t, with the 
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This is default Geneva 12 point. 

Ten point is considerably smaller. 

Eighteen point looks like this. 
This is 12 point Toronto . 

nine point Toronto looks larger than 10 point Geneva. 

24 Point Toronto boldface. 
san fraooilao iS rather ltrango. 

l..os Angeles 12 point is almost italics . 

.4nd this is New· York 10 point in italics . 

.A.Dd Hew TQr.k 12 pQi.Dt bQJdface a.od italic. 

Chicago has a Ltery printed kind of appearance. 

Monaco 12 point has a delicate appearance. 
And its nine point type is quite easy to read . 

Venice 14 point is very ~ant. 

'Um~ffwmm~~~~~ 

ton~on sbou1~· bt ust~ tn ts potnt. 

!m ~~Btl lid§-~0 
Rthens also looks best at 1 B point. 
Seattle is an informal sort of type, 12 point . 

In boldface it:. appearance change:. con:.iderably . 

Figure 4-24. Examples of the varieties available in font characteristics. 
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" I ? < > Option-A 

Figure 4-25. The pictorial Cairo font; the keystroke used for each 
character is beneath it. 
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key to strike for each character given beneath it, to save you some 
time. This font permits "drawing" of sorts to those who can "only 
type." And when you get more involved with MacPaint, and learn in 
Chapter 6 how to s tretch any image, you can turn the dinosaur into a 
monster. 

When you select Print you will a lso be confronted by the Dialog box 
you saw a moment ago, asking for some decisions relative to the way 
you want the document printed. Not a ll applications will offer this, 
and specific options will vary from one application to another; Figure 
4-26 is from MacWrite. You can specify whether you are using contin
uous (the default) or cut sheet paper; if the latter, the Imagewriter w ill 
stop after each page and prompt you to insert another piece of paper. 
You can al so specify the number of copies you want, a nd have the 
whole document printed (the defau lt) or on ly a selected range of 
pages. And you have three print qua lities avai lab le, as illus trated in 
Figure 4-27. 

Quality: 

Page Range: 

Copies: 

Paper feed: 

0 High 
@ All 

D 
0 Continuous 

(i) Standard 0 Draft 

0 from: D To: D 
® Cut Sheet 

Figure 4-26. A standard Dialog box for printing. 

OK 

(Cancel ) 

Draft quality is fastest, s ince it is text rather tha n graphics printing, 
and the Imagewriter can print it in both direc tions. I t will not show 
a lternate fonts, s ty les, and sizes, and does not look too great because of 
its spacing. But it will often be adequate for prelimina ry copies of 
documents . Standard quality is rela tively fast and includes a ll the 
type fonts, s izes, and styles avai lable; it can print combinations of text 
and pictures. This is what you should regula rly use. High quality 
prints everything twice, for a considera bly darker image. Bu t it a lso 
prints at h alf the speed of Standard quality, and wi th some font sizes 
or styles may be actua lly harder to read. Be aware that the Im
agewriter can use up printer ri bbons rapidly, especia lly if you do a lot 
of drawings; often what you rea lly need is not High resolution print
ing, but Standard resolution with a new ribbon . 

Finally, in some a pplications such as Mac Write, the File menu will 
a lso offer a Page S~tup option, as illus tra ted in Figure 4-28. The four 
Paper choices relate to differen t sizes of paper. Once chosen, display on 
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This text is being entered in the default Geneva, 12 point, plain type. This 
will be printed i n standard quality format using a reasonably new ribbon 
in the printer. 

Th1s text 1s be1ng entered in the default Geneva, 12 po1nt, pla1n type. Th1s 
will be printed in high quality format, using a reasonably new ribb.on in 
the printer. 

This text is b~ing ~nter~d in th~ d~fault Geneva, 12 point, plain typr. This 

will b~ print~d in draft format, using a r~asonably n~w ribbon in th~ 

printer. 

Figure 4-27. Examples of Standard, High, and Text Quality printing. 

the screen , as well as on paper, will refl ect the selec tion you have 
made. US Letter (8 .5 by 11 inches) is the deFault. Orientation re la tes to 
the placement of tex t on the printed page . Ta ll is the defaul t-stan
dard vertical printing. Wide, on the other ha nd, rotates each page 
image 90 degrees, a nd prints horizonta lly on the paper (this is not 
shown on the screen). This is of somewhat limited uti li ty on the 
Macintosh, particularly with MacWrite, because you cannot change 
page width to max imize use of an 11 inch wide page, but may some
times be useful. Tall Adjusted is used mainly when you have p ictures 
inserted in a MacWrite document, as it provides a more prec ise place
ment of them; in most cases the differences are m inima l. 

Paper: ® us Letter 

0 US legal 

Orientation: ®Toll 

0 H4Letter 

0 I nternationol F on fold 

0 Toll Hdjusted 0 Wide 

Figure 4-28. Dialog box for Page Setup in MacWrite. 

OK 

( Cancel ) 

We have now covered in considerable detail the operation, both 
basic and more advanced , of what can be ca lled the Macintosh way of 
doing things. You are ready to use what you have learned w ith any 
Macintosh applica tion; little adaptation will be requi red as you move 
from any one of them to o thers . In Part n we will probe in detail the 
basic Macintosh applications, a nd get you us ing those as well. 
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Checklist for Chapter 4 

1. Save puts a copy of the current document on the disk. The first Save 
produces a Dialog box that permits us to name the document and select 
the disk we want it saved to, via the Drive and Eject options. Subsequent 
Saves replace the file on the disk with the current contents of the 
document. 

2. Save as ... permits us to save a copy of the current document with a 
different name or on a different disk. 

3. Quit cancels the current application and returns us to the desktop. 
4. Close returns the curren t document to its proper place, but keeps the 

curren t application active. 
5. New, after a Close, opens an enti rely new document under the current 

application. 
6. Open ... , after a Close, provides a window showing a ll documents 

created by the active application, allowing you to select a document for 
reopening. 

7. A startup disk is one with the System documents present. The Macintosh 
needs these to boot (get started). 

8. Startup is a lso, to the Finder, the disk that was used to start the current 
Macintosh session. The Finder wi ll find a new startup d isk each time it 
is disconnected by the open ing of an application. 

9. Set Startup, from the Special menu, permits the selected application to 
open automatically when the Macintosh is turned on. 

10. Font Mover is an application for moving fonts into or out of the System 
file. 

II . Erase removes the entire contents of a diskette, but docs not deinitializc 
it. A startup disk can be erased only if it was not used to boot the system. 

12. Documents must be Open before they can be printed, and a copy is 
a lways written to d isk before the Print takes p lace. 

13 . Dialog boxes associated with printing permit selection of paper type, 
number of copies, print characteristics, and page characteristics. 
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Introduction 

MacWrite is the Macintosh 's word processor, which most users will 
have received or bought when they acquired the computer. It is a 
reasonably fu ll-featured word processing program, but does lack a few 
of the powers of some of the more sophisticated equivalen ts on other 
computers. Since it keeps the entire document in memory, for exam
ple, MacWrite on a 128K Macintosh is quite limited in terms of the 
size of any document it can create-about ten s ingle-spaced pages . If 
you have a 5 12K Macintosh, however, MacWrite can hold about eight 
times as much . (The third version of MacWrite is disk- rather than 
memory-based, meaning that it can deal with larger documents, al
though at a sacrifice of slower operation.) The program has, however, 
the general Macintosh advantages of ex traordinary ease of use and 
highly versat ile pr int formatting, plus the mixing of tex t and pictures. 
It is a lso better supported by Apple in terms of documentation tha n is 
the case for the Macintosh generally o r Mac Paint , which we will 
consider in the nex t cha pter. Th e Apple MacWrite manual is quite 
useful , but we will go th rough the program in our own fashion here. 

We will build here on what we have learned in Chapters I through 
4. You now have considerab le command of the Maci ntosh technique, 
of manipulating text, using windows a nd menus, ha ndling disks and 
documents, a nd so on. All of those ski ll s are used by MacWrite in 
pretty much the same way as you have used them so far. Thus we will 
not reintroduce them now, but , rather, te ll you to ta ke actions w ithout 
further prompting , when they a re things you sh ould know how to do. 
If in doubt , go back over the releva nt sections of Chapters 1 through 4, 
or check the Macintosh Quick Reference in Part III . 

Using MacWrite 

Let's begin. Use your copy of the Write/Paint d iskette rather than the 
one you configured for word processing only, because we w ill make 
some use of the Scrapbook a bit la ter. Make sure it conta ins a copy of 
Sample Memo-the documen t th a t came on your original Write/Paint 
disk-and then duplicate Sample Memo a nd name the new copy Trial 
Memo, so that we can mess around with it without concern . (If, by 
chance, you don't have a copy of Sample Memo, you can just open a 
new document and type in what you see on the screen shown in Figure 
5-1 .) Then Open Trial Memo, which will provide a w indow looking like 
Figure 5-t . 
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,. j file Edit Search format font Style 
., 

~0 Trial Memo 
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Date: 
To: 

July 16, 19M 
Robert 

From: Elizabeth 

I 

Re: Finance Meeting Agenda 

1. Moving Date: Let's wait a 'While. Discussing the moving date 
seems premature, since there are so many unknowns. 

Figure 5-1. The Trial Memo window before making any changes. 

~ 

Much of what you see will seem natural by now. The document's text 
occupies most of the screen . Most of the menu tit les at the top are 
quite fa miliar- Apple, Edit, Font, Style- a lthough some of their con
tents a re a bit different here because they a re cus tomized for Mac
Write . The two new menus , Search and Format, we will get to pres
ently. The Ruler, a t the top of the document, is used extensively by 
MacWrite to contro l margins , tabs, line spac ing, and line format. At 
the top left of the document window you will see the flashing cursor, 
and somewhere in the window the pointer. 

This is a good time to quickly review your text manipulation tech
niques. Move the pointe r into the document window and it will ta ke 
on the fa milia r 1-sha pe. Click the mouse button and the cursor creates 
a n insertion point where you have clicked . Try inserting text between 
a ny two words, then removing it with the Backspace key. No te how 
MacWrite automatica lly reformats text as you enter and delete char
acte rs . Select a few charac ters by dragging, then replace them by 
typing in new text. Select a whole word by double-clicking in front of 
or on it , then dese lect it by clicking anywhere else. Se lect a word or 
two a nd remove it with the Backspace key; you can go to the Edit 
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menu and se lect Undo typing to gel it back. Then return to the Edit 
menu, where you wi II find the same selection now says Redo typing, 
which really means "undo the undo." Try se lec ting the space between 
two words-spaces are just like other charac ters and can be replaced 
or deleted. 

Now practice a bit of cutting and pasting. Select a paragraph or 
more by dragging down and across. If you select too much but have 
not yet released the mouse button , just back up to dese lect any part; if 
you have a lready released the button , hold down the Shift key a nd 
drag back to deselect any part. Use Command-X to delete it. Then use 
the scroll bar to go down a bit in the document, select an insertion 
poin t, and do a Command-V to Paste what you have dele ted there . Try 
the same thing with Command-C (Copy) rather than Command-X, so 
that the original text is not removed; Paste that somewhere also. All of 
these choices, of course, can be made from the Edit menu as well as 
from the keyboard. 

Go to the first line of the memo, which reads "Re: Finance Meeting 

:0 Trial Memo 

Date: July 16, 1934 
To: Robert 
From: Elizabeth 

~e : Finance Meeting Agenda 

_o Trial Memo 
Date: July 16, 1 9<34 
To: Robert 

m 
Here are my comments on your proposed agenda for the Finance ~ 

From: Elizabeth 
Re: Finance Meeting Agenda 

Figure 5-2. Using the Backspace key to delete a carriage return and move 
a line up. 
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Agenda," and click an insertion point in front of the firs t character, as 
in the top window of Figure S-2. Now hit the Backspace key, to see tha t 
a carriage return is also a character , and can be dele ted, as in the 
bottom window of Figure S-2. Hit the Return key and that line moves 
back down to where it was. 

Mac Write offers two dis tinc t ways of selecting la rge blocks of text. If 
you drag the pointer a ll the way off the bottom or top of the window, 
text will continue to scroll and be selected until you ei ther release the 
mouse button or move the pointer back into the window. Alternative ly, 
you can shift-click . Go to the top of the document and click jus t in 
front of the word "Date." Then use the scroll box to scro ll down to the 
end of the documen t and shift-click. Every thing between the click and 
the shift-click is selected-in this case the entire documen t. You could 
now delete or copy al l this text, change its type font or s tyle, change its 
ruler settings, etc., which is often ve ry useful. For now, however, just 
click in the margin to deselect. 

We will continue to usc Trial Memo for wha t fol lows, so, if you have 
changed it dras tica lly while practicing, jus t Close it without saving 
the changes and then Open it aga in . 

MacWrite Menus 

Figure S-3 il lustra tes the six menus (not including the s tanda rd 
Apple menu) avai lable with MacWritc. Three of them are quite famil
iar by now. The Font and Style menus we have probed in some de ta il 
a lready. Note that with the illustrated choice of New York font, al l s ix 
s izes a rc ava ilab le; thi s will not be the case with a ll fonts . (Remember 
that the contents of this menu wi ll vary, based on the version of 
MacWrite you are us ing and the fonts you may have added or deleted 
with Font Mover.) All of the major Style choices can be selec ted from 
the keyboard as well as the Sty le menu; each is a toggle, so jus t select 
it again to turn the feature off, or select Pla in Text to cancel all current 
choices. For example, se lect the firs t short paragraph of the memo, as 
in the top window of Figure S-4; then do a Command-B for bo ldface, 
and deselect the text to see its cha nged appearance, as in the second 
window. 

Then select the same short paragraph, and use the Sty le menu or 
Command-B or Command-P to cancel the Bo ld; now select 18 Point, 
Shadow, and Underline. Deselec t the text a nd it should look like the 
third window in Figure S-4. Note that MacWrite automat ica lly refor-
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Show Rulers 
Open Heoder 
Open Footer 
Display Headers 
Display Footers 
Set Page# .•. 
Insert Page Break 
Title P 

New 
Open ... 
Close 
Saue 
SaueRs ... 
Page Setup 
Print ... 
Quit 

Cut 
Copy 
Paste 

Show Clipboard 

........ 
Seattle 
Los Angeles 
Coiro 
Toronto 
Son Francisco 
Chicago 
Geneuo 

./'New York 
Monaco 
Uenlce 
London 
Athens 

Figure 5-3. The six MacWrite menus. 
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~u 

~0 

~s 

~H 

~L 

mats tex t as its size changes . This can be seen even more clearly in the 
fourth example, where we have selected just two words a nd cha nged 
them to plain text and 9-point in size. 

Superscript and Subscript a rc choices we have not encountered 
before (if you have the earliest version of MacWrite, you w ill not see 
them on the Style menu). They are essential for some writing app lica
tions. Go back to the first line again, as in Figure S-5, and cl ick an 
insertion point after the word "Agenda." Then use Command-H to 
select superscri pt and type a " 1 ," which will produce the footnote 
number seen in the second window of Figure S-5; do a second Com
mand-H to turn superscripting off. Subscripts work the same way. Be 
aware, however, that superscripts and subscripts will make your line 
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Trial Memo 

Here are my comments on your proposed agenda tor the 
Finance group meeting nert week. 
I 

Plain TeHt 3CP ~~~~~~ 
Bold 3CB 
lltllic 3C I 

1;!2!~:2.o2!!~!=6!i~=!i!~~~~.tUnderline 3CU 
(i)(!J{l~ 3CO 

.101lJm(!](!)I!D 3C s 
Superscript 3CH 
Subscript 3Cl 

Q) !PG1kil{l 

n m IPIDII!iltl 
n ~ IPID!Imtl 
n ~ IPIDDmn 

.;ij(l)~ 

00 IPIDIIm{l 

Trial Memo 

JIU®r(i) truPL'Q R CC!Cilml{ID(Qm{trs Cilm y®m{P propoa~d ji' 

agulda frooga {tfb® JPftm!MlCC!L'Q !~JfPCilW[!l fiDCii®Rftml! 

m'i~R VUrk" ;ii 

Figure 5-4. Altering fonts and styles in MacWrite. 
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spacing uneven as MacWrite makes room for them . This is a weakness 
of the program. You can compensate for it, to some degree, by doing 
your superscrip ts a nd subscripts in smaller type, as in the third 
window in Figure 5-S , where we have selected both superscrip t a nd 9-
point type . 

~=~Ojj~~~~~~~~~~T~ri~o~l B)M ..IPioin TeHt 
Bold 

Re: Finance Meeting Agenda 

/Iuiie 
Underline 
mrnnonrn~ 
~G](i)(!J[!JJ 

3€P~~~~ 

=~ ~' 
3€U 
3€0 
3€S 

SuperS( ript .:*t. H 

;:;O Triol Memo 

Re: Finance Meeting Agenda 11 

0 Trial Memo 

Re: Finance Meeting Agenda 1 

Figure 5-5. Using superscripts with MacWrite. 

The rest of the Font and S tyle choices offer nothing new, a nd so can 
be left fo r your own exploration. Likewise, the File menu includes only 
materia ls we have dealt with in deta il in Chapters 3 and 4. The 
printing controls (Page Setup a nd Print .. . ), which were expla ined in 
Chapte r 4, used examples from MacWrite. 

The Edit menu is a lso the same as we have worked with before, 
except tha t the top choice-Undo-is somewhat more speci fi c. It will 
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specifica lly refer to our most recent action , usua lly say ing "Undo 
Typing," because that is what we are most often doing. In Figure 5-3 it 
says "Undo Hide Rulers ," because that had been the most recent 
ac tion (it is explained below). Also , after a n Undo, it will say "Redo," 
agai n specifying the most recent action. This makes clear jus t what 
the Undo or Redo can accomplish , but actually the command is 
working exac tly as we have experienced it before. 

The Search menu is new to us, and relates to one of the most 
powerful characteristics of word process ing: the ability to automat i
ca lly search through a document [or any string (the computer world's 
term for any group of characters), and, if desired, replace it w ith 
something e lse. The longer the document, the more useful thi s ability 
will be. Le t's scroll to the top of Tria l Memo. Assume tha t, after 
writing, we suddenly realize that we may have referred to Tim with
out us ing hi s last name, a nd we want to be sure about this. Go to the 
Search menu and select Find . .. , wh ich produces the Find window of 
Figure S-6. We can then type in Tim, as the string to search for. We 
have a choice of search ing for the Whole Word (the default) or Partial 
Word, in which case any s tring in which the characters "Tim" ex is ted 
would be found. Genera lly we want the former. MacWrite ignores case 
in searches, so capitali za tion is irrelevant. 

Click on Find Next and MacWrite sea rches through the tex t until it 
encounters the string specified, which it highlights. We cou ld now 
click on the Tria l Memo window and add a las t name, if we had 
neglected to use it. Then click on Search again, select Find .. . , and 
no te that Tim is s till in the Find what box. So click on Find Next once 
more, and MacWri te tell s us that no more occurrences of tha t s tring 
have been found, as in the second window in Figure S-6. We can a lso 
use a shortcut approach , by jus t hitting the Return key ins tead of 
clicking on Find Nex t; repeated hitting of Return w ill keep MacWrite 
looking for additional occurrences unti l it has searched the entire 
documen t. 

Le t us suppose, additiona lly, that we real ize we have used the term 
Finance when we rea ll y wan ted to say Financia l Department. We can 
go to the Search menu and pick Cha nge ... , which produces the third 
window of Figure S-6. We enter what we want found and what we 
want to rep lace it with. You can move back and forth between these 
two boxes by clicking or by usi ng the Tab key. We then have three 
immediate choices. By c licking on Find Nex t, the next ins tance of 
Finance will be searched for and high lighted. Then the "Change" and 
"Change, Then Find " bars become ac ti ve, permitting us to make the 
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_o Find 

Find what ~...lr_tm ________________ ____J 

[Find NeHt ) ® Whole Word 0 Partial Word 

"Tim" not found 

Chan 

Find what Finance 

Change to 

(find NeHt) ( [ lHHH.W, 'TlH~n find ) ( l: lHHH.~·~ ) ( Change Rll ) 

@Whole Word 0 Partial Word 

WARNING! "Change Rll" is not Undo-able! 

n Go Rhead D (Cancel ) 

Figure 5-6. Windows for Find ... and Charge ... from the Search menu. 

change, or make it a nd automatically move on to the nex t occurrence. 
Alternative ly, we can just click on Find Next and not implement the 
change for thi s occurrence. Hit ti ng the Return key ins tead of clicking 
on Find Next accomplishes the same thing. 
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We can also just click on Change All, in which case MacWrite will 
automatically search through the en tire document, changing every 
occurrence of Finance to Financial Department without pause for user 
in teraction. It provides us with the Alert box seen in Figure S-6 as a 
warning of this, because it can sometimes have undesired effects. If 
you use Change All with Partial Word, for example, the string you 
specify will be changed when it is part of other strings, regardless of 
capitalization. (Changing "rest" to "remainder" with Change All and 
Partial Word, for example, would turn "poorest" into "pooremainder" 
and "RESTAURANT" into "REMAINDERAURANT"!) 

The third version of MacWrite offers some additional features 
based on the Search menu, which are not included in these illustra
tions. Find Next can be chosen from the Search menu itself, or with 
Command-F from the keyboard, which avoids having to reopen the 
Dialog box, therefore saving time. The Search menu also offers a Goto 
Page option (Command-G from the keyboard), tied into another new 
feature-the Scroll box shows the page number you are currently 
working on. It will sometimes be handy to be able to scroll to a given 
page. 

Try some changes, to get a feel for how Find ... and Change 
... actually work. They a re s imple and extremely useful. Among 
other things, Change .. . can be used to simplify typing. If you have a 
long and clumsy name or chemical formula , for example , which you 
wi ll be using often in a document, you can simply type in one or two 
characters to represent it (for example, a"@" or a "#"); then, when 
you are a ll done, automatically replace all occurrences of"@" with 
the actua l name. You do not h ave to be at the start of a document to 
search entirely through it. MacWrite will a lways go forward from 
where you are, and then loop around from the beginning of the 
document back to where it started. You can also use Copy and Paste to 
insert text in the Search Dialog boxes-copying in the document itself 
and then pasting after opening Find . .. or Change . . . ; usually, how
ever, it is easier just to type the text in . 

The Format menu a lso provides a number of MacWrite's dis tinctive 
capabilities , some of which we will discuss a bit later. A few of them 
can be ha ndled here. For example, Title Page, when selected, results in 
the text of a ny header or footer we have designed (for example, page 
numbering) not being printed on the first page of the document; blank 
lines are inserted instead. Set Page # ... permits us to specify that 
the first page of the document be numbered something o ther than one, 
with a ll subsequent pages in that document being numbered sequen
tially after it. It is set via a special window, as seen in Figure S-7 . Its 
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main use is when we are creating something longer than MacWrite's 
memory permits for a s ingle document. We can then create as many 
separate MacWri te documents as necessary (sections, chapters, a nd so 
on), and s till be ab le to correct ly paginate the whole thing. 

New page number? 1•1 
( OK ] ( Cancel ] 

Figure 5-7. The Dialog box provided when Set Page # ... is selected from 
the Format menu. 

Insert Page Break does just that-it puts in a page break wherever 
we want it, regardless of how much text is on a page. MacWrite inserts 
page breaks automatically when the capacity of a s ingle page has been 
reached (the number of lines wi ll of course vary based on the type 
fonts and sty les we have se lected). But if you definitely want some text 
on a new page, you can force a page break anywhere you like. Fot· 
example, in Tria l Memo scroll down to the end of numbered para
graph 3, and click a n insertion point a t its end , after the word "down." 

Insert Ruler 
Show Rulers 
Open Header 
Open Footer 
Display Headers 
Display Footers 
Set #, .. 

The rest of the agenda is fine . As always, in the interest of brevity, 
keep Joe from straying off the subject. You can reach me as follows 
if you have questions: 

New York 
Washington 
Cleveland 

The J and L 
Emery's 
Mother's 

Figure 5-8. Manually inserting a page break in MacWrite. 
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Then go to the Format menu a nd select Insert Page Break, which will 
resu lt in a window looking like Figure S-8. The dot ted horizonta l line 
is MacWrite's page de li nea tion marker, and the materia l at the bottom 
of the window is now on page two. 

All the empty space now on the lower part of page one is, to 
MacWrite , a grou p of cha racters. As with o ther things in the Macin
tosh , those charac ters can be replaced, removed, copied , and so forth . 
Just move the pointer above the page break line and click-the empty 
space is highlighted . You can now remove it with the Backspace key, 
and the page break you inserted is removed as well ; this is simi lar to 
the removal of carriage re turns we saw ear lier. 

Mac Write Rulers 

MacWrite uses rulers for a number of text formatting charac
teristics, and new rulers are inserted whenever you wish to ma ke a 
change. Figure 5-9 ill us trates and labels a typical s tandard ru ler that 
MacWrite inserts at the beginning of every new documen t you create. 
We wil l look at each of its icons, and then see how variations can be 
created. Ru lers are themselves windows and, like other windows, can 
be copied, cut, etc. (the s ta rting ruler, however, cannot be removed). 

An important MacWrite limitation is that only about s ix inches of 
hori zontal space are allotted on the screen for tex t. One inch on the 
left cannot be used in any way; your left margi n can only be at tha t 
point or further to the r ight. The default is one and one-eighth inches 
(the margin marker was moved further in on Sample Memo, a copy of 
which you are using here). And on the right, you can see only up to 
s lightly past the seven inch marker, leaving a default margin of one 
and one-half inches on that side. 

You can get closer to the right-hand edge of the paper by moving the 
whole window to the left and then increasing its s ize with the s ize box, 
to about the eight-inch mark, as in Figure 5- l 0 . But this results in your 
not seeing a ll of the window on the screen , which is very clumsy for 
enter ing text. (You can, however, type in your text in the s ta ndard 
window, so that you see what you are do ing, and then expand the 
window and change the margins jus t befo re printing.) Overa ll, you 
must learn to live with the window size MacWrite provides; by using 
the smalles t type font with its smal les t size you can get I 00 or so 
characters on a line. This is less than the printer is capable of, but 
MacWrite will not easily permit more. 
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Figure 5-9. The MacWrite Ruler. 
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Triul Memo 
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uly 16, 1984 
~obert 

mzabeth 

;inance Meeting Agenda 

Figure 5-10. The MacWrite window moved and the right margin extended 
as far as it will go. 

On the right side of the ruler a re four boxes for se lecting line 
justification. The default , leftmost, is highlighted when any document 
is started , providing left justification, meaning that the lines are a ll 
Oush on the left s ide but not the right. The user can choose, moving 
from left to right, centering of a ll tex t; right justification (as for 
headings a nd return addresses, fo r example); a nd full justification , 
where spaces are automatically added so tha t both the left and right 
edges of a ll lines (except short ones) are flush. 

Click on each of these boxes to see how the appeara nce of the 
document cha nges. MacWrite does the reforma tting ins ta ntaneous ly, 
which is one of the a dva ntages of its keeping the whole document in 
memory. 

The th ree boxes fu r ther to the left are for line spacing: single-space 
(the default), space and one-hal f, a nd double-space. This is the spacing 
MacWrite will insert as it word-wraps automatically from one line to 
the nex t, a nd is also the spacing created whenever the user hits the 
Return key-normally a t the end of a paragraph . Click on each a nd 
observe the ch anges. Any ruler cha nge can be undone by reselecting 
the previous se tting, or by selecting Undo Ruler Change from the Edit 
menu (Command-Z from the keyboard). The la tter is ava ila ble, how
ever, only immedia tely a fter you have changed the ruler. 

The last box, labeled 6/ines/inch, is an addition to the third version 
of MacWrite. It lets MacWrite documents conform to the most stan
dard form of computer printing, and will be useful for preprinted 
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forms and so on. It is also better for superscripts and subscripts, since 
it avoids the uneven line spacing which otherwise results. 

The black tri a ngles se t left and right ma rgins; they can be eas ily 
moved by jus t dragging them with the pointer to wherever you want 
them. Note that on the left there are actually two markers, as we can 
see more clearly in Figure 5- 11. The larger tria ngle is the left margin 
proper, while the smaller one (with the "tail") is a paragraph indenta
tion marker. It denotes where new lines created w ith a Return ra ther 
tha n via word-wrap should s tart. Thus, if you want a n indent or a n 
outdent for paragraphs, you would move the s ma ller ma rker to the 
right or left, respectively, of the left margin ma rker. If you want a ll 
lines to be flush on the left, you would keep the two together. 

Indent Demo 

1 .. l ...•.. J.: ..•.. ! ..• .. J? .... l ...•.. .1 ...•... l ...• .. .l.~ •... l ...•.. .1 ...•... l ...•.. .1.1 ... l ...•... L.. •... l ...•.. .l.~ •... l ...•. :!·· ···l ...•. ..1.~ •... l ...• .. .1 ...•... l ...•.. :J? g 
!£a~ ~~~ ~~~~ 11 

When we enter text it will wrap around to whereYer we haYe 
set our left margin marker, and then it will continue to start each 
line at that place. But when we use the Return key for a new 
paragraph, such as NOW. 

MacWrite will automatically begin the new line at the 
paragraph indentation marker. 

Figure 5-11. A MacWrite ruler showing the left margin and paragraph 
indentation markers separated. 

Hm: 

I 
ltltlf 

1~1 
@ll 

Finally, the two boxes with hollow triangles a re tab wells , providing 
an endless supply of regular a nd decimal tabs, to be placed anywhere 
a long the ruler we wish. You simply press on the box a nd drag the 
shadow of a triangle to where it is wanted. In Figure 5- 12 we have 
added a s tandard tab marker at the three-inch mark and a decimal 
tab at the four-inch mark. To remove a tab marker, jus t drag it toward 
the bottom of the ruler; when it becomes boldfaced, release the mouse 
button and it will disappear. 

The Tab key w ill move the cursor to the nex t tab marker, going on to 
the following line if there are no more on the line currently addressed. 
The decimal tab is for entering numbers, as for tables. Unlike a 
standard tab , which a ligns things from the tab position rightwards, 
the decimal ta b will line up deci ma l points at the ta b marker, with the 
associated numbers to their left a nd right. 
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Here we have dragged two new tabs from the tab wells, a regular tab 
et the three-inch mark and a deci mal tab at the four-inch mark. Now if I 
hit Tub » the insertion point jumps to the next tab stop. 

And if I want to enter numbers, with their decimal points aligned, I 
Tab to the decimal tab » 4.55 

26.347 
1,892.044 

and everything l ines up correctly. 

Figure 5-12. A MacWrite ruler with two new tabs set. 

I 

All of this provides a good deal of readily available versati lity, so 
let's try it out. Scrol l to the end of Trial Memo a nd click a n inse rtion 
point after the word "Mother's ." Then, from the Format menu, se lect 
Insert Ruler, which will give us a new ruler, as in the top window of 
Figure 5-13. Note tha t a n inserted new ruler is a copy of the current 
one. Le t's make some cha nges, as in the bottom window of Figure 5- 13. 
Move the s ta nda rd ma rgins to the two- and six-inch ma rks, a nd the 
paragra ph indent m arker to one a nd one-ha lf inches. Drag one s tan
da rd tab to three a nd one-hal f inches and the decimal tab to five 
inches, di sca rding the other standard tab . Click on the box for one and 
one-ha lf line spacing a nd the box [or full jus tification. 

The cursor should be beneath the ruler a t the pa ragraph indent 
mark; if it is not, hit the Return key. Then begin typing text as in 
Figure 5- 14. Don 't use the Return key in the firs t paragra ph-jus t le t 
MacWrite word-wrap around . You should use a Return after the word 
"spac ing" and then use the Return a nd Tab keys to insert the colum
nar items . (There may a ppear to be an additiona l, unset ta b stop at the 
two-inch mark; tha t is because you are us ing an outdent, and Mac
Write sees the sta ndard margin ma rker as a ta b a lso.) 
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Figure 5-13. Inserting and setting a new ruler. 

=o Trial Memo 

Washington Emery's ~ 
Cleveland Mother's ii!lii 

} •... .I .... •·-±-'--I...·•-_1?.._.J._ .... J ....•... .I .. ..o •• ..I.~ •... L .o-! ··'···.I--•·J -1 ... .1 •••• •• -.I .. _, ... .I ....•.. ~?., ... .I.-.•.. ..1 .... , ..•. 1 •••• , •• 1~•·-.I-.. • .... L,_J ...... ..J.?. illlii 
I"Al~ ~~~ ·~~~~ mm 
1.:.:..1 1.:.:..1 liiiiiiiii.J-~ L=J- ~-~ ~-~ ijijij 

This is a test of the operation of Mac Write's rulers. I have ~ 
inserted a new ruler here so that I can observe its 

effects. I am using an "outdent" so that the first 

line of each paragraph extends five spaces to the 

left of the rest of the paragraph. I am also using 

one and one-half line spacing. 

Charles 

William 

Sam 

$49.95 

$132.50 

$b.87 

Figure 5-14. Entering text under a new ruler. 
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Now scroll to the beginning of Trial Memo and select the ru ler there 
by clicking anywhere a long its top (where the numbers are); it will 
invert. Copy it with Command-C. Then scroll back to the botto m, click 
an insertion point after "$0.87," and then do a Command-V fo r paste. 
You now have inserted a copy of the origina l ru ler and any more text 
you type will conform to its specifications. This is easier tha n insert
ing another new ruler if you want the same fo rmat as before, but 
either me thod can be used. 

Open the Format menu and se lec t H ide Ru le rs , as in the top of 
Figure 5- 15. This removes rulers from the sc reen, givi ng you more 
room to view the text you are entering. All ru lers a re st ill active, 

one and one 

inserted a 

effects. I 

Open Header 
Open Footer 
Display Headers 
Display Footers 
Set Page#., , 
Insert Page Break 
Title P 

one and one-half line spacing. 

Charles 

·s rulers. I have 

that the first 

spaces to the 

am also using 

$49.95 

Figure 5-15. Selecting Hide Rulers and Show Rulers from the Format 
menu. 
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however, and wi ll control the format of any new tex t you insert in the 
areas beneath them. You can a lways selec t Show Rulers from the 
Formal menu, as in the bottom of Figure 5- 15, when you want to sec 
them. 

Now se lect the new ru ler you have just copied a fter the entry for 
"Sam." Hit the Backspace key and it is gone. Then scroll up to the new 
ruler we created in Figure 5-14, se lect it, and hit Backspace again. 
Note how the nature of your inserted text immed ia te ly changes, as its 
formatt ing is now controlled by the orig ina l ru ler a t the top of the 
document. Then go to the Ed it menu and se lect Undo Typing-your 
ru ler is re inserted . It says "U ndo Typing" because using the Backspace 
key, to MacWrite, is a typing action; if you delete the Ruler with Cut, 
the Edit menu will say Undo Cut. 

The abi lity to insert new ru lers with a ny desired se ttings a t a ny 
point , and to cut, copy, and pas te them, is really quite powerful. In 
some cases it is rather cumbersome, for example ir you just want to 
cen ter or r igh t-just ify one line of type. Sometimes you can achieve 
such an end s imply by spacing to where you want to type, but often 
you will have to use a new ruler for even such simple changes. 

Whenever you change a ruler's settings, all text between it and the 
next ruler (or the end of the document if there is no next ruler) wi ll be 
affected. This should not be forgotten. For now, you can delete the new 
ruler and the new tex t; selec t the ruler and then drag down unti l a ll 
the new tex t is highligh ted along with the ruler, then use the Back
space key. We will use the original Tria l Memo to explore some addi 
tiona l fea tu res of MacWrite. 

E xpanding MacWrite __________ _ 

What you have learned in this chapter so far, plus your understa nd
ing of earlier cha pters, w ill permit you to take extensive advantage of 
MacWrites ca pa bilities . You a re a lready well prepared for producti ve 
word process ing. But there a re some add itional MacWrite features 
that make it even more versati le, and we will look at those now. Make 
sure Tria l Memo is open, and scroll to the top of the document. 

H eaders and Footers 

Headers and foo ters are text that we want inserted at the top or 
bottom, respectivel y, of each page of the document we a rc working on 
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(except for the firs t page, if we have selected Ti tic Page from the 
Forma l menu). They can be as simple as jus t a s ingle page number, or 
as ex tensive as about one-thi rd a page of text o r pic tures. We create 
the m in specia l Header a nd Footer windows which are comparable to 
other w indows in the Macintosh- we can change their size, copy 
materia l into them , delete it from them , and so on. Th ey a lso have 
some unique features, such as icons that automat ically report the 
time, da te, or page number. 

Go to the Format menu a nd selec t Open Footer, which w ill proyide 
the window we see in the top of Figure 5- 16 . (The Header window is 
iden t ica l.) Note tha t it is a s ta nda rd MacWrite w indow with its own 
ruler, s ize box, etc ., but tha t it a lso has three specia l icons jus t below 

0 Footer 

.~ .. L. • .. .l ...•.. .l ...• .. .l.? .... l ...• .. .l .... ... L. . ... J.~ •... L. • ... L. •... l ...• .. .l.1 ... l ...•... L. •... l .... .. .l.~ •... l ...•. :!·•· .. l .... .. .l.~ •... L. • . J ...•... L. • .. J.: 
~~ ~~E) ~~~~ 

-0 Footer 

·~-L. . ... I... . ... L. . .. .l.? .... L. • . J .... ... L ... .l.~ .... !..,, ... L . ... L. . .. J1 ... !...• ... L., ... !...• .. J~, ... L. • . li;·• ... L. . .. .l.~, ... L. . .. J .... ... L.• .. J.: 
~~ ~~E) ~~~~ 
Robert, IBJ page II!!! 

Figure 5-16. The Footer window, blank and with text and icons entered for 
display in the document. 



134 0 II: Doing Work ____________________ _ 

its title bar. Note a lso that the s ta ndard menus for Font, Style, and so 
on are avai lable for this window a lso. The window, as provided, will 
permit up to six lines of text, but it can be made larger or smaller. Le t's 
insert a simple footer appropriate to the purpose of Trial Memo. We 
will use only the top line of the window; if we were to space down, the 
actual space reserved on each page for the footer would be increased. 

Type in the name "Robert" followed by a comma and a space. Then 
go up to the calendar icon just under the w indow's title, and drag it 
down just to the right of what you have typed. Now use the space bar 
to move the insertion point to jus t under the five a nd one-half-inch 
mark on the ruler, and type the word "page" followed by a space. Then 
drag the page icon (with the # sign) to the right of what you have 
typed. The window should now look like the bo ttom illustration of 
Figure 5-16. Then click on the window's Close box. Scroll a ll the way 
down to the bottom of Trial Memo and you will see -your Footer 
properly inserted, as in Figure 5-17. (If it does not appear, you proba
bly clicked on Title Page in the Format menu, which would impede 
printing the footer on the first page of the document. Open the Format 

=D Trial Memo 
u 'fVU UCl V<:: 'iU~::SUUU::S. 

I· 

Robert, June 13, 1 984 

New York 
Washington 
Cleveland 

The J and L 
Emery's 
Mother's 

page 1 

Figure 5-17. The bottom of a Trial Memo page showing the footer created 
by the window of Figure 5-16. 
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menu a nd, if Title Page has a check in fron t of it, select it , which will 
toggle it off.) 

Now select Open Header and click on its ruler box for centering 
text. Then, from the Style menu, select Shadow a nd 18 Po int, hit the 
Return key twice, and enter the tex t you see in the top window of 
Figure 5-18 . Then close the Header window, selec t Hide Rulers from 
the Format w indow so you can see the appearance of your document 
better, a nd the s ta rt of your new Tria l Memo will appear like the 
bottom part of Figure 5- 18. The added spaces , here, have increased the 
size of the top header margin, which you will some times want in 

I Header 

~,J_,,j_,_,L, .. J.?,_j_,,,l.,,, .. ! ... ,.J~, ... ! ... , ... l.,.,_ i ... ,,.J.1 ... l...• .. J _, _ _!,,,,_l~, ... L,,,:l;:·• .. ..L ... , .. J~,-l..., ... L., ... L.•-l: 
~~ ~~E) ~~~~ 

::0 Trial Memo 

Date: July 16, 1984 
To: Robert 
From: Elizabeth 

Figure 5-18. Creating a header in the Header Window, and its appearance 
in Trial Memo. 
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either a header or footer, but which obviously leaves less room for text 
on each page . 

Note, in Figure 5- 19, the selections for Display Headers and Remove 
Footers. These relate to d isplay on the screen and in printing. If you 
create a header or footer and then choose Remove, it will not be seen on 
screen or in the printed document. It does remain in the file, however, 
and can be used later simply by selecting Display. If you want to com
ple tely remove a header or footer, select Open Header or Open Footer 
from the Format menu, then se lect and delete a ll of its text. 

., 
~r ~-~F~iile~E~d~iit ~seia~ricihr ••:r.~,nr~~~~~ Font style 
~ lnsert~R~u~le~r~-~~~~~~~~~iiii~~ 

Show Rulers lA 

Date: July 16, 1 g 
To: Robert 
From: Elizabeth 

Open Header 
Open Footer 
Display Headers 
Remoue Footers 
Set Page# ... 
Insert Page Break 
Title Page 

Figure 5-19. The Format menu permits us to have headers and footers 
displayed or hidden. 

~ 

In addition to the provided icons for page number, date, and time , 
and tex t you type in, headers and footers can contain a ny Macintosh 
text, such as pictures transferred via the Clipboard-so long as they 
are not la rger than a bout one-third of a page. Headers and footers can 
a lso simply include space-if you insert only carriage returns in the 
header or footer window, you wi II increase the s ize of top and bottom 
margins according ly. This may not be useful very frequently, but wi ll 
permit, for example, the use of preprinted letterhead s tationery with 
MacWrite documen ts. 

Note that there is no relationship between the Se t Page # ... facili
ty of MacWrite a nd the Page Range specification available when you 
selec t Print. That is, you may have told MacWrite to number the 
current document starting w ith page number 43 , so that its pages 
range from 43 to 49. So far as Print is concerned, however, you have 
pages I through 7, and partia l printing instructions have to refer to 
them as such, regardless of the page numbers tha t may be prin ted in a 
header 01- foote r. 
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Text and Pictures 

One of the great advan tages of MacWrite is its a bility to incorporate 
a ll or part of documents created with o ther Macin tosh applicat ions, 
not leas t MacPaint. The combina tion of tex t and pictures is powerful, 
indeed. The techniques for doing thi s involve the same cutting or 
copying a nd pasting we have used before, with a couple of added 
fea tures provided by MacWrite. The picture itself must be on the 
Clipboard, having been transferred there d irect ly from MacPaint or 
from the Scrapbook; it is then pasted into your MacWrite document 
wherever you want it. 

As an example, ma ke sure Tria l Memo is open, and click an insert ion 
point a t the end of the first line, after the word "Agenda." Then, from 
the Apple menu, select Scrapbook, and page through it , if necessary, 
until you see the picture in Figure 5-20 (if you no longer have that 
picture , you can use any other). Choose Copy from the File menu, a nd 
then close the Scrapbook. Now, with the insertion point as above, do a 

Date: 
To: 
From: 

Re: 

Figure 5-20. Calling up the Scrapbook from MacWrite to copy a picture to 
the Clipboard, preparatory to transferring it into a MacWrite 
document. 

., 
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Command-V for pas te , and the result, as in Figure 5-2 1, is the drawing 
inserted where we have asked , with th e continuing text automatica lly 
moved down to accommoda te it. 

Here are my comments on your proposed agenda for the Finance 
group meeting next week. 

Figure 5-21 . The same picture, after being pasted from the Clipboard into 
the MacWrite document. 

Once inserted, the picture can be readily moved and a lso resized. To 
move it up or down, jus t click an insertion point to the left of the 
pictu re, and then use the Re turn or Backspace key to add or delete 
lines, thus moving the picture. To move it hor izonta lly, firs t cl ick on 

Figure 5-22. Clicking on a picture provides a border, which can be 
dragged to move it horizontally. 

I 
Ill 
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the picture itself, which produces a border around it, as in Figure 5-22. 
Then position the pointer on either the left or right vertical border and 
drag to move, as we have done here. You can a lso use the three boxes 
on the bottom border to change the size and proportions of the figure. 
We have lengthened it in Figure 5-23 by dragging on the middle box. 
The two corner boxes permit both lengthening or widening, or both 
simultaneously, depending on the direction you drag them, as seen in 
Figu re 5-24. 

J 
-

Here are my comments on your proposed agenda for the Finance 
group meeting next week. 

Figure 5-23. The center box permits lengthening or shortening a picture. 

I! 

1~1 

II 

One thing that MacWrite does not permit is the addition of text to 
the r ight or left of any picture you have pas ted into one of its docu
ments. The picture, in effect, covers the width of the page regardless of 
its actua l s ize. If you p la n ahead, however, you can add tex t next to the 
picture when you create it in MacPaint, and then transfer the whole 
thing into your MacWrite document. If you usc the same fon t in both 
instances, the effect can be very professional. 

With these few techniques, combined with MacPaint's sophis ticated 
abil ities to create pictures in the first place, you have considerable 
power over graphic displays in MacWrite documents. Moreover, the 
same techniques can be used to move tables from spreadsheets, data 
or diagrams created by BASIC programs, and so forth, a lso into 
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~0 

I 
I 
~~~ 

Figure 5-24. The left and right boxes permit altering length and width of a 
picture. 

MacWrite documents. As more a nd more a pplications for the Macin
tosh emerge, there wi 11 be that many more forma ts of materia ls that 
can be merged into MacWrite. 

Forms 

The cu rrent version of MacWrite does not have true "boi lerplate" 
capabilities , where you can store freq uently-used text in a set of fi les, 
and automatica lly read any one fil e or group of files in to the one you 
are working on. You can achieve this end with cutting a nd pasting, 
which is super for what the Mac intosh does wel l, but no t adequate to 
the demands, for example, of a legal office which wants to insert 
leng thy s tandard sections into developing documen ts. But it is possi
ble to create forms for many uses, greatly expediting their usc under 
MacWrite. Letterhead s tationery is the most obvious example , but 
others will a ppear as you begin to turn the Macintosh to pract ical 
applications. 

We can use a let terhead for an example of for·ms creation, however, 
that will suggest the possibilities . Whether for bus iness or personal 
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use, there is no need to constant ly enter the same tex t for each new 
letter. Rather, as we have seen above, you can create the bas ic form, 
a nd then, whenever a "piece of s tationery" is required, e ither dupli
cate it or use Save as ... to create new copies. Let 's Close Trial Memo 
from the File menu , and then select New for a new MacWrite docu
ment. We will set up our rulers and h eadings for a business s ta tionery 
pad . 

In this case, we want our original ruler to specify cen tered a lign-

=o Untitled 

.~ .. l.. .. ... L. •... ! .... .. .J.? •... l.. .•.. .1 .... ... ! .... . ..1.~ .... L. . .. .1 ....... L. • .. .l.1 ... ! ...• .. L. •... l .... .. .l.~ .... ! .... . :!·· ... l... . .. .l.~ •... l ...• .. .1 .... ... ! ...• ..• e!Q 
~[3 ~§)~ ~~~~ i 

~w~oo~wooD~ ~nw~ ~ ®w~~~ I 
2438 DESERT AYE. !:!:!: 

PALM SPRINGS, CA 90753 111111 

(714)555-9433 TELEX: 499885~ I 
mm 

-o Untitled 

Figure 5-25. Developing a letterhead form in MacWrite. 
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ment and single spacing, and will use also some dis tinctive text styles 
for a nice appearance. We could even design a logo in MacPaint and 
make it part of our letterhead. The effect of this is seen in the top of 
Figure 5-25. Next, we will enter the word "date," having reselec ted 
plain 12-point type, and then insert a second ruler that we want for the 
body of our letters . On this ru ler, we specify a paragraph indent, tabs 
at the two- and four-inch marks (the la tter for automatic placement of 
our closing and name), and left justification. And we then insert the 
word TO where the recipient's address will be . This is reflected in the 
second window of Figure 5-25. 

There are speci fi c reasons for the insertion o[ "date" and "TO," 
related to the way in which MacWrite ha ndles rulers and changes of 
font without any text presen t. If we did not have the word "TO" there, 
for example, any text we began to enter would sti ll be controlled by 
the original ruler, unless we have the second ru ler displayed, which 
interferes with seeing how our document will look. Since our whole 
a im with this exercise is to save time and effort, that would not be a 
good way to proceed. Now, however, we can select Hide Rulers from 
the Format menu and save the document with the rulers hidden . Then, 
when we open a copy, we just selec t the word "da te" a nd replace it 
with the current date, and then select "TO" and replace it with the 
address we are writing to, and we are automatica lly entering text 
under the control of the second ruler, as in Figure 5-26. 

0 johnson 

~@~OO~®ooa~ FD®~ ~ ®~~@~ 

( 71 4 l 555-943; Al~
4 

~:R~~~;~~~ ~~753 TELEX 4998858 ~~~~ 

Som Svobodo 
1428 18th St. 
Haymarket, CO 47762 

Dear Mr. Svoboda: 

June 13, 1984 

Figure 5-26. Using our letterhead replacing the dummy entries. 
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Needless to say, our s tandardized tex t could be much more elabo
rate, not only with pictures and font selections, but a lso with stan
dardized headers and footers. You should now try design ing one of 
your own, saving it with a n easily recognizable name. Then just Open 
it , and use Save as ... to have a fresh copy without disturbing the 
original whenever you require a piece of "stationery"-all the busy 
setup work will have been done ahead of time. And the same can be 
done for s tatements, invoices, whatever, with all fi elds defined and 
only the pertinent da ta waiting to be filled in . 

Tables 

Creating tables and columnar data with MacWrite is poss ible, but a 
bit clumsy. The inability of the MacWrite user to turn word-wrap off 
and to have no justification at all can make it frustrating to try to 
precisely posi Lion things on the page . Indeed, it is often easier to 
create your tables with MacPaint, and then copy and pas te them into 
your MacWrite documents. But simple tables can be created direc tly 
in MacWri te by the judicious use of the space bar and tabs, and we 
will review the process here. 

Close the current document and open a new one. We wi ll now create 
the screen illustrated in Figure 5-27. The default ruler is changed only 
in clicking on the box for centering a ll text, and then the headings are 
put in (the firs t line is in 24-point boldface , underlined, and the second 
line is in 14-poin t pla in text). Then the second ruler should be in
serted , with one and one-half line spacing and left jus ti fication. We 
have moved the default tab s top from the 5 1/2-inch mark to 43/4 inches, 
a nd inserted two addi tiona! tab s tops at the 2 1/2- and 31/2-inch marks, 
plus a deci mal tab stop at 6 inches. 

If we want the column headings cen te red over the ir associated data, 
as is the case with the words "Delicious" and "Revenue," we have to 
use the space bar for pos itioning them. This is rather clumsy with 
MacWrite because of our inability to turn word-wrap or jus tification 
off, but using auto-repeat of the space bar helps. Then the actua l items 
are easily entered , using the Re turn key for each line a nd the Tab key 
to move from column to column . 

In Figure 5-28, we a re adding a new column. To do thi s, firs t add 
another ta b marker where it is wa nted ; in this case, we have moved 
the other tab markers firs t to make room. Then click an insertion 
point just in front of each Revenue amount- in this case we arc up to 
the third li ne ($696.50). Type in the new entry, as we are doing here, 
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SALES FIGURES 
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Mocintosh Pippin Delicious 

January 42 37 18 

February 67 46 32 

March 85 60 56 

April 90 65 60 

Figure 5-27. Creating a table with MacWrite. 

Revenue 

$384.80 

$414.90 

$696.50 

$795.90 

I 
I 
~ 

and then hit the Tab key to move the amount over to its new place. The 
values in the Revenue column are changed quite s imply by jus t selec t
ing the tex t and typing in the new amounts. MacWri te does not have 
the a bility to define "column blocks" and work on a whole column at 
one time, so we have to do it line by line. Once again, if we want a ll the 
column headings cen tered over their values, we will have to use the 
Backspace key and space bar with care; backspacing, for example, 
will often remove the spacing of the tab as well. With some experi
ence, this wi ll become more intuitive, but never really easy. 

To remove a column, we must a lso work line by line. In thi s case, as 
in Figure 5-29, we are removing the Pippin column . We select the text 
we want to remove plus a ll the empty space up to the next tab marker, 
and dele te it with Cut or the Backspace key. This will remove every
thing in that tab position a nd bring the nex t column leftward. There is 
still a bit of work left re lative to centering the column headings in this 
example . 

Thus it is possible to create nice looking tables with MacWrite; 
certainly, you have powerful display abi lities with the use of va rying 
type fonts, s izes, a nd s tyles. But it wil l look even better, a nd be 
considerably eas ier if the columnar se tup is complex, to do it in 
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Mac Pippin -Del Golden Revenue = llllll 

Wanuary 42 37 18 20 $406.80 

February 67 46 32 22 $499.50 

March 85 60 56 37~696.50 

April 90 65 60 $795.90 Qj 

Figure 5-28. Adding a new column in the table. 
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Moe 

January 42 

February 67 

March 85 

April 90 

Del Golden 

18 20 

32 22 

-56 

65 60 

Revenue 

$406.80 

$499.50 

37$696.50 

$795.90 

Figure 5-29. Removing a column from the table. 

~ 
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MacPaint or another app lication and paste the results into your Mac
Write document. 

You now have both the general tools and specific MacWri te sk ills 
required to do extensive and sophisticated word processing. If Mac
Write is not the most powerful word processor around, it is nonethe
less quite satisfactory for a wide variety of purposes. Moreover, its 
ease of use plus its considerab le number of distinc tive ab il ities (such 
as type selection, easy c ut and paste, and movement of material from 
o ther applications) make it in fac t very powerful in its own r ight. As 
w ith any application, the more you use a nd explore it , the more you 
will be able to take advantage of its abilities, and the eas ier it will 
become. 

C hecklist for Chapter 5 

I . Clicking and then shifi-clicking permits easy selection of la rge blocks of 
tex t. This can a lso be done by dragging the pointer off the top or bottom 
of the screen. 

2. Double-clicking in front of or on any word or space selec ts the whole 
word or space. 

3. Afte r selecting a block of tex t, using the shift key while dragging permits 
partial deselecting. 

4. Superscript and subscript arc accessed fro m the Style me nu (or Com
man d-H a nd Command-L from the keyboard). Usc sma ll type to mini
mize clumsy line spacing. 

5. Undo and Redo in MacWrite specify the action that can be undone or 
redone. 

6. Find . .. from the Search menu permits finding a ny occurrencc(s) of 
a ny string in the document. 

7. Change ... from the Sea rch menu perm its finding and, if desired, a uto
ma tically replac ing any s trin g in the documen t. 

8. Se lecti ng Title Page from the Forma t menu results in the text of headers 
a nd footers not being printed on the first page of the documen t. 

9. Set Page# . .. in the Format menu permits starting the document with 
a page number othe r than one. 

10. Insert Page Break from the Format menu permits forc ing a page break 
anywhere one is desired. 

II . Rulers permit formatting of a ll the text beneath them , up to the next 
ruler or the end of the documen t. Changing any rul er se ll ing automati
ca lly reformats a ll text unde r its contro l. 

12. New rulers can be inserted at any point , an d they can be cut , copied , 
a nd pas ted. All rulers can be shown or hidden via S h01v Rulers and Hide 
Rulers in the Forma t menu; ei ther way, they remain act ive. 
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13. Practically, there is a maximum of s ix inches of horizonta l space avai l
ab le for each li ne of tex t. 

14. Lines can be left-justified , righ t-j us ti fied, left- a nd right-jus tified, or 
cen tered. 

15. Line spacing can be one, one a nd one-ha lf, or two; or it can be set to six 
lines per inch. 

16. Margins a re set by d ragging the black margin markers w here wanted on 
the ru lers inch scale. 

17. The paragraph indent marker permits au toma tic inde nting or ou tdenting 
of the firs t line of each paragraph , as defined by usc of the Return key. 

18. S ta ndard a nd decima l ta bs a rc dragged from the tab wells a nd p laced on 
the inch sca le of the ruler. 

19. Headers a nd footers have their own wi ndows, and can be up to one-third 
of a page in s ize. They work j us t like s ta nda rd MacWrite w indows, but 
a lso have specia l icons for da te, time, a nd page num ber. They can be 
shown or hidden by selecting the Display and Remove Headers/Footers 
cho ices in th e Format me nu; e ithe r way, th ey 1·emain part of the 
docu men t. 

20. Pictures or text from other app lications can be pasted into MacWrite 
documents. Click on a picture to c rea te a border fo r its m an ipula tion . 

2 1. Select Tall Adjusted from the w indow created fro m Page Setup on the 
File menu for more accurate printi ng of MacWritc documents tha t 
con ta in pic tures . 

22. S tandardized forms, such as le t terheads, can be created with fon ts, 
rulers, e tc., all established, a nd then saved. By us ing Duplicate or Save 
as ... , we have a prdorma tted form for fi lli ng in . 

23. Tabular material can be created in MacWri tc through the careful usc of 
r ulers a nd tabs. Complex tables shou ld be created in o ther applications 
a nd pasted in to MacWrite . 
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Introduction _____________ _ 

MacPaint is the Macintosh's creative drawing program. It is quite 
extraordinary in the world of personal computers in terms of its 
power and ease of use , comparable only to the more structured 
LisaDraw on Apple's Lisa computer. MacPaint's specialty is really free
form as opposed to structured drawings (Apple is releas ing MacDraw 
for the latter); however, with some experience and care, diagrams, 
flow charts, floor plans, and the like can be created. Moreover, it has 
some creative and artisti c faciliti es that clearly exceed those of 
LisaDraw. One of its larger drawbacks is its ability to only deal with 
slightly less than one-third of a page at a time, and a general clum
siness in extending any one element across more than that space. This 
can be done, however, by applying the techniques we will learn in this 
chapter. 

The program is extremely versatile, with what sometimes seems an 
infinite variety of tools. Whole books devoted exclusively to MacPaint 
will appear but its key elements can and will be covered in one 
chapter. However, regard less of how much you may read, MacPaint is 
really something that can be fully learned only by exploration and 
experimentation. Fortunately, as with everything else on the Macin
tosh, you can get in to it very easily, and learn its advanced operations 
over time, as they are needed. Moreover, they are a ll fun. 

In this chapter, we will cover a ll of MacPaint's basics. As with earlier 
chapters, we will learn a ll the menus, plus, in this case, the specific 
MacPaint tools. We wi ll also try to adhere to our established tutorial 
procedure, although this is a bit clumsier with MacPaint tha n with 
what we have covered in Chapters 1 through 5. Just try to duplicate 
what is described and demonstrated in the figures, but don't worry 
too much if your drawings are rather different. So long as you under
stand what is going on, you wi ll be well on your way to mastering 
MacPaint. 

Because MacPaint documents tend to be rather large, it is impor
tant to leave sufficient room on your disket tes. With a single-drive 
system, you wi ll want the System Folder (minus Imagewriter) a nd 
MacPaint on the di sk, but you should remove some fon ts to save space. 
A few of the more decorative fonts are useful with MacPaint , but on ly 
one of the more s tandard fonts (New York, Toronto, Geneva, Monaco) 
is usua lly necessary. Also, when you finish with a drawing, copy it to a 
backup disk; try to leave about 60K free on your working diskette. 
With dua l-drive systems, you can use your Syste m Disk in the internal 
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drive, loaded with every font if you wish. And in the external drive you 
can have a diskette with only MacPaint; this will leave a great deal of 
room for documents. 

U sing MacPaint ___________ _ 

Double-click on the MacPain t icon, a nd the application wi ll open, 
providing a screen like that of Figure 6-1. The menus are quite famil
iar, a lthough some of the choices under them are different from what 
we have seen before, and the Goodies menu is new. Also, the two boxes 
or bars along the left side and the one a long the bottom are unique to 
MacPaint. The blank drawing window, where we compose our draw
ing, is actually a window into a bit less than one-third of a printed 
page. Open the Goodies menu and select Show Page, which will pro
duce the window seen in Figure 6-2. The portion inside the dotted-line 
box represents what we are currently working with . We will often 
want to use Show Page so that we can drag that box horizontally or 
vertically, in order to ge t to other parts of the full page for our 
drawings. For now, just click on Cancel to return. 

r * File Edit Goodies Font FontSize St le 

o• 
o• 
oe 
C:?W 
a .. 

Figure 6-1. A MacPaint screen ready for drawing. 

., 
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untitled 
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i I 
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L ............................... .......................................... J 

Figure 6-2. The Show Page window from the Goodies menu, which 
permits moving other parts of the page into the drawing 
window. 

MacPaint Tools 

In Figure 6-3 we have exp loded the three tool boxes in order to label 
them more clear ly. We wi ll re fer to each as we go a long. To s tart, click 
on the hollow rectangle icon, then go to the upper left-hand corner of 
the screen (note that the pointer turns into a + s ign), press the mouse 
button , a nd drag down and to the ri ght for an inch or so , which wi ll 
produce a figure similar to that in the upper-left of Figure 6-4. Then 
select the filled oval icon, a nd go to the pattern ba r a nd click on any 
pattern other tha n black (no te that wha t you have cl icked on now fi lls 
the leftmost, larger box). Go, a lso, to the line-selec tion box, and click 
on the top, dotted line. Move to the window, to the right of the box you 
drew, and drag aga in to create a borderless fill ed oval sha pe , as in the 
upper right of Figure 6-4. 

Now select the hollow kidney-shaped icon, and a lso click on the 
middle line width in the line se lection box. Go below the rec tangle you 
drew (note that the + is thi cker, refl ec ting your cha nge in li ne thick-
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Drag to select irregulir ShipPs . 

Drag to movP documPnt in window. 

Fills an arPa with selt-ctt-d pattPrn . 
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line se lected produces no borders for shepes. 

Figure 6-3. The basic MacPaint tools. 

ness), and draw a freehand shape of some kind- make sure you con
nec t the lines to make a closed shape. Then se lect the ho llow polygon 
icon a nd an even thicker line width; draw a shape under your oval. 
This works a bit di fferently : every time you want to end one side of the 
polygon, you click the mouse button, then release it to continue; a lso, 
when through , double-cl ick to s top. (With fi lled freehand shapes, Mac
Pa int will help you by c losing the out line even if you don 't, but w ith 
the hollow ones you mus t make sure they a re c losed yourself.) When 
fini shed , you should have four shapes drawn, rough ly like those of 
Figure 6-4. 

Now select the paint can icon (a lso ca lled the "bucket"), and click on 
a d iffe rent pa ttern in the pattern ba r. No te, as you move onto the 
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Figure 6-4. Drawing hollow and filled shapes with varying line widths for 
borders. 

drawing window, that the pointer becomes a pa int can. Move the icon 
so tha t the dripping paint is ins ide the hollow recta ngle you origina lly 
drew, and click- any fully enclosed shape, including hollow text (or 
even thick black ch aracters), can be filled with any pat tern by the 
paint can. Fi ll the other two shapes you have drawn with di fferent 
patterns. If you don't like wh at you have done (or if you didn 't fu lly 
close the shape, in which case the paint will "spill over" onto the 
whole window!), remember the Undo selection from the Edit menu , 
which is ava ilable also under MacPaint. 

Select the hand icon (a lso ca lled the "grabber"), move the pointer to 
the drawing window (i t becomes a hand), and drag you r p icture down 
a bit-the whole thing moves together, but only to a limited degree in 
a 128K Macin tosh . You can move it more with a 5 12K Macintosh 
because of its expanded memory (the third version of MacPa in t is 
changed only in terms of permitting faster operation with the "Fat 
Mac")_ Then click on the text icon (the le tter A) and click an inser tion 
point in the top cen ter of the drawing window. Select a fon t and font 
s ize from the appropr iate menus , and from the Style menu select 
Align Middle. Then type in, "My First MacPa int Drawing." (When you 
enter text, even using the Return key, so long as you don't cl ick the 
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mouse button you can make new font and style selections , and the text 
will be automatically reformatted.) You should then have something 
looking genera lly like Figure 6-5 . 

• o untitled - - ----- -- - - - - -- -
------- - ---------- -

-- -
-- - --- --------

tty f'ust MacPa.tnt Dra.wi,nq 

Figure 6-5. The original drawing-titled and with shapes filled. 

Click on the selection box icon, position the pointer above and to the 
left of your oval shape, and drag so that the flashing line covers the 
whole shape. Now, when you move the pointer into the outlined shape, 
it changes from a + to an arrow; press and drag the whole shape to 
another position. Click anywhere else in the window to deselect. Then 
choose the lasso icon, and use it to draw a select ion "rope" around 
another of your shapes; the shape's outline flashes to show it is se
lected. Move it, a lso, somewhere else in the window. The two selection 
icons do the same thing, but the lasso is easier to use for irregularly 
shaped objects, and it selects only the object without any surrounding 
space. 

Now with the last shape still selected, do a Command-C for Copy 
and, when the disk stops whirring, a Command-V for Paste. You now 
have a copy of the'shape, and the copy is selected. You cannot predict 
where MacPaint wi ll put the copy, sometimes it may even b e right over 
the origina l-but you can drag it where you want it. Then select the 
pencil icon, and usc it to draw a free-hand shape or tex t in the drawing 
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w indow-it writes when the mouse button is depressed, a nd stops 
when it is re leased . The end resu lt will be a window like that of Figure 
6-6. 

untitled 

ny f irst :MacPa.tnt Drawtnq 

Figure 6-6. Drawing window with shapes moved and copied, and with a 
free-hand pencil addition. 

Let's leave th is part of the drawing as it is a nd work on ano ther part 
of the page. Go to the Goodies menu and select S how Page. Put the 
po in te r a nywhere on the page shown outside the box, and drag to 
pos ition your drawing at the top center of the page. Then pu t the 
pointer inside the box, and drag the box itself below your d rawing, as 
in Figure 6-7. The pointer, under Show Page, depending upon where 
you place it, can be used to move the who le drawing on the page o r to 
select wh ich part of the page will be avai la ble in the drawing window. 
(It can a lso be used to delete the whole drawing by dragging its image 
from the page to the desktop- don' t do tha t now, since that ac tion is 
no t Undo-ab le.) Then click on OK, a nd the draw ing window reap
pears, w ith ou r selec ted bla nk pa rt of the page showing. As you begin 
to do full-page d rawings, you will use S how Page frequently. 

Select the straight line icon (below the pa in tbrus h), a nd the thickest 
line width. Go into the drawing w indow a nd s ta rt to draw a line
note, as you move from stra ight to d iagona l, its edges arc rippled; that 
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Figure 6-7. Using Show Page to move the drawing and change what will 
be in the drawing window. 

is a function of the degree of resolution of the screen. Try it again, 
ho lding down the Shift key-this works as a constraint, forcing lines 
to be perfectly horizonta l or vertica l, even if your hand is not as steady 
as a brain surgeon's. You can eas ily do boxes or other closed shapes 
with the line icon, by releas ing and then again depress ing the mouse 
but ton at each corner, as in Figure 6-8. And if you do make a closed 
shape, you can then fill it with the paint can jus t as you do wi th 
predefined shapes. 

Now select the spraycan icon and any pattern you wish, and use it 
just li ke the penci l for free-hand drawing. It can use a ny patte rn, but 
its thickness is not adjustab le. Try, a lso, using the Eraser, for any part 
of your line or spray painting that you don't like. You can Undo each 
individua l erasure, but once you have re leased and aga in depressed 
the mouse button while erasing, you a re engaging in a new action so 
far as MacPaint is concerned. So make sure you a re happy with each 
erasure before you continue with it or select another icon. 

The paintbrush icon is one of the most versatile in MacPa int. Go 
back to the Show Page se lection and move the box to give us more 
room in the drawing window (if you have run ou t of room, you can 
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·-=------ untitled 

Figure 6-8. Using the straight line and spraycan tools, and correcting with 
the eraser. 

save or trash this documen t and open another one). Se lect the 
pain tbrush icon, and then draw a sha pe or some free-form text in th e 
drawing window. Note tha t it combines the powers of the penci l and 
the spraycan-we can draw a nything wi th i t, using any selected pat
tern . Now go to the Goodies menu and select Brush Shape, which 
provides the selection box we see in Figure 6-9. We can select a ny one 
of these shapes and sizes by simply clicking on it- the cur rent selec
tion is denoted by being surrou nded by a box. You click on the one 
a lready selected if you do not wish to change the shape. 

Select a few d ifferent brush shapes a nd patterns to get a feel for 
how they work, as in Figure 6- 10. The illustra ted box with three 
patterns in it was created by selecting a long vertica l brush shape and 
using the Shift key to const rain to perfectly horizontal as the lines 
were drawn. 

These are the basic MacPa int tools, a ll of which we have now 
• covered in an introduc tory fashion. Severa l of them have advanced 

features, which we will cover below. But even what we have a lready 
dealt with is quite powerful , and capa ble of various combinations and 
manipulations tha t permit a good deal more creativity tha n these few 
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Figure 6-9. The Brush Shape selection box from the Goodies menu. 
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Figure 6-1 0. Using the paintbrush with varying shapes and patterns. 

examples suggest. For now, print a copy of your document if you wish , 
and save it or trash it; then choose Close and then New from the File 
menu, to give us a blank page for a new MacPa int drawing. 
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MacPaint Menus 

Figures 6-1 1 and 6-12 duplicate the menus ava ilable when using 
MacPaint. Note, in Figure 6- 11 , that these three menus are virtually 
identical to what we have used before. The main new element is the 
Align section in the Style menu. When we have selected text (the A 
icon), the Align choice affec ts the way the tex t we type will re late to 
our insertion point-centered a round it, or left- or right-justified from 
it. In this figure, the title used Al ign Middle, whereas a ll other typing 
used Align Left. Since we a re using MacPa int, we do have some 
additional capabi lities from these menus, such as font s izes up to 72 
point , and the abi lity to fill thi ck text charac ters with the paint can, as 
was done in Figure 6-1 I . 

The File and Edit menus illustra ted in Figure 6- 12 a re essentia lly 
similar to those we have seen before, but do have some a dditions . The 
firs t five choices on the File menu are entire ly fami liar, as is the las t 
one. Revert , however, is new, and is best thought of as a large-scale 
Undo. If you have made more than one cha nge to a document, so that 
something you want to undo can no longer be undone or easily erased, 
you can select Revert, which produces the Dia log box illus trated in 
Figure 6-13-if you click OK (or hit Return), the current version of the 
document will be junked and replaced with the last vers ion saved. Be 
careful using Rever t, since everything since the last save w ill be 
irrevocab ly los t. However, if you develop the correct habit of saving 
often as you work, it is a good way to undo a number of unwan ted 
changes, pa rticularly ones that may have ruined your drawing . 

Printing from MacPaint is automatic, in that you do not have the 
paper size and page options available under MacWrite; it prints s ingle 
copies in a s tandard 8-by-10-inch size only. You can se lect Print Draft 
rather than Print Final from the File menu, which prints a fas ter, 
somewhat lower resolution copy, but s till reta ins a ll the fonts and 
pa tterns; the difference, in fact , is s li gh ~. Sometimes, with very dark 
drawings or a new ribbon, Print Draft w ill ac tua ll y be preferable. 

Print Catalog is a nice featu re. When selected, it sends to the printer 
a listing of a ll the MacPa int documents on the current disk, including 
minia tures of the ac tua l documents, as in Figure 6- 14. The miniatures 
are not entire ly clear, but are usually distinc t enough to remind you of 
jus t what tha t pic ture was a ll about. 

In the Edit menu, Clear works exactly the same as the Backspace 
key. Select any part of the drawing window with the selection box or 
lasso, and then choose Clear or use Backspace to delete it without 
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Figure 6-11. MacPaint menus for text manipulation. 
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Figure 6-12. The main MacPaint menus. 
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Figure 6-14. Using Print Catalog from the File menu of MacPaint. 

sending it to the Clipboard . The bo ttom six choices in the Edit menu 
deal with ma nipula tion of a ny pa rt of a d rawing we have selected , 
permitting us to cha nge their shading or o ri en tation , as no ted in 
Figure 6-12 . We will demonstrate the opera tion of each of them in the 
nex t section . 

The Goodies menu also con ta ins some of the more advanced aspects 
of MacPa int. We h ave a lready looked at Show Page and Brush Sha pe. 
Grid is a toggle, showing a check in front of it when on. It provides a n 
invis ible "magne ti c" grid in the drawing window, which forces a ll 
drawing a nd writing to adhere to its lines. It is useful for s tructured 
graphics when you want to line things up very carefully; most of the 
time, however, it is bes t left off. 

FatBits we will use in some de ta il below; it is a superb tool perm it
ting cus tomization a nd precise editing of everything we draw a nd 
write. Edit Pal/ern is iden tical to what we learned in Chapter 2 con
cerni ng customizing the desktop; it provides us w ith a Dia log box as 
in Figure 6-15, show ing the currently se lected pattern on the right a nd 
its magnified bit pattern on the left. By d ragging the pointer through 
the la tter, turning bits on and off, you can create customized patterns 
to use for filling your objects . Brush Mirrors will also be considered 
shortly; it permits doing symme trical drawings with the paintbrush . 
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Figure 6-15. The Edit Pattern Dialog box. 

Select Introduction from the Goodies menu, a nd you will see a 
screen that summarizes the basic tools we have been discussing. Then 
select Short Cuts, which provides a nother info rmation window il
lustrating keystrokes a nd double-clicks tha t e limina te the need to use 
the menus, thus saving some time . We will a lso deal with those in the 
Advanced section below. 

For now, we have dea lt with the immedia tely useful menu options as 
well as the basic tools, and this is a good time to explore a bit. Try to 
do a few drawings, using a ll the tools and a ll the menu choices you 
currently unders ta nd. Use Show Page to move the drawing window 
both horizonta lly and verti ca lly on the page so tha t you can draw on 
a ll of it. And when you feel reasonably comfortable with what we have 
covered so far, go on to the nex t section , where we will expand our 
control of MacPa int. 

Expanding MacPaint __________ _ 

Now that we have mas tered the basics of MacPa int, we can increase 
our drawing a bilities with some of its more powerful manipula ti ve 
tools. By us ing the selec tion box or lasso to select one or more objects, 
or a part of a s ingle object, and then applying these tools in a varie ty 
of ways, our control over drawings is considera bly increased, a nd the 
va rie ty of things we can do increases as well. 

Selecting and Manipulating Objects 

Make sure you have a new MacPa int w indow open, then selec t the 
pain tbrush and d raw a sha pe more or less li ke tha t on the left in 
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Figure 6-16-we want the arrow at one end di stinctly larger than that 
at the other. Then use either the se lection box or lasso to select the 
shape. Now select Clear a nd then Undo from the Edit menu, and then 
hit the Backspace key and then Undo from the Edit menu-either one 
entirely removes the se lec ted object, without sendin g it to the 
Clipboard . 

Now select Cut from the Edit menu or Command-X from the key
board. The object is removed from our document a nd sent to the 
Clipboard; even though there is no Show Clipboard selec tion in Mac
Paint , what we have Cut is there. Then select Paste or Command-V, 
and it re turns. As in other appl ications, this is how we can move 
things from one place to another, or from one application to a nother. 
Now choose Copy and then Paste, which creates a copy of our object. If 
you sti ll see only one, tha t is because MacPaint has put the copy right 
on top of the original-drag the selected object and the orig ina l will 
appear from beneath it. 

Deselect the copy by clicking anywhere else in the window, then 
select the Eraser and erase it completely. Then reseiect the original, 
make sure it is in the upper left of the window, and do a Command-C 

untitled 

, __________ .) 

Figure 6-16. An object Copied and then Pasted, being forced into a 
selected space. 
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to copy once again. Now move to the right a nd <.!raw a n empty 
selection box larger than the o rigina l object; then do a Paste-the copy 
appears in the selec tion box, filling it. By drawing a selec tion box we 
can predetermine both the location a nd the size of a copy of any 
object. This may distort the copy, however, so tha t for a n exact copy 
you may not wa nt to follow this procedure . You can enable the Grid 
from the Goodies menu to help in cons tructing the selection box more 
precisely. 

Now we want to look a t some of the ways the Edit menu permits us 
to change one or more objects . Get rid of the copy you jus t made , a nd 
then select the origina l object and copy it once more . Do a s imple 
Pas te and drag the new copy to the center of the w indow, leaving it 
selected. Select I nvert from the Edit menu a nd it becomes white-on
black; the whole area tha t had been selected is affec ted by this. Make 
another copy a nd select Trace Edges; look at what ha ppens a nd then 
select Trace Edges again-this turns solid lines in to outlines, a nd puts 
borders around a ll hollow ones. If you hold down the Shift key while 
selecting Trace Edges, a shadowed border is created. For Invert, it is 
better to use the lasso rather than the selection box, so tha t only the 
object itself is inverted. But for Trace Edges you mus t use the selec tion 
box and not the lasso. 

Original Object 
Inverted Copy Trace Edges Copy 

Copy with selected area filled. 

Figure 6-17. Using Invert, Trace Edges, and Fill from the Edit menu. 
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Now make one more copy, use the lasso to draw a se lection circle 
around the lower arrow only, and the n se lec t Fill [rom the Edit 
menu-this fill s a ny selec ted object with the current pattern , just like 
the paint can does. Unlike the paint can, however, this procedure 
covers the shape's border a lso, creat ing a borderless shape, like when 
the dotted line is selected for borders . The results of our actions so far 
appear in Figure 6- 17. 

Now select the origina l object once more and do a Command-C for a 
copy. Then select Show Page from the Goodies menu, put the poin ter 
inside the dotted- line box, and pull the box down to a clean part of the 
page. Click on OK, a nd when the drawing window reappears, do a 
Command-V to Paste. Drag the object to the upper-left, and do 
another copy with Command-V, then drag the new copy to the cen
ter of the drawing window. Make sure it is selected with a selection 
box rather than the lasso, as that is required for what fo llows. Select 
Flip Horizontal from the Edit menu, and the object is reversed in the 
horizontal plane; if you did a perfectly proportioned. drawing, you 
may not see any noticeable change. Then select Flip Vertical, a nd the 
reversal of the vertical plane wi ll be quite clear, as in Figure 6-18. 

untitled 

Original Object Flipped Horizontal Flipped Vertical 

Rotate 11 1 
Rotate 112 Rotate 113 Rotate '41 

Figure 6-18. Using Flip Horizontal, Flip Vertical, and Rotate from the Edit 
menu. 
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Ma ke a nother copy of the origina l objec t, a nd then selec t Rotate 
from the Ed it menu ; look a t what happens and se lec t Rotate three 
more times. As seen in Figure 6- 18, this moves a selected objec t or 
objec ts 90 degrees counter-c lockwise. 

Seeing how these tools work is only the beginning. They become 
truly powei-fu l when used w ith a group of objects or, sometimes even 
more, only part of an object. In Figure 6-3, for exam ple, a "snapshot " 
of a MacPaint screen was taken us ing Shift-Comma nd-3, as described 
in Chapter 3. Then indi vidua l parts of tha t documen t were selected 
a nd moved 0 1- dele ted in order to have the exploded view the figure 
provides. A more complex applica tion of thi s procedure was followed 
for Figure S-9, which presents the MacWrite ruler in a vertical plane . 
This requ ired ex tensive man ip ula t ion of the sna psho t window, select
ing parts of the ru ler and ro tating them ind ividua lly, and then reunit
ing the parts. Such ac tions are complica ted by the rela ti vely small 
a rea a drawing window provides; if you do a rota tion that forces part 
of an object outside the window, it will be lost. But with some care and 
experience, these tools in the Edit menu permit some effecti ve graph
ics capa bilities. 

Fat Bits 

Proba b ly the most powerfu l editing a nd manipu la ting tool in Mac
Pa in t is Fa/B its , which we can now explore. If you s till have a d rawing 
current, Save and Close it, a nd then selec t New once more to get a 
fresh page on which to work. Selec t the pa intbrush and draw, as in 
Figure 6- 19, a rough a pproximation of the a pple you see on the front of 
your Macintosh . Dependi ng on your a rtis tic ability, it may be better or 
worse than what you see in the figure, bu t that rea lly doesn't matter-

Figure 6-19. Original apple drawing, with copy to work on. 
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among o ther things, FatBits a llows those of us who are not innately 
arti sti c to improve our drawings. Then make a copy of the drawing, so 
you w ill a lways have the origina l a nd can s tart over if you mess up 
with your editing. 

Now we are ready to make modifications to our drawing. Drag a 
se lection box over the top of the copy, as in Figure 6-20, a nd then select 
FatBits from the Goodies menu, the result of which wil l be a window 
like Figure 6-21. Th is is a high ly magnified view of part of what we 
have selected-the actual part now being shown is indicated, regular 
s ized, in the li ttle window in the upper left-hand corner. If we rea li ze 
that each character the Macintosh shows on its screen, drawing or 
tex t, is ma de up of a grouping of bits or do ts, then the purpose of 
Fa tBits becomes intuitively clear: it permits us to turn on or off any 
individual dot on the screen. 
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Figure 6-20. Selecting a section of a drawing for manipulation under 
FatBits. 

When using FatBits, a ll the o ther MacPaint tools remain available. 
We can erase with the Eraser, drag select ion boxes, draw with any of 
the drawing tools, and so on-but, here, their actual bit pa tterns will 
be shown. The mos t useful too l, generally, is the pencil , because of its 
precis ion: if we click on a dot, it w ill be erased, a nd as we drag the 
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Figure 6-21. FatBits presenting as much of our selected section as it has 
room for. 

pencil al l other dots we cover will be erased . Conversely, if we click on 
a white area, its dot wi ll be turned on, and as we drag over other white 
a reas they will be turned on as well. 

In this drawing, we will use the hand icon to drag the very top of the 
s tem into the window. As we can see, in the top of Figure 6-22, it does 
not rea lly come to a nice point. So we can click on the pencil icon, a nd 
click two more rows of dots, the first with two dots a nd the second 
with 0:1e, as in the second part of Figure 6-22, the effec t of which is 
immediate ly seen in the little window a t the upper left. At any time, 
we can look a t the overa ll effect of our FatBits editing by jus t clicking 
in that little window, which changes the display back to the drawing 
window; when we reselect FatBits, we go back to just where we were. 

Now use the hand icon to drag down to the bitten-out part of the 
apple, and see if you can smooth it out a bit by adding and dele ting 
dots . You will never get a curve smoother than what the Macintosh's 
screen resolu tion permits, but this is much more precise than free
hand drawing in the drawing window. Go back and forth to the 
drawing window to see how the whole thing looks. Note that the 
smallet· the area you select while in the drawing w indow, the more 
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untitled 

untitled ---

Figure 6-22. The apple stem's point before and after adding three dots to 
make it sharper. 

precise you can be a bout which pa rt of it ap pears under FatBits. As in 
the drawing window, you can use the Shift key with the penci l, eraser, 
e tc ., under FatBits to cons tra in the ir action to a s traight horizonta l or 
vert ica l line. 

As illus tra ted in Figure 6-23, we have used the pencil to turn some 
dots on and off in the "bitten" part of the app le , a nd used the eraser to 
re move the whole ri ght "shoulder" of the app le , then redrew it within 
FatBi ts us ing the paint brush . We have a lso used the eraser to remove 
the part of the stem tha t extended down into the apple . And fina ll y, 
from w ithin FatBits we drew the dividing lines that permitted us to 
c reate with the pa int can the rather b izarre combination of patterns 
thi s apple shows. 

The point he re is not whe ther or not thi s right-hand a pple-or the 
one on your Macin tosh- rea lly looks better than the orig ina l, bu t , 
ra ther, to ge t a sense of how we can use FatBi ts to a ! ter or create on a 
very precise scale. As your drawings ge t more complex, with various 
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shapes and text superimposed over one another, or carri ed from one 
document to another, the ability to do such precise edit ing is ex
tremely useful. In Figure S-9, referred to above, when the MacWrite 
ruler was taken apart, rotated, and put back toge ther, small parts of 
each end of the ruler were los t. Using FatBits, it was possible to 
reconstruct a perfect match for the lost parts, even including ruler 
hash marks and parts of numbers, w ith one small excep tion (which 
you can search for when you have nothing better to do!). 

Figure 6-23. The original apple and the copy altered with FatBits. 

Brush Mirrors 

Quite different in scale and effect from FatBits, but a lso very power
fu l, is Brush Mirrors, a selection that permits the easy creat ion of 
complex symme trical shapes with the paintbrush. Go to the Goodies 
menu and select Brush Mirrors, that produces a Dialog box like that of 
Figure 6-24. By clicking on any one or more of the lines shown, you 
create a mirror or mirrors which wi ll duplica te whatever you draw 
with the paintbrush from one or more alterna t ive perspectives. You 
deselect any given m irror by clicking on its li ne, re turning it from 
thick to thin; and you turn off Brush Mirrors complete ly by cl icking in 
the None box. You can quickly tell if some Brus h Mirrors pattern is 
active by opening the Goodies menu-a check in front of Brush Mir
rors tell s you tha t it is on. 

For now, just click on the vertica l li ne, as in Figure 6-24; then cl ick 
OK to re turn to the drawing window, a nd selec t the paintbrush. You 
have the option of using any of the paintbrush's shapes and any 
pattern, but we w ill s tart s imply, with the defaul t shape a nd black. In 
Figure 6-25, we have simple examp les of the operat ion of Brush Mir-
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OK None 

Figure 6-24. The Brush Mirrors Dialog box. 

rors, with each labe led to show where the drawing s ta rted. Note that 
the closer you are to the center of the drawing w indow, the closer 
toge ther the elements created wil l be. 

Try a drawing somewhat like the firs t one in Figure 6-25; if it does 
not deve lop as you expec t, just erase or undo. Then go back to Brush 
Mirrors and select the horizontal line, leaving vertica l a lso selec ted . 
Try something like the second ill us trated pattern. For the third pat
tern , we have clicked the horizonta l a nd vertical lines to deselect those 
mirrors, and then cl icked on the two diagonal ones. And for the fina l 
design, we have turned on a ll four mirrors. Try numerous com b ina
tions to get a feel for how they work; and try s tarting further away 
from the center of the drawing wi ndow in order to sec its effect, as 
well. 

If any of your designs went off the end of the drawing window, the 
parts outside the window are lost. This is a weakness o f MacPaint , but 
a lso another place where FatBits can come in handy. You can usc 
Show Page to move the drawing w indow hori zonta lly or vert ica lly, 
and then usc FatBits to repair your drawing. Figure 6-26 only sugges ts 
some of the des ign poss ibilities, us ing varying brush s izes a nd pat
terns for drawing. The bottom one was slightly ed ited with FatBits 
and then the enclosed areas were fill ed us ing the pa int can. 
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~BEG~ I ~ 
VERTICAL 

~BEG~~ <l3 
VERT I CAL AND HORIZONTAL 

BOTH DIAGONALS 

ALL FOUR MIRRORS 

Figure 6-25. Drawing with the paintbrush with Brush Mirrors in effect. 
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Figure 6-26. Using Brush Mirrors with alternate Brush Sizes and Patterns. 

A dvanced MacPaint Facilities ___ ____ _ 

Advanced operat ions in MacPaint involve two fa irly d is tinc t capaci
t ies . The firs t consis ts of somewhat more sophis ticated a nd precise 
ways to alter things we have a lready drawn, whi le the second involves 
shortcuts for ge tting th ings done fas ter by avoiding hav ing to open 
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menus. Most of these actions are summarized, in one way or ano ther, 
in the Short Cuts information window available from the Goodies 
menu. In Figure 6-27, we have exploded that window to permit some
what greater labeling, and will be referring back to it as we go through 
this section. · 

IOptoon! [!:] Multiple Cople3 -- M1ko roputinq copios 

rn::t:::l Pellerned Line' & Border3 _ Usos curront Dlttorn for p1ttornod boroar in 
~ hollow sh-s. bordor~ss p1ttorn 111 flllod on.s . 
rn::=:l ~ Scroll Fet8 tl3 ---- Aulom•hc•l-., producos h.nd icon fOf" 
c::t=:.l scrollirnj thrOU<jt f•t8i1s 
f!:J ~ Enter or leeve FetBib-Onloj with poncil in dr•win9 window. 

f!:J [] C h8nge Font Size ~ 'movos to noxt font or sizo down tho 
~!shift! f)1 Ch&nge Font monu, ond < movos to rwxt font or s izo 
~ W up tho monu. 

S•m• u Undo from Edit monu S1mo •• C~.r from 
Edit monu. 

Uso t09othor for rop .. tinq cop1ts. 

With Commond, 90 up or 
down to noxt font s1zo . 
With Shft-Commond, 90 
up or down to MMt font . 

Double 
Cl tck 

Select Wtndow 

Show Pege 

Bru3h Sh&pe 

FetBtt' 

Ere'e W•ndow 

Double-clicking on any 
of these effects the 
listed action without 
having to take the usual 
steps for doing so . 

~~~ Edit Pettern 

Figure 6-27. The Short Cuts window, exploded for labeling. 

Constraining and Stretching 

Make sure you have a fresh drawing window ava ilable, and then 
create a drawing more or less like that in Figure 6-28. The stick figure 
can be crea ted a ny way you like (this one was done with the oval and 
line icons, ra ther tha n free-hand), but you should try to enter the text 



----------------------6 1 MacPaint 0 177 

exactly as you find it in the l'igure. Before going any fu r ther, d rag a 
selection box around the whole illustration-stick figu re a nd text
a nd then do a Command-C for copy. Then, using S how Page, move the 
box down twice, a nd do a Command-V each time, so that you have 
three sepa rate copies of the same drawing w indow at d ifferent par ts of 
the page. Once done, use Show Page to move back up to the top copy. 

This is some text entered in 
12 po1nt Geneve using Align 
Middle to keep it centered. I 
wi 11 use it to demonstrete 

constreining end stretching of text. 

Figure 6-28. Drawing and text to be used for Constraining and Stretching 
exercise. 

Now drag a selection box around the s tick figure. While depressing 
the Shift key, drag the s ti ck figure downward , then try to move it to 
the right or left at the same t ime. As we learned before, Sh ift is a 
cons traint- it will le t us use any tool only in a vertical or horizonta l 
(with some, a lso a 45-degree) p lane; indeed, we can' t even switch 
from verti cal to horizonta l withou t fi rst releasing the mouse button . 
With the recta ngula r and oval sh a pe icons, by the way, the Shift key 
constra in t permits them to produce only squares and circles, respec
ti vely. Undo your cha nge. 

Now, with the s tick figure still selected , ho ld the Comma nd key 
down while you d rag it downward and to the r ight. This is the Stretch 
con trol, permi tt ing us to cha nge the sh ape a nd proportions of our 
objects . Select Undo from the Edit menu to ge t the figure back as it 
was. Then selec t the block of tex t a nd do the same thing-holding 
down the Comma nd key, drag it down and to the right. It works a lso 
for tex t , bu t the d is tortion can be even more no ticeab le, as seen in 
Figure 6-29. Selec t Undo to get the tex t a lso back where it was. 

Resclect the s tick figu re, and this time hold down both the Shift and 
Comma nd keys whi le you d rag down a nd to the r ight. This cou ld be 
called constrained stretching, since it le ts us s tretch a se lection but 
ma inta ins the same proportions as the origi na l. The same applies to 
blocks of tex t (remember that to the Macin tosh there a rc no great 
differences between p ictures and letters), bu t, in order to main ta in 
proportion, thi s permits less la titude re lative to the space requ ired. 
Figu re 6-29 shows our s tick figure stretched w ith Shi ft-Command , and 
the tex t rearranged w ith Com mand a lone . 
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The stick figure \tlas stretched 
using both the Sh1ft end Command 
keys, while dragging, so that its 
proportions \tlere not changed. 

untitled 

Ubissaret~nmin 

12 ~mt Genna IBft'l; A' 
nD to teep 11 ceaterail 
wm l£e it to RHstrnte 

tE111iig Dn~ stmtc~l! ~ text 

The text above \tlas stretched 
by using the Commend key 

'w'hile dreggi ng it in its 
:relection box. 

Figure 6-29. A figure stretched with Shift-Command-drag, and some text 
stretched with Command-drag. 

By a judic ious use of s tre tching a nd constraining, a lone or together, 
and in combination with o ther MacPaint tools , one can achieve a good 
deal of orig ina l creativi ty. In Figure 6-30, for example, we have made 
use of the pic torial Cairo type font, printing characters in the sug
gested 18 point s ize, a nd a lso in 36 and 72 po int. And we have also 
used Shift-Command-drag to cha nge the size of the orig inal 18 point 
charac ters. Note a lso how solid characte rs (the big dinosaur) as wel l 
as hollow ones (the b ig locomotive) can be fill ed with the paint can. 
FatBits could be used on the larger figures to smooth out the ir con
tours, if des ired . 
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18 point l6 point 72 point 

18 point Stretched 

1-8 point 36 point 

72 point 

18 point Stretched 

Figure 6-30. Using the Cairo font, in various FontSizes and with Shift
Command-drag to stretch. 
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Advanced Copying 

We have already noted that copying, cu tting, a nd pas ti ng work the 
same in MacPa int as they do in other Macintosh applicat ions. One of 
the nice things available to us is the abili ty to create a d rawing in 
MacPaint , a nd cut or copy a ll or part of i t to the Clipboard or the 
Scrapbook. Then, it can be pas ted in to another part of the same 
drawing, a different drawing, or a MacWrite document. 

There are a lso some specia l copying capabi li ties associated wi th 
MacPaint , since the process is so useful in this app lication. Use Show 
Page to get to a no ther pa r t of your page, where you have the original 
figures, as in Figure 6-28. Select the s tick figu re a nd then , while 
holding down the Option key, drag downwards-we have an auto
matic copy, w ithou t hav ing to use the Edit menu or the Command-C/ 
Command-V processes. The n selec t the block of tex t and do the same 
thing, with the same effect, as in Figure 6-3 1. 

Now remove a ll the tex t a nd the copy of the s tick figure from the 
drawing window, so that a ll you have is a s ingle stick figure in the 
upper left part of the window. Use the lasso to draw a se lection rope 

untitled 

This is some text entered in 
12 point Geneva using Align 
Middle to keep it centered. I 
will use it to demonstrate 

constraining and stretching of text. 

·------------------------------1 
: This is some text entered in 1 

: 12 point Geneva using Align 
1 

: Middle to keep it centered. I 
: wi 11 use it to demonstrate 1 

: constroining ond stretching of text. : 
L-----------------------------! 

Figure 6-31 . Making copies with Option-drag in MacPaint. 
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around the stick figure. Then, while hold ing down both Option a nd 
Command, drag the stick figure, which will create a chain of repeating 
copies as on the left in Figure 6-32. 

The speed and smoothness you use while dragging wi ll affect the 
placement and overa ll appearance of the copies, and it requires a good 
deal of ex peri men tat ion to become good at it. The spaci ng of copies 
can be controlled, to some ex tent, by choosing varying line widths 
from the line-selection box; selecting a thicker line makes the copies 
stay further a part. The reason for using the lasso with the st ick figure 
is that, if you use a select ion box, the bla nk space in what you have 
selected wi ll a lso be copied and the repeating pattern will no t look as 
good . Since the lasso selects a n object only, and not its surrounding 
space, this problem is avoided. Shapes like the repeating filled boxes 
on the right in Figure 6-32 can be selected with a selec tion box, s ince it 
can be made to fit the object precisely. 

Figure 6-32. Using Option-Command-drag to create repeating copies. 

Saving Time 

The remaining items in Figure 6-27, and in the Short Cu ts inform a
tion window in the Goodies menu, rela te to us ing the keyboard or 
double-clicking to save time with various ed iti ng actions. The upper
left-hand key (- ' ),for example, does the same thing as Comma nd-Z or 
Undo from the Edit menu (except, of course, in tex t mode, when it 
actua lly prints its characters). The left and right arrow keys (upper- or 
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lower-case, it doesn't mat ter) can be used to a utomatically cha nge 
FontSize (with the Command key) or the Font itself (with Shift-Com
mand). Logically enough, the ( key switches to the next item up on the 
relevan t menu, a nd the) key to the next item down. 

You can double-click on the se lection box, to se lect the en t ire draw
ing window- for copying, de le ti ng, etc. And you can double-click on 
the Eraser to erase the enti re drawing window. Remember, a lso, that 
from Show Page you can delete the entire drawing by dragging i t off 
the page to the desktop. If you change your mind before leaving Show 
Page, put the pointer back on the page image a nd drag in the o ther 
direction to bring it b ack; once you leave Show Page, this action 
cannot be undone. 

Double-cl icking on the hand icon autom atically produces the Show 
Page window, and double-clicking on the pencil icon automatica lly 
selects FatBi ts, with the pencil selected as your tool; you can a lso 
double-click on the pencil again to re turn to the drawing window. 
When the pencil is selec ted whi le in the drawing w indow, holding 
down the Co mma nd key while cli cking the m ouse button a lso 
switches you to FatBits; a nd the same action in FatBi ts re turns you to 
the drawing window. When you a re working in Fa tBits with the penci l 
icon, holding down the Option key turns it in to the ha nd icon to let 
you move a different pa rt of the picture into the Fa tBits window; 
when you release the Option key, the penci l reappears. 

Double-clicking on the pa int brush icon takes you direct ly to the 
Brush Shape window, and double-clicking on any pattern se lects it 
and produces the window for cus tomizing tha t pa ttern . And if you 
hold down the Option key while d ragging a ny shape, it w ill have one 
of two effects: with a hollow sh ape, the border w ill be in the current 
pattern rather tha n black (providing the eas iest way to achieve this 
effec t); a nd a filled shape will be made borderless. This procedure can 
create patterned lines a lso. 

You shou ld try a ll of these ac tions to see how they work . They are 
easy enough to forget if no t used regularly, but jus t remem bering that 
they exis t can make your use of MacPa int eas ier a nd more powerful. 
That is why MacPa int provides the Short Cuts window from the 
Goodies menu- for a constantly ava ilable reminder of wh at these 
ac tions can do. 

We have now covered a ll of MacPa int-every tool and menu se lec
tion , and all of its specific faci lities . There rema ins a lo t more tha t can 
be done, however, with these tools and faci lities, as you will discover 
only by ex tensive use and experimenta tion. Particula rl y useful will be 
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the process of moving part or all of drawings to documents created 
with other applications, such as MacWrite . Whe ther your interest is in 
business-oriented designs and graphics , or just drawing for fun, Mac
Paint offers extraordina ry poss ibilities which a re there for your . 
exploration . 

Checklist for Chapter 6 

I. The drawing window is where we draw; it can present almost one-third 
of a printed page a t one time. 

2. Show Page le ts us choose what part of the page will appear in the 
drawing window, and move the whole drawing on the page. 

3. The three tool boxes to the left and below the drawing window provide 
MacPai nt 's basic tools. 

4 . Hollow shapes use wha teve r line thi ckness has been se lec ted ; filled 
shapes use the selected line thickn ess and the selected pa ttern for filling. 

5. The kidney and polygon shapes permit freehand shaping; MacPa int will 
automatically close the filled ones, but not the hollow ones . 

6. The paint can will fi ll any enclosed sha pe , including thi ck tex t charac
ters, with the selected pa tte rn . 

7. The h and icon can move everything in the window, but only to a limited 
dis ta nce. 

8. The selection box and lasso a re d ragged to select any part of the window 
for further ac tion . 

9. The pencil icon is for precise free-hand drawing. 
10. The straighrline icon can usc a ny line width . 
1 I . The spraycan w ill spray th e se lected pattern , but its w idth is no t 

adjusta ble . 
12. The paintbrush has many ava ilable shapes, selected fro m Brush Shape in 

the Goodies menu, and can use any selec ted pa ttern . lt can a lso provide 
symmetrical drawings through selection of Brush Mirrors fro m the 
Goodies menu. 

13. The Align choice from the Style menu affects justification of tex t rela tive 
to the insertion point. 

14. Rever! , from the File menu, replaces the current document with its most 
recently saved version. 

15. Print Draft provides s li ghtly faster and s lightly lower resolution draw
ings than Print Final. 

16. Print Catalog prints the na me and a miniatut-e representa tion of all 
MacPa int documents on the current disk. 

17. Clear is equivalent to Backspace: it deletes the se lected ma teria l without 
sending it to the Clipboard. 

18. Grid is a toggle , providing a n invisible "magneti c" grid that forces 
pic tures and text a long its lines. 
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19. FatBits provides a highly magnifi ed view of a ny selected material, per
mitting bit-by-bit editing thereof. All standard tools can be used in 
FatBi ts. 

20. Edit Pal/ern provides a highly magnified view of a ny selected pa ttern , 
permitting bit-by-bit editing thereof. 

21. The Eraser can be used to erase anyth ing in the draw ing window. 
22. Trace Edges, from the Edit menu , turns solid shapes into ou tli nes and 

puts borders around hollow shapes. Shift-Trace Edges creates shadowed 
borders. 

23. Flip Horizontal, Flip Vertical, and Rotate, from the Edit menu, permit 
cha nging the orientation of the selected object(s). 

24. Selected objects can be constrained and stretched by using the Shift or 
Shift-Command keys while dragging. They can be automatically copied 
by using the Option key while draggi ng. Chained multiple copies arc 
created by using the Option and Command keys wh ile dragging. 

25. The Short Cuts window, availab le from the Goodies menu, summarizes 
numerous shortcut keystrokes that can be used with MacPa in t. 

26. Holding down the Option key wh ile dragging a line or border, draws it 
in the currently selected pa ttern rathe r than b lack. 
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introduction 

Many Macintosh buyers will not be interes ted in lea rning to write 
computer programs. They are buying the computer for what it can do 
with programs written by others. Indeed, the long-term success of the 
Macintosh wi ll be de termined, more than anything else, by the quan
tity and quality of the software written to operate on it. 

There is certainly no great need for most computer users to lea rn to 
program. For al l but the simplest tasks, programming is demanding 
a nd time-consuming, both to learn and to imp lemen t. And, on the 
whole, profess ionals are better at it than amateurs. Certainly, sophis ti
cated programs like the word processors, spreadsheets, and graphics 
programs that mos t Mac intosh owners want to use are well beyond 
the capacities of a ll but the most accomplished programmer. 

Some Macintosh buyers w ill be very interested in programming, 
however, not leas t the university students who a re buying the com
puter in large numbers, and may well be required to progra m. More
over, there are some benefits for any computer user in learning a bit 
about programming if he or she has the time. It increases one's general 
sense of understanding the machine and feeling the master of it, s ince 
much of the mys tery of computing disappears. It is not really terribly 
difficult to learn, g iven a modes t expenditure of concentrated time. It 
can even be fun , to a certain degree, s ince progra mming uses the same 
kind of logical and puzzle-solving activities that ma ny people find 
agreeable elsewhere. 

More prac ticall y, some mastery of programming can be useful for 
a ny computer owner- less for gra nd designs than for quite simple 
ones. Often, you may wa nt some simple things done that your sophis ti 
cated software docs not bother with. A program of one or two dozen 
lines can fi ll tha t gap nicely. This can a lso save cons iderable money, 
when the a lternati ve is buying a nother expens ive progra m , only part 
of whose power you rea ll y need . 

For example, spreadsheets a nd , parti cula r ly, accounting programs, 
a re often ra ther weak on s tatis tics, because s tatis tics are little needed 
in the business applications for which those programs were written . 
Data base manageme nt sys tems are powerful for manipula ting large 
bodies of da ta, but are often too clumsy or complex for sma ll , spe
cialized bodies of information you want controlled in a specific way. 
Both of these are areas where a lit tle programm ing knowledge can 
come in handy for any computer user. 
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BASIC _____________ _ 

If you do decide to give programming a try, you will soon encounter 
an interesting phenomenon in the world of computing-people tend 
to identify wi th one or a nother computer language with the intens ity 
of relig ious fanatics. This is amusing, but, for newcomers, frustrating 
as well. You certainly don't want to put in a lot of time and effor t 
learning a la nguage that won't be suitable for what you may later 
want to do but are not currently able to predic t. 

You wi ll not have to go far to fin d people who assure you that Pascal 
is the only language for beginners to learn, that its "structured " 
format makes it the mos t powerful of the "easy" languages. And you 
need go only a bit further to find advice that C is the "most transporta 
ble," that Logo is " recursive," tha t Ada or Forth or Modula-2 is " the 
la nguage of the fu ture ," a nd so on. Certainly, you can very easily 
encounter arguments aga inst learning BASIC, because it is "not struc
tured ," "not s tandardized," "too slow," and so on, a ll of which is, to a 
degree, true. 

But it is a lso true that BASIC is the universal la nguage of microcom
puters, used everywhere. BASIC is a lso, without doubt, the easiest 
broadly usefu l programming la nguage to learn , particularly for peo
ple who remain amateur a nd occasional programmers . It is probably 
the only programming language tha t "ordinary" computer users can 
rea lly teach themselves from a book. And there is little that cannot be 
done with BASIC-some quite sophis ticated accounting programs 
and data base ma nagers, for example, have been written in that 
la nguage. It remains at present the best language for newcomers to 
s ta rt out with, and, probably, for mos t people to s tay with over the 
long term. 

Moreover, two vers ions of BASIC have a lready appeared for the 
Macintosh, one issued by Apple Computer and the other by Microsoft, 
Inc. (Apple is a lso releasing a version of Pascal for the Macintosh , and 
other la nguages are already coming as well.) So in thi s chapter we 
wi ll look into these BASICs, and their general characteristics. 

This is not the place to teach BASIC progra mming, and no effort to 
do that will be made here. Books on BASIC for the Macintosh are 
a lready appearing. Rather, we will look in to these two BASICs to 
define their general characters, and the ways in which they integrate 
into the Macintosh system. Our inten tion is to provide nonprogram
mers with a "feel" for the languages on the Macintosh-how they look 
and, generally, how they operate. And for programmers, we hope to 
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suggest the ways in which each of these BASICs is similar to or 
different from what they have used elsewhere. 

Given that we are not teaching BASIC here, and that most readers 
probably haven 't bought BASIC for their Macintosh yet, this appendix 
wi ll not follow a tutorial format. Our focus will be on description, but 
those who do have BASIC can work along a nd try to duplicate the 
screens illustrated . 

Microsoft BASIC 

The main advantage of Microsoft BASIC (also called MS-BASIC on 
the Macintosh) is that it is as close to being an industry standard as 
anything in the world of microcomputers. Most 8-bit computers oper
ating under the CP/M operating system, for example, use Microsoft 
BASIC. The BASICs on the Apple II and Radio Shack computers are, if 
slightly different, s till by Microsoft and generally the same. This is 
true, also, of the BASICs that come with the popular current 16-bit 
computers, such as the IBM PC and its many "compatibles" that use 
the MS DOS operating system. 

Thus, with MS-BASIC on the Macintosh, you can expect that BASIC 
programs written on most other microcomputers will run without 
requiring extensive changes; similarly, programs you write on the 
Macintosh will run equa ll y easi ly on other computers. Moreover, if 
you have already used Microsoft BASIC on another computer, you will 
find yourself switching to the Macintosh version with almost no time 
needed for learning. Also, because Microsoft BASIC is so widely used, 
it is easy to get help with your own programming. Mos t microcom
puter BASIC teaching guides and reference manuals use it as their 
model, and most professional or amateur programmers you may turn 
to for help will be familiar with it as well. 

One important qualification, however, is that with implementations 
of BASIC, even among those written by Microsoft, there are a lways 
some differences. The number of statements ("commands'') tends to 
vary from one implementation to another. And there are often dif
ferences based on individua l computer hardware characteristics (for 
the Macintosh, not surprisingly, BASIC is expanded with some com
mands to take specific advantage of its graphics and mouse). Thus, 
some conversion from one computer's Microsoft BASIC to that of 
another computer is generally required. Overall , however, the greater 
part of programming, and certainly all the most frequently used 
statements, will be consistent with what is found on other computers. 
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MS-BASIC is a n interpre ted language. If tha t does no t mean a lot to 
you, you needn ' t worry about it. But an interpreter, as opposed to a. 
compiler, executes each line of progra mming individua lly, in series, 
ra ther tha n first turning the whole program into the binary codes tha t 
the compute r understa nds . From the user 's s ta ndpoint, this ma kes 
BASIC progra mming easier to write a nd test. La rge programs do run 
considerably slower when they a re in terpreted, but for most Macin
tosh users tha t is not really a problem . Newcomers to computing are 
generally better off with interpreted BASIC, and many experienced 
progra mmers continue to use it for every thing they do. Because of the 
Macintosh$ powerfu l 16/32-bit m icroprocessor , the interpreted MS
BASIC runs quite fast-apprecia bly fas ter on the Macintosh than , for 
example, on the IBM PC. 

MS-BAS/C on the Macintosh 

The main dis tinc tiveness of Microsoft$ Macintosh version, apart 
from some added graphics and mouse commands, is its integra tion in 
the general Mac in tosh e nvironment- using the mouse, pull-down 
menus, windows, e tc. This integration is no t as full -scale as it should 
be, a nd some of the facilities you have found in such applications as 
MacWrite and MacPa in t a re not present. But you s till have the Apple 
menu, windows, the desktop, some a bility to cu t a nd pas te, and a 
general environment tha t, to the Macintosh user, will seem famili a r. 
Moving data be tween MS-BASIC a nd other applications is no t really 
easy, a lthough Microsoft does prov ide information for doing it with its 
own MultiPla n spreadsheet progra m , and has turned the Clipboard 
into a device (compa rable to the disk , screen, or a printer) which a 
program can write informa tion to or read from . 

Generally, Microsoft h as retained traditiona l BASIC syntax, while 
adding the Macintosh way of doing things as an a lternati ve. Thus you 
can select RUN from a menu, or type it in as would be the case on 
o ther computers , and you can type the traditiona l SYSTEM command 
as well as choosing Qui t from the File menu . 

The Microsoft manual , like mos t of those tha t come with BASICs, is 
not really a teaching tool. If programming is new to you , you should 
look for a teaching book that uses Microsoft BASIC as its focus . The 
manual conta ins an introductory sec tion of a bout 45 pages tha t really 
focuses on th e program's use w ithin the Macintosh environment, in
troduci ng a few specia l Macintosh commands and describing a few of 
the bas ic func tions this version of the language provides. This is 
followed by a 140-page Reference Ma nua l, where each individual 
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statement and [unction is described, with minimal examples. There 
are a lso eight appendices, some of genera l interes t a nd some useful 
only to skilled programmers. 

Using MS-BASIC 

A startup disk conta ining MS-BASIC w ill produce a window looking 
like that of Figure A- I. The a pplication icon is the one labeled MS
BASIC; the other icons with ha nd pointers a rc ac tual BASIC progra ms 
supplied as exa mples by Microsoft. To s ta rt a new program or jus t get 
BASIC up and loaded, you Open the MS-BASIC icon . If you want to 
directly run a progra m that a lready exists, you Open it. The menus a t 
the top of the screen are the s ta ndard Macintosh ones, and no t specific 
to this application. 

MS BASIC 
8itHas 2051( in dislc 

LJ ; Q Q Q 
Systtm Folder MS-BASIC Draw PICTURE.BAS Bridge 

Q Q LJ 
Mlj Programs Tt>rm1na1 Fig. 7.7 

~I 10 '2l 
Figure A-1. The desktop under MS-BASIC. 

When we open MS-BASIC, we immedia tely see, a s in Figure A-2, two 
of the a pplication's three s ta ndard windows . Either one can be the 
a ctive window and, as elsewhere in the Macintosh , the windows can 
b e resized and moved, a lthough these two cannot be scrolled through . 
The Command window is [or entering program s ta tements; most 
menu choices can also be typed into the Command window, if desired . 
The la rger Output window shows the results of wha t we do-in this 
case , the lines o[ programming, which a re transferred to it each time 
the Re turn key is pressed. In the figure, line ISO has just been typed, 
but the Re turn key h as not yet been p ressed. The Output window is 
also the place where the results of progra m execution will be seen . We 



- -------- ---------A I BASIC Programming 0 193 

cannot do anything with the Output window, other than resize it; MS
BASIC uses it to communicate with us . 

r • fife Edit Control 

Untitled 
100 REM Demo progrom to illustrote MS-BASIC's windowing. 
110 print "This progrom will count up to 10." 
120 for x = 1 to 1 0 
130 print x 
140 next 

Command 
150 end 

IJ 

Figure A-2. The Command and Output Windows of MS-BASIC. 

When we type "run" or select it from the Control menu, the program 
execu tes and its resul ts appear in the Output w indow, as in Figure A-3. 
One of the truly nice features of MS-BASIC consists of the Lis t w in
dows it offers us, as in Figure A-4. The List window shows us our 
program as we have entered it; we can change its size and a lso sc1·oll 
vertically or horizontally through it, to qu ickly see whatever section of 
a program we want. Moreover, we can have up to three List windows 
on the desktop, permitting us to look at different parts of the program 
simultaneously. This is a great improvement over other computers' 
implementations of BASIC. 

In Figure A-5, we have a rather busy desktop, which illus trates these 
capabilities. The Output window shows the execution of a program 
provided by Microsoft. ("Break in ISO" indicates that the program has 
been stopped .) We h ave opened three Lis t w indows, each showing a 
different part of the progra m. And we have selec ted one of those 
windows, and then one programming line therein by clicking on it. 
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Untitled 

his program will count up to 
1 
2 
3 
4 
5 
6 
7 
8 
9 
10 

Figure A-3. The Output window showing the results of a RUN command. 

List 
100 REM Demo program to 111ustrate MS-BASIC's 
110 PRINT 'This program w111 count up to 10." 
120FORX= 1 TO 10 
130 PRINT X 
140 NEXT 
150 END 

Figure A-4. A List window. 
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This sends it automatica lly to the Command window. Now we have 
selec ted part of tha t li ne of programming with the pointer, and are 
prepared to change, cu t , or copy it. These arc the faci lities that make 
MS- BASIC rela tively pleasant to use on the Macintosh. The abili ty to 
have one or more List windows available at the same time a progra m 
is 1·unning, to scroll eas ily through them , and to quickly edit by 
moving lines to the Command window, makes writing a nd cor recting 
programming easy. It would be more effi cient, however, if we could 
edit in the List window itself, saving the extra s tep of copying the line 
firs t. Moreover, we have no ab ility to make cha nges in more than one 
line at a time, something that is genera lly easy to do in the Macin tosh 
envi ronment. 

r a File Edit Control 

100 DEFINT A-Z 
110 DIM A(1025) 
120 GOSUB 220 
130 GET(O,O)-( 127, 127),A 

ASPECT' = .1 
WHILE ASPECT'<20 

C IRCLE(60 ,60) ,50 ,30 ,,ASPECT' 
ASPECT'= ASPECT'* 1.4 

Figure A-5. The desktop with three List windows showing, and a line of 
programming moved from a List window to the Command 
window for editing. 

MS-BASIC Menus 

., 

In Figure A-6 we see the four menus ava ilable from within MS
BASIC. The Apple menu is the same as under o ther applica tions; here 
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is one place where the presence of a ca lculator can come in ha ndy. The 
File menu is also quite s ta ndard , although the Close choice will never 
be in black, s ince it is not implemented in MS- BASIC (at leas t in the 
firs t released version). As no ted in Figure A-6, Microsoft h as skimped 
on the implementation of Open . . . , in tha t this does not produce a 
li s ting of the progra ms availa ble on the di sk. Rather, you mus t firs t 
use the s tandard BASIC "FILES" command to see what is ava ilab le, 
a nd then , under Open, type in the na me of the program you wa nt. 

Unfortunately, the use of Cut, Copy, a nd Pas te from the Edit menu is 
quite limited under MS-BASIC. You can Cut or Copy selec ted tex t 
from the Command window to the Clipboard, and you can Pas te from 
the Clipboard to the Comma nd window. But the Comma nd window 
can hold only one line of progra mming a t a time; thi s has some va lue 
in editing the programs you are writing, bu t is no t very powerful. The 
editing power provided is greater than is common wi th BASIC on 
o the r computers, but it ac tua lly takes little a dva ntage of the 
Macintosh. 

The Control menu is distinct to MS-BASIC, a nd includes the ma in 
commands one usually issues to BASIC progra ms. All of the com
mands can a lso be entered from the keyboard , e ither with the Com
mand key (which works, under MS-BASIC, like the CONTROL key on 
other computers) or by typing in the command, or both . Run executes 
the program . It wi ll s top automatically when it is done, or can be 
s topped at a ny point by selecting Stop (the s tandard Con trol-C), which 
wil l halt execution a nd indicate the line number be ing executed when 
interrupted . You can then go on to o ther things, or resta rt execution 
with Continue ("cont" from the keyboard). 

The Suspend choice from the Control menu is equivalent to Contro l
S in other BASICs. It tempora rily suspends program execution un t il 
any other key is pressed. Unlike other BASICs, Suspend is not used to 
halt program lis tings, since you scroll through Lis t windows with the 
s tandard Macintosh scrolling controls . The Trace On a nd Off com
mands are a lso common to most BASICs a nd of use in debugging 
programs. When Trace is on , each line number will be pr inted to the 
Output window while the progra m executes, to permit seeing what 
line was executing if a n error occurs. 



------- ---------- -A I BASIC Programming 0 197 

Stenderd Apple menu, with About 

New 
Open ... 
Close 
Saue 
SaueRs ... 
Quit 

Cut =r 
Copy 
Paste 

Stop 38( 
Continue 
Suspend 38S 

Microsoft BASIC window. 

Works the seme es with other 
Macintosh epplicettons, except that, 
w1th Open ... 1t does not give e listing 
of ell files on the disk--you must 
know neme of program you want. 

Works es in other Macintosh applications, 
but only for limited purposes, suches 
from List window to Commend window. 
Will not transfer to other eoolicetions. 

Same as Con1rol-C in other BASICS. Halts program 
execut1on. 
Same as CONT in other BASICS; continues 
program execution after Stop. 

Same as Control-S. Temporarily suspends 
program execution; any key restarts . 

List --- ---If---- Or type "list"-opens List 'w'indo'w' into program. 

Run ------If---- Or type "run"-execu1es the program. 
Truce On 
Trace Off ~----'~ 

Turn on to see each line number listed as 
program execu1e~·for debugging purposes. 

Figure A-6. MS-BASIC menus. 

MS-BAS/C Features 

There are a few additional features of MS-BASIC that arc worth 
mentioning to further cla rify its dis tinc ti veness on the Macintosh. 
For one thing, MS-BASIC docs away with many of the constraints 
found in other BASICs, which are rea lly imposed by the opera ting 
systems under which they are working. For example, fil enames can 
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be up to 255 characters long; extensions to the names are en tire ly 
optional. Only alphanumeric characters are permitted, according to 
the manual , but we have used others w ithout d iffi culty. Variable 
names can be up to forty characters long, a ll of which arc sign ificant. 
And strings or s tring variables can be very large indeed-up to 32,767 
characters. 

Instead of the usual disk drive designators (A :, B:, etc.), MS-BASIC 
uses the Macintosh convention of addressing volumes, which corre
spond to the names you give disks when they are initia lized. If, for 
example, the disk in the ex ternal drive is named MY PROGRAMS, you 
load the progra m "picture" from that disk via Open from the File 
menu by calling it: "MY PROGRAMS:pictu rc." As noted, MS-BASIC 
does not provide you with a catalog of fi lenames when you choose 
Open. More important, it a lso fai ls to offer the EJECT opt ion to 
permit loading a fil e from or stori ng it to a disk not currently in the 
drive(s). This is a very serious omission, and is par ticu larly frustrating 
for owners of single-drive systems. 

You have to be careful with output to the screen under MS- BASIC, 
because any lines created by program execution that ex tend beyond 
the borders of the Output window are lost. There is a WIDTH com
mand, which can specify the working width of the screen, clipboard, 
and printer and communications ports; it is importa nt to use it to 
control printing to the screen. Genera lly, wilh maximum screen width 
for the output window, you can have a bout 60 charac ters printed in 
one line, rather than the industry standard of eighty. Since MS-BASIC 
does not support any a lterna tive type fonts, this cannot be changed, 
another unnecessary irr itation. 

There are a number of usefu l functions in MS-BASIC for support of 
Macintosh graphics and the mouse. Figure A-7 demonstrates a simple 
example, showing both the content of the program and its output. 
Line 100 is just a remark, a nd line 110 clears the screen. Line 120 uses 
the CIRCLE function to draw a circle; we need only specify the hori
zontal and vertical coord inates, a nd the diameter, a ll in terms of 
pixels. Additiona l refining commands a re also available. Line 130 uses 
LINE for a s traight line, specifying s tarting a nd ending coordinates. 
And line 140 uses LINE to draw a box: the line coordinates become the 
opposite corners, "B" te lls MS-BASIC to draw the box, a nd "F" tells it 
to fill the box; 33 specifies using black as the color. 

You can always specify black or white for any drawing action. And 
MS-BASIC has special commands (POINT and PSET) for address ing 
each pixel on the screen. Thus it is possible, working pixe l by pixe l, to 



------------------A I BASIC Programming 0 199 

create variegated patterns, such as those in MacPaint, but MS-BASIC 
has no automatic fu nctions fo r doing this. 

There a re special functions for reading mouse button s tatus a nd the 
current horizontal a nd vertica l positions of the mouse, as well as the 
s tar t ing a nd ending horizontal a nd vertical positions of mouse move
ment. This means the programmer ca n easily use the mouse as a 
dynamic device, and incorporate mouse movements in to his or her 
programs . 

MS-BRS I C Demonstration 

List 
100 REM Demo module to drew circle, 
119 CLS 
120 CIRCLE (320, 120), 50 
130 LINE (320,60)-(320, 1 BO) 
140 LINE (300, 1 00)-(340, 145),33,BF 

Commend 

Only one line of programming needed for each of the three shapes. 

Figure A-7. Drawing three shapes with MS-BASIC. 

ll 

Beyond these fea tures , one has all the s tandard character istics of 
Microsoft BASIC, which is certainly a good a nd well-proven imple
men ta tion of that la ngua ge. The Macin tosh version, however, is gener
a lly somewhat less powerful, in ter ms of number of statements , than 
the Microsoft BASICs on the IBM PC and compatibles. However, users 
who have done some progra mming on other computers will find it 
easy to continue their work ha bits with MS-BASIC on the Macintosh , 
which is probably i ts s trongest recommendation. Moreover, Microsoft 
should have released Version 2.0 of MS-BASIC for the Macintosh by 
the end of 1984, a nd it is supposed to correct a nu mber of th e deficien
cies no ted above. 
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Macintosh BASIC 
Movi ng from Microsoft's BASIC to Apple Computer 's Macintosh 

BASIC is, in ma ny respects, like movi ng from an earl y Apple II com
puter up to the Mac in tosh. It is a truly in novati ve and powerfu l 
implementa tion of BASIC, and one tha t takes fu ll advantage of the 
Macintosh's ma ny fea tures by integra ting fu lly into it. '.' Experienced 
progra mmers, and certa inly those who want to wri te profess iona l 
Macintosh app lications programs, w ill be deligh ted with its powers . 
And newcomers to progr;:1m mi ng, a lthough they may need a bit more 
time to get goi ng, w ill never be bothered with some of the cons tra ints 
common to mos t other versions of the la nguage. 

Some of Macintosh BASIC's key cha rac ter is tics mer it mention a t the 
outse t. Firs t o f a ll , it is no t a n in terpre ted BASIC, bu t , ra ther, a 
semicompiled one . That is, as each line of programming is entered , it is 
eva lua ted for correc tness a nd then compiled into what Apple ca lls "B
code." Then, when the whole program has been wri t ten, only a very 
br ief a dditional check of its s tructure is done before running . It is the 
B-code that is executed, rathe r tha n the source code typed by the user, 
wh ich makes for much faste r operation tha n is nor mal with in te r
pre ted BASICs. It is a lso qu ite "compact," requ iring less me mory a nd 
d isk space than source code . 

You lose re la tively little of the interact ivity of an in terpre ted BASIC 
in this imple menta tion, since each li ne is checked when writ ten, a nd 
a lso beca use of Mac in tosh BASIC's ex traordina ry debugging and edi t
ing facilities . And the increase in speed of execution is re marka ble : 
close to truly compiled code without the long wa it usua lly req uired 
for the process of compi ling. In a number of s tandard compara ti ve 
tests , for example, Macintosh BASIC executed programs much fas ter 
tha n MS-BASIC, a nd anywhere from 30 to 60 percent fas ter, or more, 
than the interpre ted BASIC on the IBM PC. 

Macintosh BASIC is a lso, to a certa in degree, multi-tasking-able Lo 
do severa l thi ngs at one time. It can run more th an one program a t a 
ti me, and has unusua lly effec ti ve capabi lities for one progra m to run 
inside a no ther or to ca ll other programs a t a ny poin t, passing a ll k inds 

1'Th is is the only p lace in th is book where software not yet com mercia lly available is 
being discussed. This sec t ion is based o n the "Alpha" pre-release vers ion of Macintosh 
BASIC, supplied for rev iew by Apple Computer. As such, Appl e makes no representa
t ions rela tive to this software, a nd it is possible that the fi nal vers ion of the software 
wi ll be not be ident ical to w hat is described here. 
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of information be tween themselves. It is a lso closer to being a s truc
tured la nguage than o the r BASICs . Macintosh BASIC includes a 
number of procedures and s truc tures tha t permit a more s truc tured 
a pproach to programming, and m ay sati sfy some of the criticisms 
generally applied to the la nguage by its critics. 

Macintosh BASIC a lso does away with line numbers. Yo u can 
number your lines, if you wish, but the numbers will just be consid
ered labels, and could as ea sily be replaced by wurus. Any line refer
enced by ano ther line in the progra m does need a la bel, but that need 
no t be a number. Consequently, Macintosh BASIC will no t reorder 
progra ms according to their numbers as inte rpreted BASICs do . You 
have to put things precisely where you wa nt them . The use of labels 
rather tha n numbers, and the removal of li ne numbers as a requi re
ment, does make progra mming much more powerful and , once you 
are used to it , easier. 

Mos t no tab ly, Macin tosh BASIC is full y in tegra ted into the Macin
tosh system . Unl ike MS-BASIC, this is unqua li fied . You can , for exam
ple, use a lterna te type fonts, ex tensive filing a nd editing se lections, 
and easy cutti ng or copying and pasting; a nd you can eas ily move 
disks in to and out of the system. 

Using Macintosh BASIC 

Macintosh BASIC s tarts up with a window like tha t in Figure A-8. 
The application's icon is the one w ith a flow chart a nd a ha nd; pro
gra m icons, as on the right, a re larger images of flow cha rts. When you 
open the Macintosh BASIC icon, this produces an en tirely em pty 
desktop with six menus, which will be discussed momentari ly. Select
ing New from the File menu produces a Lis ting window, always t itled 
"Text of" followed by your program na me , as in Figure A-9. Note that 
thi s is a typica l Macintosh window-it can be moved, res ized, scrolled 
through , and so for th . More impor tan t, you have the full complement 
of Macintosh editing cha racte ri stics r ight in tha t window. We can 
move the 1-beam pointe r anywhere, cl ick a n inser tion point or drag, 
a nd change, add , or delete any tex t we want. This is cer ta inly the 
eas ies t-to-edit BASIC in ex istence. Another lovely touch is tha t Macin
tosh BASIC automat ically puts all resei'Ved words (BASIC sta tement 
and func tion na mes) into a diffe rent fon t, to ma ke them easy to spot. 

The RUN command produces Macin tosh BASIC's second s tandard 
display, the Output window, as in Figure A-10. Again, it is a fu lly 
func t ional wi ndow, unlike tha t of MS-BASIC, and wha t runs off the 
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top is s till there. We are aware of no o ther BASICs that have this 
facility; what scro lls off the top of the screen in program output is 
a lways lost, except with Maci ntosh BASIC. You can eas ily print every
thing in the Output or Listing window (including wha t is not showing) 
from the File menu. Again, w ith most BASICs, if you forget to turn on 

------ --·------ ----- BRSIC 0.51 ------=-----=--=---=- . -----------
315K ill 4isk 

~ 
~intosh BASIC Empty Folder Btnchmk6 ~ 

CJ CJ 
System Foldtr BASIC PrO<Jrams 

Figure A-8. The Macintosh BASIC window on the desktop. 

TeHt of Untitled 
! Here 1 s a s1 mp 1 e program 

for x = 1 o to 1 step -1 
print x 
next x 

pr1nt 
pr1 nt "BLAST -OFF!" 

I 

Figure A-9. A Macintosh BASIC Listing window. 

----



------------------A I BASIC Programming 0 203 

10 
9 
8 
7 
6 
5 
4 
3 
2 
1 

BLAST-OFF! 

Untitled 

Figure A-1 0. A Macintosh BASIC Output window. 

the printer before you s tart or from within your program, this is 
s imply not possible. The program can be rerun , changed or not, in the 
same Output window, or, if the Listing window is active when the 
RUN command is given, new Output windows wi ll be created each 
time. Any window can be closed from the File menu or its own Close 
box. 

One feature of Macintosh BASIC that both beginning and experi
enced programmers wi ll enjoy is the interac tivity of its debugging or 
program correction features. When a programming error is dis
covered during execution, a Dia log box appears, such as in Figure 
A-1 1. It prints the line tha t caused the problem , along with a n error 
message. And you can choose to proceed, or click · on Debug to have 
Macintosh BASIC automatically identify the offending line in the 
Listing window, as in Figure A-12. Especially since Macintosh BASIC 
does not use line numbers, this is a very useful feature indeed. 
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Far- without Neat 

far- i - 0 to size% 

( Debug ) 

Figure A-11 . A Dialog box noting an error in programming. 

0 TeHt of 8enchmlc5 

.-~ 

Jj 

!s1 eve, one iteration 
print tlme$ 

~~;;,~h=m;go~i eve !IIIli 

dim flags%(700 1) 
print "only 1 iteration" 
count% = 0 
fori = 1 to size% 
flags%( 0= 1 
next i 
f o r 1 = 1) to ·:. i : e :::; 

prime%= i+i + 3 1~1m 
k=i+prime% mm 

:·:·:· 

213: if k>size% then got 

Figure A-12. Macintosh BASIC's way of pinpointing errors in the Listing 
window. 
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M acintosh BASIC Menus 

Macintosh BASIC is so full-featured tha t no t all of its faci li ties can 
be covered here. But looking a t its s ix menus can sugges t some of these 
a bilities, a nd they are presented in exploded form , with commen ts, in 
Figure A-13. The Apple menu is s ta nda rd , as is the Fon ts menu . The 
la tter offers eleven fon ts (including the pictoria l Ca iro) in five s izes , 
which can be a pplied to ei thct· window, pcrm i tting some nice effec ts 
in BASIC programs. The File menu has a nu mber of fac ilit ies we h ave 
not seen before, and which a re a lso q uite dis tinc t ive to BASIC. In 
addition to opening a progra m , for example, we ca n a lso op~n a tex t 
fi le for viewing o r ed it ing; no o ther BASIC offe rs such an a bility. Save 
Tex t permi ts saving the origina l tex t , rather tha n the B-code, to d isk; 
and Save a Copy in . . . permits saving the tex t to a di ffe rent d isk. Save 
Output is a lso extremely clever, letting us au tomatica lly save the tex t 
in the Ou tput window to disk. We can a lso prin t either a q uick copy of 
the conten ts of a ny window, or a s ta ndard resolution copy, w ith a 
Dialog box for prin ting controls. 

The Edit menu provides most of the fac ilities we have used in other 
Macintosh applications, includ ing, here, the ab ility to pas te materia ls 
direc tly from the Clipboard into the Lis ting window, thus immed i
ately changing our progra m . Among other thi ngs, th is is one way tha t 
standard program ming procedures or sub rou t ines can be added to 
any progra m . And Copy Pic ture permi ts us to copy a ny gra phics 
created by Mac intosh BASIC to the Clipboard, from where they can be 
pasted in to MacPaint or some o ther a pp lication. This offe rs the op tion 
of combining graphics of your own crea tion w ith those crea ted by 
MacPa int, or of using the la tte r to ma ni pula te wha t you have crea ted 
under Mac intosh BASIC. 

The Search menu w ill be a ppealing to a nyone who has done much 
BASIC progra mming. It is essentia lly identica l to the same fac ility in 
MacWrite, pe rm itt ing searching a nd, if des ired , rep lac ing of a ny 
s tring in a window. A s imple bu t useful exa mple wou ld be a case 
where we h ave defined a var ia ble a s a real number ra ther than a n 
in teger, rea lizing la ter tha t it should have been the latter. Rather tha n 
going through a lis ting changing every occur rence of va riab le na me 
"mon th" to "month%," we can jus t usc Replace All a nd the cha nge is 
made throughout the progra m ins tantaneous ly. In combina tion w ith 
Macintosh BASIC's full-screen editor, which le ts us ed it the Lis ting 
window jus t the sa me as in MacWri te, fo r exa m p le, the overall ed iting 
a bilities of Mac intosh BASIC a rc ou ts tanding. 

The Progra m menu provides most of the s ta nda rd progra m con-
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trois, plus a few more. For some reason, Macintosh BASIC does not 
offer a keyboard option for the RUN command, which is a bi! clumsy. 
But mos t others, as the figure shows, can be entered with Command 
key combina tions. Halt and Go are the Macintosh BASIC equivalents 
of the s tandard Controi-C, to halt a program, a nd Continue to get it 
going again. Save Binary permits saving a binary code form of the 
program to disk; thi s is more compact for storage and runs faster. It 
cannot be read or changed, however, nor can it be converted back to 
text code . You can keep both text and binary versions of the same 
program on a disk, however. 

Checking On/Off is a toggle. When On (the default condition), all 
lines of programming are checked for errors when entered. If Check
ing is Off, Macintosh BASIC will not check your syntax until you 
choose Check Syntax from the Program menu or run the program. 

The las t four choices permit sophisticated debugging of programs, 
and will be of interest primari ly to more advanced programmers . 
Debug is a toggle, turning Macintosh BASIC's interactive debugger on 
or off. Step (Command-space bar) permits executing the program one 
line at a time; Trace runs it full speed, with the Tracing finger icon 
pointing at the line be ing executed. And Block Trace runs the program 
fu ll speed within con trol blocks (defined by FOR/NEXT, IF/ENDIF, 
GOSUB, e tc .), and one line at a time between them . 

The effect of all thi s is both a powerful implemen tation of BASIC 
and considerable ease of use. People who have used the Macintosh but 
are new to programming will find the progression to BASIC smooth 
because of the consistent Macintosh format this BASIC uses . And more 
experienced programmers will find that Macintosh BASIC's mode of 
operation makes programming and debugging extremely agreeable. 

Additional Features 

Not surpris ingly, Macintosh BASIC has extensive graphics ca
pabilities, including support for the mouse. As with MS-BASIC, 
graphics development focuses on the pixel and lines. But it is also 
shape-centered, having bui lt-in OVAL, RECTANGLE, and ROUND
RECT (rectangles with rounded corners) statements. Moreover, unlike 
MS-BASIC, Macintosh BASIC has Paint and Pattern commands, for 
fi ll ing shapes, and an Erase command for erasing them. 

Figure A-14 is a simple example using the default patterns; any 
MacPaint pattern could be used, or you can design your own. The first 
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li ne draws a rec tangle, whose corners arc defined by the two pairs of 
horizontal and vertical pixel positions . The second s ta tement makes 
the program wait for the mouse button to be pressed wh ile the pointer 
is inside the Output window. Then the oval is drawn by line 3, and 

,. • File Edit Search Fonts ., 

Figure A-14. Listing and Output windows for a graphics program. 

fi lled w ith defaul t black by line 4. Needless to say, much more sophis
ticated s tuff can be done, but the programming invo lved is relative ly 
painless , and Macintosh BASIC provides enough bui lt-in commands 
and functions to make it easy for the new user as we ll as the advanced. 

A few o ther charac teri s tics of Macintosh BASIC a lso merit mention, 
even in a brief overview. Sometimes, little th ings can be s ignifican t. 
For example, Macintosh BASIC permits using e ither s ingle or double 
quotation marks intercha ngeably, for example, for the delineation of 
s trings . And th is, in turn , permits actually us ing quotation marks 
ins ide of s trings, which no other BASIC we have seen permits w ithout 
the use of much clumsier progt·amming s teps. Even more impress ive 
are Macintosh BASIC's control s tructures, which permit sophis ticated 
looping procedures. One of these is the DO/LOOP s tructure and an
other is the FOR/NEXT s tructure, both of which have EXIT features . 
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The DO/LOOP permits a n infinite loop of a ny size (other loops, of 
course, can be inside it), with any number of IF ... EXIT statements 
to control the ending of the loop. It permits rapid and powerful 
looping with easy cessation of the loop or bra nching elsewhere . It is 
bo th easier to use and potentially more powerful tha n the WHILE/ 
WEND of other BASICs . And the fac t tha t Macintosh BASIC's FORI 
NEXT loops can include an EXIT function avoids the po tentia lly 
dangerous effec ts of jumping out of uncomple ted FOR/NEXT loops 
cha rac teris tic of other BASICs . 

Macintosh BASIC's PERFORM s ta tement is a lso very useful. It sum
mons another program and runs it, passing any desired values to the 
ca lled program. Then, when the summoned progra m ends , control 
passes back to the original program , with a ny values from the called 
one which the origina l progra m asks for. The call ed program, more
over, can summon o ther programs as well. This provides extremely 
powerful and simple programming, not leas t for the use of some 
progra m modules inside numerous others . As such, it becomes a more 
powerful va ria nt of using ex tensive subroutines. 

Even with a pre-release version of Macintosh BASIC, which was not 
full y implemented and still had a number of bugs , it is easy to see that 
it is a di s tinc tive BASIC, bo th in its own terms and in its tight 
in tegration into the Macintosh system. You lose, of course, a cer tain 
amount of compatibili ty with other BASICs, although primarily when 
going from the Macintosh to o ther computers . Of the seven s tanda rd 
speed measurement tests I tried, six of them ra n w ith only insignifi
cant modi fications from wha t I used on a n IBM PC, a nd the seventh 
failed to run a pparent ly because of a bug in thi s pre-release version of 
Macintosh BASIC rather than because of incompatibility. 

If you will be pr ima rily us ing the Macintosh , certa inly Macintosh 
BASIC is the BASIC dia lect of choice; it is far more powerful tha n 
Microsoft's MS-BASIC, a nd, with a bit of experience, a lso eas ier to use. 
Even if you do use BASICs on other computers , Macintosh BASIC i!) 
worth trying ou t for your Macintosh programs because of its charac
teristics a nd a bili t ies . Only if you rea lly wa nt to move programs 
between computers should you approach this BASIC with care, since 
a good dea l of additional progra mming will be required. 

By the time this book a ppears, Macintosh BASIC should be ava il
able, as well as the 2.0 version of Microsoft's MS-BASIC. If you are 
interes ted in BASIC programming, you should look a t bo th of them. 
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Introduction 

Any effective modern computer should permit people to make effec
tive use of it without mas tering extensive technical concepts o r vocab
ulary. All do, to some degree, but with varying levels of success. The 
Mac intosh, and Apple 's Lisa a lso, are indeed di s tinct in developing 
this ability to focus on the work at hand to a degree well beyond that 
of other computers. To be sure , each a pplication bears some of the 
responsibility for creating ease of use. But the Macintosh system does 
p lay a large role in facilitating the process. 

Thus, in the body of this book we have been able to avoid technical 
detai l, beyond some rudimentary descriptions of topics like the nature 
of the Macintosh's video d isplay. We have also been ab le to avoid the 
ex tensive vocabula ry of operat ing sys tem commands that users of 
other computers have to mas ter, because the Macintosh fun ctions 
without them. You have no particular need to look any further into 
this computer's technical characteristics-any more than you need to 
know the intricacies of its systems software-un less, of course, you 
are interested in them. 

For those who would like to know a bit about the innards of their 
computers, this appendix provides a brief description of some of the 
salient characteristics of the Mac in tosh's in terna l hardware. This wi ll 
be a laypersons guide, noting where some of the main components are 
a nd wha t they do. In the process, you can learn a bit more about the 
nature of computers genera lly. 

Unlike many other microcomputers, the Macintosh is not des igned 
to be opened by its owners. There are no user-serviceable parts inside, . 
nor is there any place to plug in an additiona l curcuit board , as would 
be the case, for example, with an Apple II or an IBM PC. Even indi 
vidual integrated circui ts ("chips") are not user-replaceable, since they 
a re soldered in. This is a ll part of the Macintosh design philosophy, 
and also rela tes to some of its economies of production. Thus, unless 
you are a certified electron ics engineer, you would be well adv ised to 
keep your screwdriver a t bay. Moreover, a ny a ttempt to open your 
Macintosh wi ll void its warranty, which is an addi tiona l incentive to 
leave well enough a lone. 

Figure B- 1 is a cut-away photo of a Macintosh, with a few items 
labeled . The CRT (cathode ray tube) used for video display is # 1, the 
largest s ingle item ins ide the computer's case. Second in terms of s ize 
is the di sk drive, # 2. To have had a la t-ger video display, or two disk 
drives, would have required tha t the Macintosh be larger than it is, 
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and Apple engineers had to constan tly weigh the advantages of small 
s ize and portability against those of possible features that could be 
included if the computer were bigger. 

The Macintosh uses only two boards or cards o[ integrated circuits 
and other electronic components. The vertical one, #3 , is the analog 

Figure B-1 . Cut-away photo of a Macintosh. 
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board; and the horizontal one, #4, barely visible in this photo, is the 
digital board, often also referred to as the motherboard, because it 
contains the most elemental components of the computer. Notable by 
its absence is a fan. which mos t computers require . The Macintosh's 
relatively high vertical space and its advanced engineering that uses 
far fewer components than usua l, both help to hold down the amount 
of heat generated by the computer. Thus , the Macintosh operates in 
blessed, and relatively unusual , silence, except when some disk drive 
activity is taking place. 

The Motherboard __________ _ 

Figure B-2 provides a better view of the motherboard, where the 
Macintosh$ processing really takes place . Most readily noted are the 
integrated circuits that we tend to associate with computing. And 
those chips on the Macintosh are indeed marvels of ad vanced en
gineering, not least in terms of the small number of them required to 
make the computer go. The Macintosh design team was unusua lly 
successful in compressing what needed to be done onto just two 
boards and a relatively small number of chips, permitt ing the Macin
tosh to be both compact, even porta ble, and reasonably priced. 

The Motorola 68000 Microprocessor 

At the heart of the motherboard is its largest chip, the Motorola 
68000 microprocessor, labeled # 1, "a computer on a chip." The 68000 
is one of the most powerful microprocessors cu rren tly available for 
small computers, equivalent to about 68,000 transistors, and has the 
capability to provide all the processing power even a multi-user sys
tem might require. 

Microprocessors a re generally classified in terms of their word size 
- the number of bits (Binary digiTS) which they are capable of pro
cessing a t one time. The Apple II, for example, a nd the many business 
computers that operate under the CP/M operat ing system, are classed 
as 8-bi t machines, s ince the ir word s ize is one byte (8 bi ts). That is, 

they can process informatio n in 8-bit chunks, a nd move the data they 
are processing in 8-bit chunks a long the BUS that connects their 
various parts . Since two words are generally used for addressing main 
memory, word size is a lso important in determining how much mem
ory any computer system can use. The 8-bit machines, for example, 
can generally make use of only 64K of main memory, because with 
two 8-bit words tha t is the most they can keep track of. 
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Figure B-2. The Macintosh motherboard. 

A 16-bit computer opera tes, genera lly, much faster than a n 8-bit 
one , s ince it deals with information in larger chunks. It can also 
address much more memory, beca use using two 16-bit words to keep 
track of addresses, up to one million memory locations can readily be 
handled. This is why such machines are so popular today, particularly 
for business and professiona l applications . The IBM PC is a 16-bi t 
machine, but of a hybrid sort. Its Intel 8088 microprocessor does use a 
16-bit word size for processing a nd addressing, but moves data only 8 
bits at a time, just like a n 8-bit machine. Tha t is why in many a pplica-
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tions it is not much faster than a computer like the Apple II. Many of 
IBM's rivals are using the Intel 8086 microprocessor, among others, 
that uses 16-bit words for a ll purposes, including the transfer of data. 
They are, therefore, often much faster than the IBM. 

This sets the stage for the 68000, which is a lso a hybrid, but at a 
higher level. For processing and addressing, it is a true 32-bit micro
processor-one of the very firs t to achieve that level of power on a 
single chip. This means that it is not only much faster at processing 
information than an IBM PC, but also that it can address much more 
memory-up to 16 m illion bytes (megabytes) in fact. But for the 
transfer of data, the 68000 uses a 16-bit word size, which is slower 
than if it used 32 bits for data transfer as well , but s ti ll more than 
double the ra te of an IBM PC. Thus, while Apple adverti ses the Macin
tosh and the Lisa-which uses the same m icroprocessor-as 32-bit 
machines, this is only partially true , but not really incorrect. 

Another important characteristic of any microprocessor is what is 
generally termed its clock speed or frequency, generally expressed in 
megahertz (MHz). Two computers using the same microprocessor will 
do their work at di ffe rent speeds if the clock speeds of their micro
processors differ, which is not at a ll unusual. Some 8-bit machines 
operate at only 1 or 2 MHz, for example, while others operate at 4 or 6 
MHz. The IBM PC$ 8088 operates at 4.77 MHz, but some of its rivals 
have 8088's that run at 7 MHz, which resu lts in overa ll speed of 
operation that is 30 to 50 percent greater. 

The clock speed of the Macintosh 's 68000 is 7.83 MHz, which is not 
the fastest a mong 68000 implementations (some run at up to 10 MHz), 
but is nonetheless quite respectable. And, when compared to other 
single-user microcomputers, the increased clock speed a long with the 
32-bit word size ma ke this a powerful mach ine, indeed . All of that 
power, however, is constrained by the 128K main memory of the 
orig inal version of the Macintosh , which really fai ls to take advantage 
of it. 

The Macintosh ROMs 

Just above the 68000 are the two Macintosh ROM (read only mem
ory) chips , #2, con taining together 64K of informa tion that is perma
nently ins ta lled in the computer, available to all applications. The 
ROM programs, generally referred to as routines, are an ex tension of 
the operating system , and make many of the Macintosh 's operating 
characteri s tics (drawing graphics to the screen, monitoring mouse 
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and keyboard, creating menus and windows, for example) readily 
available to programmers . They thus serve as an aid to those who 
write new applications for the Macintosh, minimizing the progra m
ming that has to be done to integrate any application into the Macin
tosh sys tem. 

Another advantage of the Macintosh's highly sophis ticated and rela
tively large ROM is that it leaves more free space on startup disks and 
more of the computer's ma in memory free for other purposes. This is 
very important in a computer as short of avai lable memory space as 
the 128K Macintosh. 

Random Access Memory 

The two rows of eight chips each, labeled #3, are the main or 
random access memory (RAM) of the Macintosh . Each chip holds 64K 
bits o[ memory in the 128K version or 256K bits in the 512K version , 
so each row of eight holds 64K or 256K by tes, respectively. (Remember 
that one byte is equivalent to eight bits, which is what is used to 
represent a s ingle character.) And since memory is a lways described in 
terms of bytes, this explains the Macintosh 's total RAM of 128K or 
512K. 

As you can readily see, there is not much empty room on the 
motherboard, which is the main reason the origina l Macin tosh has 
only 128K despite the fac t that its microprocessor can address far 
more. And this is, in fact, one of the computer's ma in weaknesses-it 
limits the s ize of documents you can create with MacWrite, for exam
ple, a nd is the reason for the d isk swapping you have to do whe n 
copying disks. It will a lso impede the development for the Macintosh 
of some of the more interesting applications programs currently being 
developed for 16-bit computers like the IBM PC; many of them require 
larger amounts of RAM in order to func tion . 

The increased avai lability of 256K-bit chips permitted the re lease of 
the 512K "Fat Mac" earlier tha n Apple had originally anticipated. And 
it does provide its owners with a cons iderably more powerful ma
chine, a lthough at a fairly stiff price. Not only wi ll it run current 
app lications faster and more efficiently, but, increa singly, applications 
will be coming a long tha t will work only in the expanded machine. 
Owners of the 128K Macintosh can go to their dealers for a replace
ment motherboard with the expanded memory. If a nd when this can 
be combined with double-sided disk dri ves, permitting 800K storage 
per di skette, the power and ease of use of the Macin tosh will increase 
enormously. 
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Programmable Array Logic 

Above and to the left of the 68000 are a group of Programmable Array 
Logic (PAL) chips, #4. Like ROMs, they contain programming or 
routines used for a variety of purposes by the Macintosh. But they are 
different in that each one rea lly does the work of an entire circui t 
board that would conta in many individual chips . They are therefore 
highly compacted programming, and are important in keeping the 
Macintosh as small a nd as cool-running as it is . 

Other Main Components 

The large chip labeled #5 is the Macintosh 's disk controller, also 
something that on most computers requires a rather large circuit 
board containing numerous integrated circuits. Next to it, #6, is the 
serial communications controller, which is in charge of the two high
speed seria l communications ports. These are officially dedicated to 
the Imagewri ter printer and a modem , but are in fac t quite versatile 
and can be used for other things as well . Networking of numerous 
Macintoshes into an integra ted system , when it comes, will use one of 
these ports . 

Next to the seri a l communications controller, labeled #7, is the 
Versatile Interface Adapter, which serves the integra tion of the micro
processor with mouse, keyboard, a nd so on. And the small chip above 
it, #8, is the Macintosh 's real-time clock. This is used bo th for the clock 
you can access from the Apple menu and for any activities inside 
applications that make reference to the time or date. At the upper left 
of the motherboard, #9, are the reset and interrupt switches, which are 
activated by the Programmer's Switch if you have installed it. 

There are, as you can see, numerous other components on the 
motherboard, including a variety of additional e lectronics and con
nectors. Several connectors tie th e motherboard into the other compo
nents of the interna l Macintosh, and the rest, which we have discussed 
in Chapter 1, connect it to external devices. 

The Analog Board 

The ana log board, illustrated in Figure B-3, contains some of the 
less " interesting" circuitry of the computer, which is nonetheless es
sen tia l to its operation . Not least of these is the power supply, whose 
level of power and consistency of performance is crucial for trouble-
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free operations. It consists of several components on this board, the 
most evident of which are the transformer, # 1, and the line fi lter, 
#2. Together, they work to keep the Macintosh 's power supply clean 
and steady, which is very important. 

The speaker, #3, is part of what is, for a computer, a very sophisti
cated sound generation system. This is hardly apparen t from the early 
applications software available for the Macintosh, but should be taken 
advahtage of in the future. It is a four-voice system-capable of play
ing four notes at a time-covering a wide spectrum of sound. With the 
proper software, it is entirely capable of speech synthesis. You h ave 
the option of replacing the speaker with a higher fidelity unit by 

Figure B-3. The Macintosh analog board. 
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simply connecting an external speaker to the audio jack at the rear of 
the Macintosh ; it uses a standard audio connector. 

The video connector is at #4, with a couple of additional video 
controls above it. And the thing that looks like a s tethoscope is another 
transformer, whose end attaches to the video di splay. 

These are the primary components of the internal Macintosh, gener
a lly analogous to equivalents on other computers as well. You can 
easily afford to entirely [orget a bout them, if you wish, and use the 
Macintosh quite success[ully. But it doesn't hurt to understand a bit 
about what is inside the computer and how those parts fit together. 
Moreover, as additiona l peripherals a nd other add-ons begin to ap
pear, this kind of knowledge can help you better a ppreciate both the 
possib le advantages and possible pitfalls of such additions or changes 
to your Macintosh system. 
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In this section will be found most of the definitions provided in the 
CHECKLISTS for each individual chapter. By bringing them together, and 
providing an indication of the type of item being defined, readers will 
have a convenient place for quickly reminding themselves of the meanings 
and uses of various Macintosh concepts, tools, and applications. The 
descriptions in the CHECKLIST for each chapter , and in the text of that 
chapter, provide more complete information. 

\] 
Desktop 

\j 
Icons 

\] 
Pointer 

\} 
Windows 

\] 
Applications 

Concept 

D'' 
Mouse 
Action 

The baste Macintosh screen, analogous to a 
physical desktop. Where work is organized. 

Graphic representations of objects 

Used to make choices or to position the cursor; 
shape varies with the action being undert aken. 

Show the contents of physical objects, documents, 
etc. Can be opened, closed, moved, etc. Scrolling 
permits the window to show any part of the 
thing being displayed. This is facilitated by 
clicking on the scroll bar or scroll arrow. or by 
dragging the scroll box. 

Or tools, such as programs, that we use to get 
work done. 

~ g 
Keystroke 

Application Disk 
Document 
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\) 
Documents 

\j 
Mouse 

D 
Clicking 

D 
Pressing 

n 
Dragging 

D 
Selecting 

\] 
Menu 

D 
Closing 

\j 
Concept 

What the applications create, such as reports or 
drawings. 

The physical device used to position the pointer 
for various actions. 

Quickly depressing and then releasing the mouse 
button. 

Depressing and holding the mouse button. 

Pressing the mouse button and then moving the 
mouse. 

An object is selected or made active 
by moving the pointer to it and then clicking. 
Selection is indicated when the object becomes 
highlighted. 

A Jist or actions available; accessed by pressing 
on Its title. The selection Is made by dragging to 
It, and then releasing the mouse button. 

Returning an Icon to Its proper storage place by 
clicking on Its Close Box, or selecting Close 
from the File menu. 

~ 
Keystroke ~ 

Application 
~ 
Disk 

Document 
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D · 
Insertion Point 

n 
~ 
Cutting 

D 
~ 
Copying 

D 
~ 
Pasting 

~ 
Backspace 

D 
~ 
Undoing 

\} 
Concept 

D' 
Mous~ 
Action 

Where new text wi ll be inserted. Chosen by moving 
the pointer to desired location, and clicking. 

Removing unwanted material, which goes 
automatically to the Clipboard, by selecting Cut 
from the Edit menu or Comand-X from the 
keyboard. 

Making a duplicate of selected material, which 
goes automatically to the Clipboard, by selecting 
Copy from the Edit menu or Command-C from the 
keyboard. 

Moving material from the Clipboard to the active 
document, by selecting Paste from the Edit menu 
or Command- V from the keyboard. 

Deletes selected material but does not send it 
to the Clipboard. Clear, from the Edit menu, when 
ava i lable, does the same thing. 

Undoes most recent action, by selecting Undo from 
the Edi t menu or Command- Z from the keyboard. 

~ g 
Keystroke Application Disk 

Document 
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\] 
Clipboard 

D 
Doub le-CI ick ing 

~ 
View menu 

Q 
Disk copying 

Q 
Disk Copy 

D 
~ 
Duplicate 

D 
Selection box 

v 
Concept 

D , 
Mouse 
Action 

A special file where material that has been 
cut or copied is temporarily stored (until anything 
else is cut or copied). Pasting automatically 
places a copy of what is on the Cl ipboard into the 
current document. 

Process of quickly clicking the mouse button 
twice, to effect two actions at one time. Use 
varies with what is currently being done (e.g., 
to simul taneously select and open an icon, or 
to select a whole word). 

Offers five different ways to view ttie contents 
of a disk window. 

All or part or any diskette Is copied by dragging 
the desired icons to the icon of a second diskette. 

An application permitting rapid copying of an 
entire diskette for single-drive systems. 

Make a copy of any f i le(s) to the same diskette by 
selecting Duplicate from the File menu or with 
Command-O from the keyboard. 

Select multiple icons by dragging a selection box 
around them. 

~ a 
K~ystroke ~ 

Applicilt ion Document 

Q 
Disk 
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n 
Shift-clicking 

D 
(€:1 
Select All 

\] 
Folders 

D 
f=:J 
Shift -Command-4 

D 
f=:l 
Shift-Command-4 

D 
~ 
Shift- Command-J 

D 
Clean Up 

D 
Erase Disk 

\] 
ConcPpt 

rc:r 
Mouse 
Action 

Alternate method for selecting multiple icons; 
hold down Shift key while clicking on desired 
icons. 

Select all icons in a window or on the desktop by 
choosing Select All from File menu or Command-A 
from the keyboard. 

Used to organize file storage. Any item, including 
other folders, can be stored inside a folder. 

With the Caps Lock key up, prints a copy of the 
currently active window. 

With the Caps Lock key down, prints a copy of the 
the entire screen (a "screen dump"). 

Takes a snapshot of the screen, and stores i t on 
disk as a MacPaint document. 

Select from Special menu to have the Finder 
reorganize icons in active w indow or on desktop. 

Select from Special menu to have a diskette 
completely erased. 

~ g 

Keystroke 
Application 

Q 
Disk ~ 

Document 
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'J 
Trash 

~ 
~ 
locking 

D 
Put Back 

n 
~ 
Eject 

Save 

Save as ... 

'J 
Conctpt 

II::!" 
Mouse 
Action 

Used to get rid of any icon. Trashed materials stay 
In the Trash until it is emptied, an application is 
opened, or the Macintosh is turned off. 

Process of making a file or an entire disk 
protected; nothing can be erased or changed. Done 
for files from Get Info window, for entire disks 
by moving the Write Protect tab. 

Select from File menu to return an icon to its 
proper folder or window, whether the latter is 
open or not. 

To remove a diskette from a disk drive, select 
Eject from the File menu of Command-E from 
the keyboard. 

Saves copy of current document to disk; first save 
provides Dialog box permitting naming document 
and selecting diskette to be used with Drive and 
Eject options. 

Saves copy of current document under name and 
on disk specified via Dialog box. 

(€:1 [;;1 
Keystroke 

Appl~lion 
Disk 

Documffit 
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~ 
Quit 

~ 
~ 
Close 

~ 
~ 
New 

~ 
~ 
Open ... 

Q 
Startup dislc 

~ 
Set Startup 

~ 
Font Mover 

\} 
Concept 

Er 
Mous~ 
Action 

Cancel current application and retum to desktop. 

Retums current document to proper place, but 
keeps current application active. 

Opens new document under current application. 

After a Close, provides window showing all 
available documents for current application. 

A diskette with system documents on it, required 
for starting up (booting) the system. 

Select from Special menu for the applicat ion to 
start immediately when Macintosh is tumed on. 

An application for moving fonts into or out of the 
System file. 

~ 
Keystroke 

Application 

g 
Disk ~ 

Document 
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D 
Click & Shift-Click Permits rapid selection or large blocks or text. 

D , 
Double-Click 

U ' 
Shift-drag 

Find .. . 

Change ... 

Title Page 

Set Page • ... 

Selects entire word or space. 

For par tial deselecting of se lected text. 

Select from Search menu to f ind any string. 

Select from Search menu to find and replace any 
string. 

Select from Format menu to suppress headers 
and footers from first page of document. 

Select from Format menu to start document with 
a page number other than one. 

Insert Page Break Select from Format menu to force a new page at 
desired location. 

Rulers 

Conc~pt 

rn=::r 
Mouse 
Aciioro 

Format appearance of text under their control. 

~~ 
~ 

Keystroke 

A 

' ~-~i '·7'-
Applic~ti·ln 

[f] 
Document 
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Margin markers 

Paragraph Indent 
marker 

Tab wells 

Are dragged on ruler to desired margin position. 

Dragged on ruler to desired position for automatic 
indent or outdent of new paragraphs. 

Source of standard or decimal tabs; drag from well 
to desired position on ruler. 

Headers & Footers Have own windows, automatic page, date, and time 
icons. Display and Remove from Format menu 
control their being shown on screen and paper. 

Drawing window 

Show Page 

Tool boxes 

\( 
Concept 

rn::J-
Mouse 
Action 

Where drawing is done; shows less than one-third 
of the page at any time. 

Shows whole page, for moving location of drawing 
window or moving whole drawing on page. 

To left and bottom of drawing window, provide 
MacPaint tools for drawing. 

Q 
Applica tion Disk [>ocumen\ 
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Shapes 

Paint can 

Hand 

Selection box 
& Lasso 

Pencil 

Straight line 

Spray can 

~ 
Paintbrush 

Align 

\] 
Concept 

D" 
Mouse 
Action 

Use selected line thickness. Filled shapes fill with 
selected pattern. 

Fills any enc losed shape with selected pattern. 

Moves everything in window . 

Drag to select any part of window. 

For free-hand drawing in standard thickness. 

Can use any line width. 

Sprays selected pattern In standard width. 

Draws in selected pattern and Brush Shape, and 
symmetrical ly with Brush Mirrors. 

Selected from Style menu, controls justification 
of text. 

~ 
KeiJstroke 

Application 

g 
Disk ~ 

Document 
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Revert 

Print Draft 

~ 
Print Catalog 

Clear 

Grid 

FatBits 

Edit Pattern 

Eraser 

Q 
Concept 

ILl" 
Mouse 
Act ion 

Select from File menu to replace current 
document with most recently saved version. 

Slightly raster and lowe resolution altematlve 
to Print Final . 

Prints name and miniature of all MacPaint 
documents on current disk. 

Same as Backspace; deletes se lected material 
wi thout sending It to Clipboard. 

Provides invisible ·magnetic" grid for aligning 
text and pictures. 

Provides magnified view of selected material for 
precise editing. 

Provides magnified view of selected pattem for 
precise editing. 

Can erase anything in drawing window. 

Application 

Q 
Disk 

[f) 
Document 
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Trace Edges 

Flip Horizontal. 
Flip Vertical. 
Rotate 

~ 
Short Cuts 

\j 
Concept 

I[J. 
Mouse 
Act ion 

Turns solid shapes into outlines; puts borders 
around hollow shapes. With Shift, creates 
shadowed borders. 

Select rrom Edit menu to manipulate selected 
materials. 

Select this window from Goodies menu for 
description of shortcut keystrokes for standard 
MacPaint actions, and for constraining , 
stretching , chained multiple copies , etc. 

~ 
Keystroke 

Application 

~ 
Disk ~ 

Document 



A (text icon), 154, 160 
About the . .. , 32 
Active, 26, 29 

see also Selected 
Alarm Clock, see Clock 
Alert box, 20,70, 84,90 
Align Left/Middle/Right, 154, 160, 

183 
Analog Board, 2 13-2 14,218-219 
Apple Symbol 

for Clock, 34 
Apple II, 190, 212, 215,216 
Application, 22 
Auxiliary Storage, see Disks and 

Disk Drives 

Backspace key, 38, 39-40, SO 
BASIC,22, 139, 189-209 
Bit (Binary digiT), 215 
Boldface, 117 
Boot, 88 

Auto-booting, 90 
Boxes, 19 

see also Windows 
Brightness control knob, 7 
Brush Mirrors, 163 , 172-174, 183 
Brush Shape, 158, 182, 183 
BUS, 215 
Byte, 7, 30, 2 15 
By Icon/Date/Kind/Name/Size, see 

Menu, View 

Cairo font, 105- 108, 178,201 
Calcu lator, 34-37 
Calendar, 34 

In Clock, 34 
Cancel, 8 1, 87 
Caps Lock Key, 10, 38 

235 

Chained multiple copies, see 
Repeating copies 

Change ... , 121 , 123, 146 
Change All, 123 
Change, Then Find , 121 
Clean Up, 70, 78 
Clear, 40, 50, 160, 183 
Click, 26, 34, 49, 146 
Clipboard, 34-35, 39, 45, 46, 85, 90, 

137, 165 
File, 88 

Clock, 33-34,35,218 
On Control Panel, 41-42 

Clock speed, 216 
Close, 36, 37, 50, 76, 84, 85, 110 
Close All, 37, 4 1, 50, 74 
Close box, 27, 30, 33, 36, 50 
Command Key, I 0 

For MacPaint shortcuts, 182 
To stre tch (MacPaint), 177, 178 
With Option, for repeating 
copies (MacPaint), 181 

Command-A, see Select All 
Command-B, see Boldface 
Command-C, see Copy 
Command-O, see Duplicate 
Command-E, see Eject and Trace 

Edges 
Command-G. see Goto Page 
Command-H, see Superscdpt 
Command-I, see Get Info 
Command-L, see Subscript and 

Align Left 
Command-M, see Align Middle 
Command-P, see Plain Text 
Command-R, see Align Right 
Command-S, see Shadow 
Command-U, see Underline 
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Command-V, see Paste 
Command-X, see Cut 
Command-Z, see Undo 
Command-Shift ... , see Shift-

Command ... 
Connectors 

Rear panel, 13-1 4 
Constraining (MacPaint), 176-1 77, 

184 
Con trol Panel, 41 -45 
Copy, 34-35,45, 50, 116, 123 
Copying, 77 

Advanced (MacPaint), 180-18 1 
Disks, 55-59 
Files, 59-62 
see also Duplicating 

CP/M, 215 
CRT, see Video Display 
Cursor, 18- 19, 23 

Blinking rate, 43 
see also Pointer 

Cut, 34-35, 39, 45, 50, 116 

Deselect, see Select 
Desktop, 15, 17, 22-23, Chapter 2 

Pattern adjustment, 43-45 
Dialog box, 20, 76, 81, 84, 85 

Print, 103, 108, 11 0 
Digital board, see Motherboard 
Directory, see Disks, displays 
Disk Copy, 56, 58-59, 77, 92, 97 
Disk drives, 5, 212 

Controller, 2 18 
Double-sided, 217 
External, 6, 9, 56 
Internal, 6, 7 
One or two drive systems, 
differences, 55, 57, 58, 82,. 86, 

87, 89, 90, 92, 97, 100, 
102- 103, 150-151 

Disks (Diskettes), 7, 9, 22 
Displays, 52-55, 69 
Managing, 87- 103 
Maximizing space on, 60, 97-100 
Naming, 56 
see also Startup 

Display Footers/Headers, 136, 147 
Document, 22, 23, 110 

Management, 66, 80-87 
Double-Click, 52, 66, 71, 77, 80, 85, 

146, 153 
For MacPaint shortcuts, 182 

Drag,27, 39,49 
Drive 

In Dialog box, 82 
Duplicate, 62-64, 65, 75, 77 

see also Copying 

Edit Pattern, 163, 184 
Eject, 29, 74-75 

In Dialog box, 82, 97 
Empty Trash, 71, 78,97 

see also Trash 
Enter key, 10, 84 
Erase Disk, 70, 78, 100,1 10 
Eraser, 157, 165, 182, 184 

FatBits, 53, 163, 168- 172, 173, 182, 
184 

"Fat Mac" , see 5 12K Macintosh 
File, 60 

Handling, 64-69, 81-87 
Moving, 62 
Names, 84 
Temporary, 97, 104 
see also Copying, Duplicating, 
Folders 

Fill , 167 
Filled oval/rectangle/kidney/ 

polygon (MacPaint), 152, 153, 
183 
Borderless, 167 

Find ... , 12 1, 123, 146 
Find Nex t, 12 1-122 
Find what, 121 
Finder, 32, Chapter 3, 83, 84, 85, 

88, 89, 90, 97, 100 
512K Macintosh , x, xi, 7, 55, 57, 

114, 154, 217 
Flip HorizontalNertical, 167, 184 
Folders, 64-69, 78 

Empty, 30 
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Font Mover, 29, 52, 64, 92-96, 
97-99' 11 0' 11 7 

Fonts, 94, 105-108 
Cha nge, in MacPaint, 181-182 
Fi le, 92, 94, 95, 98,99 
Recommended sizes, lOS 
see also Font Mover 

Footers, 132-136, 147 
Removing, 136 

Format, see Initia lize 

Get Info, 29, 56,71 
For keeping records, 95-96 

Goto Page, 123 
Grid, 163, 166, 183 

Hand (icon), 154, 170, 182, 183 
Headers, 132- 136, 147 

Removing, 136 
Hide Footers/Headers, 136 
Hide Rulers, 131-1 32, 135, 146 
High light, 26, 35, 39, 49 

see also Select 
Hollow oval/rectangle/kidney/ 

polygon (MacPaint), 152, 153, 
183 
Borderless, 167 

IBM PC, 190, 19 1, 199, 200, 209, 
212,2 15,2 16,2 17 

Icons, 6, 17-18, 19, 23, 26, 30, 35 
Disk, 26, 35, 90 
In MacWrite Footers/Headers, 
134, 135 
In MacPaint, see MacPainl, Tools 
Shadow, 55, 56 

Imagewriter file, 88, 102, 103, 150 
Imagewriter printer, 6, 12, 14, 103, 

108, 2 18 
Ribbons, 108 

Insert Page Break, 124-125, 146 
Insert Ruler, 129 
Insertion point, 38, 50, 11 5, 117 

see also Pointer and Cursor 
Initialize, SS-56, 58 
Intel 8086/8088,215,2 16 

Introduc tion (MacPa int Window), 
164 

Invert, 166 

Key Caps, 37-41 
Keyboard, 5, 6, 9-10, 14, 218 

Auto-repeat adjustment, 43 
see also Key Caps 

Keypad, numcri<.:, 6, 9 

Lasso, 155, 165, 166, 167, 183 
Line fi lter, 2 19 
Line jus ti fication (MacWrite), 127, 

147 
Line select ion box, 152, 153 

For repeating copy spacing, 181 
Line spaci ng (MacWI"ite), 127, 147 
Lisa Computer, I S, 17, 150,2 12, 

216 
LisaDraw, ISO 
Locking 

Disks, 72, 78 
Files, in Get Info box, 71-72, 78 

MacDraw, 150 
Macintosh BASIC (Apple), 200-209 
MacPain t, 22, 29, 30, 45, 72 , 103, 

105, 11 4, 137, 139, Chapter 6 
Drawing window, lS I 
Edit menu, 154, 160-163, 165, 
166 
File menu, 160 
Goodies menu , ISO, 156, 158, 
163- 164, 167, 172, 176, 181 
Menus, J 60- 164 
Style menu , 154, 160 
Tools, 152-159 

MacWrite, 19, 22, 29, 30, 45 , 63, 
80, 85, 87, 103, 108, Chapter 5 
Font menu, 11 7 
Format menu, 115, 123- 124, 133, 
146 
Forms in , 140-143 
Menus, 117- 125 
S tyle menu , 11 7, 146 
Tables in, 143-146 
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Margins (MacWrite), 128, 147 
Megabyte, 216 
Megahertz (MHz), 2 16 
Menu bar, 26, 29 
Menus, 28-29, 49 

Apple, 32-49, 85 
Blinking rate, 42-43 
Edit, 31, 34, 85, 11 6, 120 
File, 29, 31, 34, 35, 85, 104, 108 
Special, 31, 90 
View, 31, 53-55, 77 
see also MacPaint and MacWrite 

Microprocessor (Macintosh), 4, 91, 
215-2 16,2 18 

Modem, 6, 218 
Motherboard, 214, 215-218 
Motorola 68000, see 

Microprocessor 
Mouse, 5, 6, 11-12, 14, 26, 30, 34, 

49, 218 
Movement adjustment, 43 

MS-BASIC (Microsoft), 190-199 

Networking, 218 
New, 85-86, 87, 110 
Note Pad, 46-49, 89, 100 

File,88 

Open, 19, 29 
Open 0 0 0 , 86-87, 110 
Open Footer/Header, 133, 135, 136 
Option Key, 10, 38, 40 

In MacPaint, 180, 181, 182, 184 
Option-Shift, 38 

Page Setup, 108-109, 120, 136, 147 
Paint can, 153-154, 183 
Paint brush , 157- 158, 172-174, 182, 

183 
Paragraph indentation marker, 

128, 147 
Partial word (MacWrite), 121, 123 
Pascal, Apple, 189 
Pas te, 39, 45, SO, 116, 123 
Pattern bar, 153, 182 
Pencil (icon), 155- 156, 182, 183 

In FatBits, 169-170, 182 
Pixel, 7 
Plain text (MacWrite), 117 
Pointer, 19-20, 24, 30, 49, 115 

Shapes, 20, 38, 152, 155 
Power supply, 2 18-219 
Press, 27, 49 
Printing, 103-109, 110 
Printing (MacPaint), 160 

Print Draft, 160, 183 
Print Final, 160, 183 
Print Catalog, 160, 183 

Printing (MacWrite) 
Draft quality/resolution, 94, 108 
High quality/resolution, 94, 96, 
98, 108 
Standard quality/resolution, 94, 
108 
Tall Adjusted, 109 
Wide, 109 

Programmable Array Logic (PAL), 
218 

Programmers Switch, 14, 2 18 
Programming, uses, 188 
Put Back, 73-74, 78 
Puzzle, 49 

Quick Reference, 221 
Quit, 76, 84-85, 110 

RAM (Random Access Mamory), 
217 
see also 512K Macintosh) 

Redo, 116, 121, 146 
see also Undo 

Reference, Quick, 221 
Remove 

In Font Mover, 95 
Remove Footer/Header, 136, 147 
Repeating copies (MacPaint), 181, 

184 
Reset switch, 14, 218 
Return Key 

In Find 0 0 0 and Change 
121-123 
In MacWrite, 129 
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Revert , 160, 183 
ROM (Read-Only Memory), 5, 

216-217 
Rotate, 168, 184 
RS-422, see Serial ports 
Ruler (MacWrite), 11 5, 125-132, 

141- 142, 143, 146 

Save, 75, 80-84, 100, 110 
Text only, 81 

Save as ... , 75, 83-84, 100, 110 
Scrapbook, 45-46, 89, 90, 99, 137 

File,88 
Screen, see Video disp lay and 

Snapshot 
Screen dump, see Shift-

Command-4 
Scroll, 19, 20,30 
Scroll bar, 45 
Scroll box, 45, I 23 
Seattle 

Filc,92,96,99 
Font, 96 

Select/Deselect, 26, 30, 35, 39, 49, 
78, 165 
And replace, 48-49, 50 
Blocks of text (MacWrite), I 17, 
146 
Multiple icons, 61-62 
See also Selection Box and Lasso 

Select All, 62, 70, 78 
Selection box, 61, 78 

In MacPaint, 155, 165, 166, 177, 
182, 183 

Serial communications controller, 
218 

Seria l ports, 14, 218 
Se t Page#, 124- 125, 136, 146 
Set Startup, 90, 110 
Setup, system , 14 
Shadow type, 117, 135 
Shift key (MacPaint), 157, 158, 

171, 177 
Shift-Command, 177, 178 

Shift-Click, 61 , 78, 117, 146 
Shift-Command-4 

With Caps Lock up, 69, 76, 78 
With Caps Lock down, 69, 76, 78 

Shift-Command-1 /2 , 75, 78 
Shift-Command-3, 76, 78 , 168 
Short Cuts (MacPaint), 164, 176, 

181-182' 184 
Show Clipboard, 34, 165 
Show Page, 151, 156, 157, 167, 

173, 182, 183 
Show Rulers, 132, 146 
Six lines/inch (MacWrite), 127 
Size box, 30 
Snapshot, see Shift-Command-3 
Software 

Application, 5, 23 
System, 4, 7, 22, 26, 52, 58 

Speaker, 219-220 
Volume control, 42 

Spraycan, 157, 183 
Startup application , 90 
Startup disk, A, 7, 88, 92, 97, 110, 

217 
Startup disk, The, 70, 89-90, 102, 

110 
Storage, auxiliary, see Disk Drives 

and Disks 
Storing, see Folders 
Straight line (icon), 156-157, 183 
Stretching (MacPaint), 176-177, 

184 
Subscripts , 118-119, 128, 146 
Superscripts, 11 8- 119, 128, 146 
System Disk, 92 
System file, 52, 88, 92, 93, 94, 99 

Using Get Info, 95 
See also Software , System 

System Folder, 29, 52, 53, 63-64, 
88, 89, ISO 
See also Software, System 

Tab key, in Search ... , 121 
Tab wells, 128, 147 
Tabs 

Regular, 128, 147 
Decimal, 128, 147 

Text only (Saves), 81 
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Title bar, 39 
Title Page (MacWrite), 123, 134, 

146 
Tool, 23 
Tool boxes (MacPaint), 152, 183 
Trace Edges, 166, 184 
Transformer, 21 9 
Trash, 20, 26, 30, 71,78 

Emptying, see Empty Trash 
Put disk icons in, 90 

Triple-Click, 52 

Undo, 39, 40, 48, 50, 116 
In MacPaint, 154, 156, 160, 165, 
i81 
In MacWrite, 120-121, 127, 132, 
146 

"Untitled", 83 
Underline, 117 

23 14 G 

Video connector, 220 
Video Display, 5, 6, 7, 212, 220 
Versatile Interface Adapter, 2 18 

Windows, 6, 19-20,23, 26, 27 , 29, 
30, 35, 68-69 
Closing, see Close 
Drawing, in MacPaint , 151, 168, 
183 
Footer and Header, 133 
Moving, 33, 36, 37,.49, 69 
Moving, in MacWrite, 125 
Moving without Selecting, 36, 78 
Printing, 69 

See also Shift-Command-4 
Sizing, 30, 49 

Word-wrap, 47 , 129 
Write-protect, see Locking, disks 
Whole word (MacWritc), 121 


